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All efforts have been made to ensure the accuracy of this Guide. However, should any 
errors be detected, Datacolor would greatly appreciate being informed of them. 
Changes are periodically made to the information and will be incorporated in new edi-
tions of the guide. 

Datacolor reserves the right to make improvements and/or changes in the product(s) 
and/or program(s) described in this guide at any time.

Copyright © 2005 Datacolor. All rights reserved. This guide may not be reproduced or 
copied, in whole or in part, without the written permission of Datacolor.

Trademarks
Throughout this manual, trademarks are used. Rather than place a trademark symbol at 
every occurrence of a trademark name, we state here that we are using the names in an 
editorial fashing with no intention of infringement the trademark.

Address
Datacolor
Brandbachstr. 10
CH-8305 Dietlikon/Zürich
Telephone: + (41) 44 835 38 00
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About this Guide

Who Should Use this Guide?
This is the Datacolor MATCHTextile User’s Guide. It is to be read by users of the Data-
color MATCHTextile system, who need to know how to begin using the programs. Once 
you are familiar with Datacolor MATCHTextile, this guide provides a reference to help you 
carry out specific tasks using the system. This guide assumes you are familiar with 
Microsoft Windows.

How to Use This Guide
This guide is divided into the following main chapters:

Preface Edition, copyright and trademarks, impor-
tant addresses.

Contents Table of contents.
1 About Information about this guide.
2 Overview Overview of the relationships between the 

specifications needed for matching.

3 Installation Installation description for Datacolor 
MATCHTextile.

4 Configuration and Administration Configuration and administration of 
Datacolor MATCHTextile.

5 Using Datacolor MATCHTextile This chapter provides you with the basic 
information you need to start and use the 
system. A step by step description shows 
you the specification of the basic data and 
the calculation and correction of recipes.

6 Maintenance and Error Handling Maintenance of the spectrophotometer, the 
database and error handling.

7 Windows and Dialog Boxes Description of the windows and dialog 
boxes with their parameters. In Chapter 3 
Installation, Chapter 4 Configuration and 
Administration and Chapter 5 Using Data-
color MATCHTextile, some dialog boxes are 
described in connection with their use. 

8 Glossary Explanation of specific terms used in this 
guide.

9 Index The index should help you to find the 
descriptions you need.
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Type Styles and Symbols
The following type styles and symbols have been used in this guide:

• References to other chapters and sections of this guide are shown in italics, e.g., 
Refer to General Table Functions.

• Screen texts (window titles, parameter names, etc.) are written between double 
quotes, e.g., 
“Explorer” window.

• If a user action is requested, menu functions or button names are highlighted in 
bold, e.g., 
Click Save.

• A note is used to draw your attention to additional useful information, e.g.:

• A caution symbol is used to draw your attention to potential hazards, e.g.:

Note:
Leave the spectrophotometer to warm up for a few minutes. Datacolor recommends 
that for the greatest accuracy you should wait thirty minutes before calibrating.

Caution
An alteration of these parameters can interrupt the communication between the 
PC and the spectrophotometer.
Datacolor February 2005 1 - 3
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Datacolor MATCHTextile User’s Guide 2 - Overview
Basic Data
The basic data application is used to manage basic data, e.g., substrates, dyestuffs, 
auxiliaries, etc.

Quality/Style
Quality/style is a summary of all data in relation to the substrate and contains:

• Quality/style and substrate
• Affinity (quality/style subgroup)
• Fiber group
• Fiber
• Customer
• Substrate - blank dyeing

Fiber Definition of all single fibers to be dyed.

Fiber group Definition of all fibers used for a quality/style. A fiber group 
can be a single fiber or a combination of different fibers, e.g., 
PES, PES/CO.

Affinity Definition of a link to a fiber group and the part of each fiber 
in%, e.g., PES = 60%, CO = 40%. Used for the relationship 
to the colorant set.

Customer A customer may be assigned to each quality/style.

Substrate - blank dyeing Reflectance measurement of the substrate and quality/style 
effect factor.

Colorant Set

Customer

Quality/style

Fiber group

Affinity

Fiber Substrate - 
blank dyeing

Note
The affinity is used to group qualities/styles. Qualities/styles linked to the same affinity 
should have the same dye behavior or should be dyed with the same combined pro-
cess.
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Product
A Product is either a dyestuff or an auxiliary.

Dyestuff

Auxiliary

Product supplier Supplier-specific data, e.g., name, address, phone number.

* Supplier dye name Dye name of the supplier, e.g., Remazol, Terasil, etc.

Stock solution Definition of different dilutions used for optimizing the accu-
racy of manual dyestuff pipetting and to prevent that the max-
imum of the dye solution is to be exceeded.

* Dyestuff type Type of the delivered dyestuff, e.g., conc., gran., supra.

Dye class Classification of dyes according to the chemical composition 
and reaction, e.g., disperse, reactive.

* Dye description Additional description of the dye, e.g., brilliant, dark.

* Dyestuff color Color names, e.g., red, green, blue.

Formula setting Settings for recipe calculation used for production, e.g., 
default unit.

* Supplier dye name, dyestuff type, dye description, and dyestuff color can be used 
to compose the product name.

Customer
A customer delivers the substrate and orders the dyeing. It is assigned to the quality/
style.

Color Type
Measured color pattern. A color type is substrate-independent.
A color type is a standard and can be linked to a recipe.

Dyestuff Dye class

Dyestuff typeDyestuff colorProduct supplier

Stock solution

Supplier dye name

Dye description

Auxiliary

Product supplier Stock solution Formula setting
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Colorant Set
A colorant set is a set of color information about the substrate and dyes the system 
uses to produce match and correction recipes. It contains ...

• information about the overall colorant set, e.g., the substrate and process that will 
be used with the dyes;

• product information about each dye, e.g., strength, minimum and maximum con-
centration;

• color information about each dye.

Colorant set

Dyestuffs (product)

Affinity
Used for pre-

selection

Dye fiber group

Parameter

Auxiliary (product)

Substrate 
(quality/style)

Dye process

Connection

Dye class
2 - 4 Datacolor MATCHTextile Version 1.0 Datacolor



Colorant Set 2 - Overview
Calibration methods

Measured (default) The calculated absorptions are the same as the measured 
absorptions. The calculated dye concentrations meet all 
measured dye concentrations. All dEs are zero.

Smoothed Adjusts the dye concentrations for larger variations in dye 
strength.

Automatic Normally, the “Measured” method is better for low concentra-
tions and the “Smoothed” method for high ones.
The automatic method transits continuously from “Measured” 
to “Smoothed.”

The old Smoothing
model could cause in 
bad results at low 
concentrations !!

Error weighting function
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Combined Process
The user has to define combined processes and operations.

Combined process
A combined process is used to describe the entire dyeing process either for laboratory 
or production. A treatment is generated for each calibration dye process type (,e.g., 
Exhaust, Continuous,) linked to the combined process.

Treatment
A treatment consists of one or more operations describing the dyeing process for labo-
ratory and/or production.

Operation
The operation specifies the sequence of action to be done during the dyeing. Actions 
may be parameters (,e.g., temperature, volume), or products (,e.g., chemicals, etc.).

Operation

Treatment

Operation

Treatment

Colorant setCalibration dye 
processCombined process

Note
If Datacolor Process is not installed, 

• only one operation is possible for each treatment;
• the operation supports XY-tables (decision tables) and fixed parameter values 

only.
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Recipe Calculation (Matching)

Selection:
• Quality/style (data of the substrate)
• Combined process
• Substrate delivery (only for deliveries with data different to the blank dyeing sub-

strate)
• Dyed substrate (over-dyeing only)
• Dyestuff group with dyes pre-selected from the assigned colorant set. The dye-

stuff group is used to optimize the recipe calculation.
Selection criteria:
• Dyes from the list

• Parameter values, e.g., fastness information

• Concentration values, e.g., min., max., conc.

• Settings (parameters for calculation control)
• Standard: Color to be matched.

Match: The recipes are calculated according to the selections and 
the results are displayed.

Recipe calculation

Selection:
Dyestuffs
Limits for parameters
Concentration

Print Dispense

Review

Save

Multi color matching
Match in the background

Colorant set Process
Affinity

Used for pre-
selection

Operation

Treatment

Substrate
delivery

Dyestuff Settings

Recipes

Dyed
substrate

Dyestuff group

Standard
(Color Type)

Quality/style Combined process
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Review: The recipes can be reviewed according to the different crite-
ria (various color difference values, coordinates, price, etc.)

Further use: The recipes can be saved, printed and/or sent to a dispenser.

SmartMatch
The SmartMatch facility is used to improve first-time matching and correction. Standard 
color prediction uses the Kubelka-Munk theory, which assumes that dyes behave in the 
same way when used together or stand-alone. However, this is not the case: dyes inter-
act with one another. The SmartMatch facility overcomes this problem by taking into 
account the performance of previous predictions, e.g., learning by experience.
SmartMatch stores information about the concentrations used to dye a sample and the 
results of dyeing, and uses this data to correct the first attempt made by Kubelka-Munk 
calculations in future matching. It stores information about previous predictions as 
SmartMatch points. 
Once you set your system to SmartMatch, it runs automatically. However, you can also 
examine the SmartMatch points the system is using and alter them to refine Smart-
Match performance. For example, if you suspect that one of the SmartMatch points 
being used is based on a bad dyeing, you can remove this point. As result, it will no 
longer be used in the calculations.
The number of similar points is reduced by grouping them. In addition to the automatic 
SmartMatch housekeeping, a powerful graphical tool supports the checking of the 
SmartMatch population for SmartMatch points to be deleted or grouped.
All recipes calculated using the “Match” option will use SmartMatch when SmartMatch 
is turned on and when relevant populations are available. The number of SmartMatch 
points used in a recipe calculation are shown at the bottom of the dye concentration 
column in the recipe table.

Note
You can still store SmartMatch points for later use, if the SmartMatch facility is switched 
off.
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Correction
Laboratory correction Production correction

Selection of correction type:
• Laboratory The existing recipe is altered and saved again.
• Production An additional recipe is calculated, that is used to change 

color of the dyed batch to the correct color.

Data input:
• Recipe to be corrected
• Batch (color of the dyed substrate to be corrected)
• Dyestuffs are pre-selected by the recipe to be corrected. Additional dyestuffs can 

be selected. Concentration and parameters can be defined.
• The acceptance limit settings can be altered.

Print Dispense

Save
Print Display

Recipe

Dyestuff Settings

Batch

Corrected recipe

Review

Additional recipe

Recipe

Dyestuff Settings

Batch

Approval for
use in production

Production
correction

Laboratory
correction

Caution!
A production correction is not saved. It must be printed before closing the “Pro-
duction Correction” dialog box. Otherwise, the recipe will be lost.
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Fast Correction
The “Fast Correction” function is used for production or laboratory corrections without 
an existing recipe. It is based on a theoretical calculated recipe of the standard or a rec-
ipe typed in manually. This task is mainly used for production correction.

Data input:
• Quality/style, combined process, colorant set, and standard.
• Batch (color of the dyed substrate to be corrected)
• Dyestuffs must be selected. Concentration and parameters can be defined.
• The acceptance limit and color difference equitation settings can be altered.
• The recipe can be entered manually or a theoretical recipe can be calculated.

Input of SmartMatch Points
The “Fast Correction” function can be used for entering SmartMatch points.

Print Display

Laboratory
correction

Quality/Style

Dyestuff
SettingsBatch

Review

Additional recipes

Recipe input or 
calculation

Combined process Colorant set Standard

Production
correction

Print Display

Additional recipe

Caution!
Only fast corrections of laboratory recipes can be saved. Fast corrections of pro-
duction recipes must be printed before closing the “Production Correction” dia-
log box. Otherwise, the recipe will be lost.
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Supported Operating Systems
Workstations
Windows XP Professional

Windows 2000 Professional

Windows NT 4.0, service pack 4 or higher

Windows 98   Not recommended!

Server
Windows XP Server

Windows NT Server, service pack 4 or higher

Windows 2003 Server

Installing Datacolor MATCHTextile

Action Result

1 Insert the Datacolor MATCHTextile 
compact disc into the CD-ROM 
drive.

If the installation does not start auto-
matically, select Run on the Win-
dows start menu, type

<drive ID>:\setup
(<drive ID>: is the identification of 
the CD-ROM drive, e.g., D:.)
in the “Open” field of the “Run” dia-
log box, and click OK.

The installation program starts automat-
ically.

2 Follow the advice of the installation 
program.

Note
After installation, the software runs in the demonstration mode and must be validated. 
Refer to New Installations on page 3-4.
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Updating Datacolor MATCHTextile

For the installation of an upgrade, refer to the installation description of the update and 
to Installing Datacolor MATCHTextile on page 3-2.

Caution!
• The database is upgraded by the update program. But, it is strictly recom-

mended to back up the database before updating. Otherwise, for some ver-
sions of the program the database could be deleted and lost.

Note
• If an old DCIMatch, SmartSort, CentersideQC or Fibramix program is updated to 

one of the new Spectrum Textile software products, the old software is removed 
during the installation of the new Spectrum Textile products like Datacolor 
MATCH, Datacolor SORT.

• If the software security key is not accepted after updating the software runs in the 
demonstration mode and must be validated. Refer to Existing Installation on 
page 3-5.
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Datacolor Security System
A new Software/Hardware security system replaces the old software protection pro-
vided by the green parallel port security key.

New Installations
New purchases receive a sticker containing their serial number. This is typically found 
on the corner of the jewel case. 

The software can be installed normally. After installation and if the software is running 
for the first time, the following dialog box appears:

From the date of the first use, you have 30 days to validate the software. (Any attempt 
to change this system date will immediately end the demonstration period.)

1 During this period, press the Continue button to start the software in demonstra-
tion mode. It is possible that not all features will be available while in the demon-
stration mode. 

The users should validate their software as soon as possible, as it may take up to seven 
days to do so. 

2 Visit http://pmweb.datacolor.com, call the local sales office, the Lawrenceville or 
Dietlikon call centers or mail the necessary information to Datacolor 
(SoftwareLicense@Datacolor.com) using the validation instruction sheet pro-
vided with the software.
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Existing Installation
If you already have one of the following Datacolor software packages: 
Datacolor MATCHTextile, MatchExpress, or Datacolor Process, that run using a green 
software security key and receive an upgrade due to an upgrade purchase or a software 
maintenance agreement that does not require re-licensing, your software will run as 
before. Continue to use the green software security key.

What Happens if the Software Security Key Stops Working?
If the software security key fails to work for any reason, the software will be converted to 
the fourteen days demonstration period. The user then has two options:

• First, check the software security key and make sure that it is still properly 
attached to the system. If not, reattach it and the software should run normally.

• If it is attached and still fails to respond, the software security key may have 
failed. Use one of the methods listed in the New Installations section to contact 
Datacolor for validating the software using the software security component.

What Happens if the User Changes Computers?
If the user needs to change computers, the software will need to be re-validated. Simply 
follow one of the procedures listed in the New Installations section to contact Datacolor 
with an explanation of why you need to re-validate your software. The validations will be 
tracked in the Datacolor network to detect any abnormalities and protect the value of 
your software purchase. 

Upgrading Your Purchase
Some software packages offer the ability to upgrade the user's purchase level. Using 
the software security model, it is now easier for users to upgrade their purchase if they 
want a higher level of software or a new feature module. Simply contact your sales rep-
resentative to make the purchase. You will be issued a new serial number and a new 
validation number for your computer. That enables you to run the new features.

Note
In this case, the website will not directly validating the user's software, but an email will 
be generated for a validation request.
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Removing Datacolor MATCHTextile

Action Result

1 On the Windows desktop, double-
click the My Computer icon.

The “My Computer” dialog box appears.

2 Double-click Control Panel The “Add/Remove Programs Proper-
ties” are opened.

3 Double-click Add/Remove Pro-
grams.

The “Add/Remove Programs Proper-
ties” are opened.

4 Select “Datacolor MATCHTextile”, 
click Add/Remove, and confirm the 
removing.

Datacolor MATCHTextile is removed.

5 If Sybase is not used again (,e.g., for 
Datacolor Process,) it can also be 
removed.
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User Administration

Specifying, Modifying and Deleting User’s Data

Changing the Password

Note
Only the user “DCI” can specify and modify user’s data.

Action Result

1 On the Tools menu, select User 
Manager - User Administration.

The “User Administration” dialog box 
appears.

2 In the “User’s List,” select a user, 
and click: 

Add to specify a new user;

Remove to delete of a user’s data.

Rename to rename a user;

Add: The “Add a New User” dialog box 
appears. Insert name and password, 
and click OK.

Remove: The user data is removed 
after confirmation.

Rename: The “Rename a User” dialog 
box appears. Specify the new name, 
and click OK.

3 If finished, click Close. The “User Administration” dialog box is 
closed.

Note
The user „DCI“ cannot be deleted and has all access rights. These rights cannot be 
modified. 

Action Result

1 On the Tools menu, select User 
Manager - Change Password.

The “Change Password” dialog box 
appears.

2 Insert the old and new password, 
and confirm the new one.

3 Click OK. The password is changed.
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Access Rights

Action Result

1 On the Tools menu, select User 
Manager - User Administration.

The “User Administration” dialog box 
appears.

2 Select the requested user and click 
Permissions.

The “User Permissions” dialog box 
appears.

3 Set the permissions and click OK. The “User Permissions” dialog box 
closes.

4 In the “User Administration” dialog 
box, click Close.

The “User Administration” dialog box 
closes.
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Available options

Note
The setting of a user right is valid for all attached rights at lower levels.

Level Lower 
Levels 
Included

Option

0 + Main

1 Delete and Rename

1 Copy Data

1 + File

2 + Basic Data

3 Product

3 Quality/Style

3 Dye Process

3 Customer

3 Color Type

3 Parameter Definition

3 Tolerance

3 Combined Process

3 Operation

3 Sample

3 Fiber

3 Fiber Group

3 Affinity

3 Substrate Delivery

3 + Browse Date

4 Illuminant List

4 Sample List

4 Color Type List

4 Tolerance List

4 ... (refer to menu „Basic Data“)

3 Display

3 Print

3 ASCII Output

2 + Recipe

3 History

3 Match

3 Match in Background

3 ... (refer to menu „Recipe“)

2 + Colorant Set

3 Colorant Set Calibration
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3 Colorant Set

3 Display

3 Print

2 + SmartMatch

3 All menu options of SmartMatch

2 + Batch Series

3 All menu options of SmartMatch

2 Send Mail

2 Scan Mail

2 + Production

3 Dye Lot

3 Production Recipe

3 Administration

1 + Tools

2 Tool Bar

2 Status Bar

2 + User Manager

3 Change Password

3 User Administration

2 ... (Refer to menu „Tools“)

2 + Options (exception: dialog tabs)

3 View

3 Dispenser

3 Stock Solution

3 Unit Selection

3 Print

2 Import

2 ... (Refer to menu „Tools“)

1 + Instrument

2 All menu options of Instrument

Level Lower 
Levels 
Included

Option
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Browser Customizing

You can select the table columns to be displayed as follows:

Action Result

1 On the Tools menu, select User’s 
Browser Definition.

The “Browse Columns for Explorer” dia-
log box appears.

2 Select the data type (table). The related data tree is displayed.

3 Check the boxes, the table columns 
have to be displayed.

In the footer of the dialog box, the 
checked table column titles are dis-
played.

4 Click Save. The settings for the selected table are 
saved.

5 Repeat steps 3 and 4 to display 
other table columns.

Repeat steps 2 to 4 to alter the dis-
play of other tables.

6 Click Close to close the “Browse 
Columns for Explorer” dialog box.

Note
The Reset button deselects all table columns except the object name. It is used if the 
performance of displaying is not acceptable.
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You can alter the column titles of the tables as follows:

Using the mouse, you can change the sequence of the table columns by drag and 
drop.

You can alter the position of column titles by drag and drop:

Action Result

1 On the Tools menu, select User’s 
Browser Definition.

The “Browse Columns for Explorer” dia-
log box appears.

2 Select the data type. The related data tree is displayed and 
the checked table column titles are dis-
played in the footer of the dialog box.

3 A double-click in a table column title 
opens the “Custom Name” dialog 
box.

Refer to the figure on the previous 
page.

4 Specify the custom name, and click 
OK.

The table column title is altered.

5 Repeat steps 3 and 4 to alter other 
table column titles.

6 Click Save.

7 Click Close to close the “Browse 
Columns for Explorer” dialog box.
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Browse Filters
It is possible to specify customized filters (queries) for selecting data from the database. 
Customized filters can be ordered from Datacolor. Please contact your Datacolor 
distributor for more information.

Using Browse Filters

Note
• The integrated tool for customizing filters needs advanced know-how of both the 

database and SQL.
• Filters are language dependant. They can only be specified and used with appli-

cations that have the same application language.

Action Result

1 On the context-sensitive menu of the 
requested list window, click Filter.

The “User Definable Filters” dialog box 
appears.

2 In the „Prepare Filter“ tab, select the 
filter, type the identification(s) of the 
objects in the fields, and click OK.

The selected objects are displayed in 
the list window.
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Disabling Browse Filters

Exporting and Sending Browse Filters
A filter definition can be exported to a file or be attached to an e-mail.

Action Result

1 On the context-sensitive menu of the 
requested list window, click Reset 
Filter.

Action Result

1 In the „Define Filter“ tab of the “User 
Definable Filters” dialog box,

• click Export to export the filter 
definition to a file.

• click Send Mail to mail the fil-
ter definition.

The „Save as“ dialog box appears. The 
file can be saved with the extension 
„.dmf“.

The e-mail form appears and the filter 
definition file is attached.
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Importing Browse Filters

Importing Browse Filters directly from the E-mail

Action Result

1 In the „Define Filter“ tab of the “User 
Definable Filters” dialog box, click 
Import.

The „Open“ dialog box appears. The file 
with the extension „.dmf“ can be 
opened and imported.

Action Result

1 On the File menu of the overview 
window, click Scan Mail.

All attached files with the extension 
„.dmf“ are searched und displayed in 
the „Loading Filters from Mail“ dialog 
box.

2 Select the requested files, and click 
Load.

The selected files are imported.
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Defining Units

Options
The “Options” dialog box is used to define the view of ID and AuxID, the dispenser con-
nection, the use of stock solutions, the selection of units, and the paper orientation.

Action Result

1 On the Tools menu, select Define 
Units.

The “Unit” dialog box appears.

2 Select a unit or specify a new name.

3 Specify or alter the parameters. Refer to Unit Dialog Box on page 7-111.

4 Click Save. The new or modified unit is saved.

Action Result

1 On the Tools menu, select Options. The “Option” dialog box appears.

2 Select the corresponding tab.

3 Specify or alter the parameters. Refer to Options Dialog Box on page 7-
112.

4 Click Save. The new or modified option is saved.
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Import and Export
Datacolor MATCHTextile supports the import/export of samples and colorant sets with 
different file formats:

• Sample Import/Export with Datamatch format (*.EXP, *.EXQ files)
• Sample Import/Export with Datacolor Envision or Datacolor Tools (*.QTX files)

• Sample Import/Export with Datacolor MATCHTextile (*.XML files)

• Colorant Set Import/Export with Datacolor MATCHTextile (*.XML files).
The XML files may become very big (a file with 120 samples is about 370KB). You can 
compress them drastically (24 KB) using WinZip.

Exporting Data
Export function for color samples.

Note
Internet Explorer Version 5.01 Sp2 or higher must be installed to run the Import/Export 
of XML files.

Action Result

1 On the Tools menu, select Export. The “Export” dialog box appears.

Refer to Export Dialog Box on page 7-
135.

2 Select the data type and the format. Attention: Datamatch, Datacolor 
Tools or Datacolor Envision cannot 
import XML files.

3 Specify path and file name of the 
export file or use the browse func-
tion, and click Export.
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Importing Data

Action Result

1 On the Tools menu, select Import. The “Import” dialog box appears.

2 Specify path and file name of the 
import file or use the browse func-
tion.

Refer to Import Dialog Box on page 7-
134.
Refer to Importing Colorant Sets on 
page 4-14 for importing colorant sets.

3 Click OK. If the corresponding options are set, all 
or the existing samples are prompted. 
You can Save, Save with Prefix, or 
Skip them.

Note
• Samples are not imported if either the name or the spectral data is the same as 

data that already exits in the database.
• The import function compares the spectral data when the sample name already 

exists. A new sample is only created if the spectral data is different. E.g., if sam-
ple „Blue 4711" is already in the database, the imported sample, which has the 
same name but different spectral data, is imported as „Blue 4711 - 001".

• Samples imported from EXP files are always stored in the database. If the sam-
ple name already exists, a new sample is created with an extension in the name, 
e.g. sample „Blue 4711" is saved as „Blue 4711-0“.
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Importing Colorant Sets

Note
• If you import a colorant set that already exists, the program updates the new 

data. Calibration data is always updated. Dyestuff prices are not imported.
• If the fiber of the colorant set does not exist in the database, a dialog opens 

where you can select an equivalent from your database.
 This is to avoid creating the same fibers in different languages (e.g. Co, Bw, 

etc).
• If there is no fiber in the database that matches the fiber of the colorant set, click 

No Match . A new fiber is then created.
• Click OK to start the import.
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Note
• The dye class is treated in the same way as the fiber.
• If the dye class of the colorant set does not exist in the database, a dialog opens 

where you can select an equivalent dye class from your database.
 This is to avoid creating the same dye classes in different languages (e.g. Dis-

persion, Disperse, or Cationique and Basic etc).
If there is no dye class in the database that matches the dye class of the colorant 
set, click No Match . A new dye class is then created.

•  You can modify the dye class ID and name before you start the import.
• Click OK to start the import.
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Importing and Exporting Samples as QTX Files

Datacolor MATCHTextile can export/import samples to/from QTX files. A file always con-
tains a standard and its batch(es). It is not possible to select more than one standard. In 
this case, you must specify multiple export files.

Backing Up Using Datacolor MATCHTextile

The backup function saves the database to the selected target drive and folder.

Note
If you select only batches, the dialog box closes when you click „OK“. No samples are 
then exported.

Action Result

1 On the “Tools” menu, select 
Backup.

The “Backup” dialog box appears.

2 Specify target drive and path (or use 
the browse button), and click OK.

The contents of the database are 
saved.

Caution
Before the backup is made all databases are validated. This may take up to sev-
eral minutes depending on the size of the databases. If there is a problem with 
one of the databases, a message is displayed and the backup is not made. An old 
backup must be restored in this case.
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Backing Up Using Sybase Utilities
The backup utility is used to store running databases, database files, transaction logs, 
and write files.

You can access the backup utility ...

• using Sybase Central, or,
• using the system command line to call the dbbackup utility. This utility can be 

used for specifying batch or command files.
The backup utility copies the database file and the transaction log of a single database.

Backing Up Using Sybase Central
Backing Up A Running Database

Backing Up A Database File or A Running Database

Action Result

1 Start Sybase Central.

2 Connect the database.

3 Right-click the database and select 
Backup on the context-sensitive 
menu.

4 Follow the instructions of the wizard.

Action Result

1 Start Sybase Central.

2 Open the „Utilities“ folder in the left 
panel.

3 Double-click the Backup Database 
in the right panel.

4 Follow the instructions of the wizard.
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The dbbackup Command
Syntax
Dbbackup [switches] path

Switches

Switch Description

-c „keyword=value“ Database connection parameters. If the connection parameters are not 
specified, the parameters of the SQLCONNECT environment variable will be 
used (if they are set).
Parameters:
eng=engine
dbn=database name
uid=user ID The user must have DBA authority or REMOTE DBA 

authority.
pwd=password

-d Only stores the main database file.

-l file name Stores the transaction log file to a file with the specified name.

-n The switch is only active, if the switch -r is set.
Changes the name of the transaction log file to the following format:
yymmddnn.log
yy year
mm month
dd day
nn number in the range of 00 to 99.

-o file name Creates a file for the log output.

-q Quiet mode: Messages are not printed.

-r Rename and start a new transaction log.

-t Only stores the transaction log.

-w Only stores the write file.

-x Deletes and restarts the transaction log.

-xo Deletes and restarts the transaction log without backup.

-y Replaces files without confirmation.
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Importing and Exporting Print Forms (Tools Menu)

Exporting Print Forms (Tools Menu)

Importing Print Forms (Tools Menu)

Caution
If the print form database is to be replaced, the old print forms must be exported 
first.
Your print forms will not be lost, if you have not exported them. The existing 
database is renamed by the setup program. The user can access the database by 
changing the database connection in the ODBC settings for the print form DSN.

Action Result

1 On the “Tools” menu, select Export 
Print Form.

The “Form maintenance” dialog box 
appears. Refer to Form Maintenance 
Dialog Box on page 7-136.

2 Select the print forms to be 
exported, and click Export.

The „Save as“ dialog box appears.

3 Specify a file name, and click Save.

Action Result

1 On the “Tools” menu, select Import 
Print Form.

The “Open” dialog box appears.

2 Select the print form export file 
(*.pfe) to be imported, and click 
Open.

The „Save as“ dialog box appears.
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ASCII Output (Option)
The ASCII output option supports writing data to an ASCII file when you can print data. 
This option includes specifying, modifying and deleting ASCII forms.

Specifying ASCII Forms

Action Result

1 On submenu „ASCII Forms“ of the 
“Tools” menu, select New.

The “ASCII Output Definition” dialog 
box appears.

2 Select a template from the list, and 
click Next.

The „Data“ dialog box appears.
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Folder without selected fields. Click the folder to open or to close it.

Folder with selected fields (signed by red dots). Click the folder to open or close it.

Non-selected field with opened properties. Double-click the icon to select the field. 
Click the icon to close the field properties.

Selected field with closed properties. Double-click the icon to deselect the field. 
Click the icon to open the field properties.

3 Select the fields to be written to the 
ASCII file.

The corresponding field properties are 
displayed.

The number of decimal digits can be 
altered for all fields of type „double“.

4 Click Next. The „Options“ dialog box appears.
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Field Delimiter If necessary, change the field delimiter.

Record Delimiter If necessary, change the record delimiter.

String Delimiter If necessary, change the string delimiter.

Field Description Line Check the box if a field description line is required.

Field Description Prefix If necessary, type a field description prefix.

File Name Type the path and the file name.
File Select „Append“ if the new records should be added to an 

existing file, or, 
select „Overwrite“ if the existing file should be overwritten.

5 Click Next. The „ASCII Form Name“ dialog box 
appears.

6 Type the name of the form, and click 
Finish.
4 - 22 Datacolor MATCHTextile Version 1.0 Datacolor



ASCII Output (Option) 4 - Configuration and Administration
ASCII Output of Recipes

Example: ASCII output of a laboratory recipe

ASCII Output of Basic Data

Example: ASCII output of an affinity

Action Result

1 In the „Recipe List“ window, double-
click the recipe that should be 
printed to an ASCII file.

The “Show Full Recipe” dialog box 
appears.
Refer to Show Full Recipe Dialog Box 
on page 5-75.

2 Click ASCII. The file is saved to the place specified 
in the ASCII form.

@"Recipe_ID","Recipe_Name","SubstrateDelivery_Name","CombProcess_ID","CombProcess_Name","ColorType_
Name","Trial","Weight","Quality_ID","Quality_Name"
"129","Ref. Beige","","REA-BEZ","Reactive Bezema Exhaust","Rec. Beige SM",1,10.00,"1","Cotton bleached "
@"Product_ID","Product_Name","RecipeAmount","RecipeUnit","ActualCost","Amount","Unit"
"NaCl","Common Salt",30.00,"g/l",0.00,3.00,"g"
@"Product_ID","Product_Name","RecipeAmount","RecipeUnit","ActualCost","Amount","Unit"
"SoCar","Sodium Carbonate",5.00,"g/l",0.00,0.50,"g"
@"DyeSet","dEIlluminant","dE","MetamerismText1","Metamerism1","MetamerismText2","Metamerism2"
"Reactive Exhaust","dE (D65)",0.00,"Metamerism (A)",0.07,"Metamerism (F11)",0.30

Action Result

1 In the corresponding list window, 
select the object that should be 
printed to an ASCII file.

2 On the basic data menu, click 
ASCII.

The file is saved to the place specified 
in the ASCII form.

@"ID","Name","FiberGroup"
"55PES/45CV WASH","55PES/45CV washed 70° C","PES/VI"
@"Fiber","Part"
"Polyester",55.00
@"Fiber","Part"
"Viscose",45.00
@"QualityID","QualityName"
"55PES/45CV LICL","55PES/45CV Libero Classic"
*****
@"ID","Name","FiberGroup"
"CO3","C04200 (BASF) gebl.BW-RENFORC","CO"
@"Fiber","Part"
"Cotton",100.00
@"QualityID","QualityName"
"S4","C04200 (BASF) gebl.BW-RENFORC"
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Calibrating the Monitors Using Datacolor SPYDER2

This function is used to perform the monitor calibration for adjusting the color of the 
monitor. After calibrating the monitor, all color patches displayed on the screen are more 
similar to the color of the measured sample. A calibrated monitor enables you to judge 
and compare colors more correctly before dyeing.

Note
This function is enabled if the Datacolor SPYDER2 is connected to the USB port.

Action Result

1 In the „Tools“ menu, select 
Calibrate Monitor.

The assistant for monitor calibration 
appears.

2 Follow the advises on the screen.
4 - 24 Datacolor MATCHTextile Version 1.0 Datacolor



Sending E-mails 4 - Configuration and Administration
Sending E-mails
All print files can be sent as an e-mail if a mail program is installed that meets the MAPI 
standard, e.g., MS Outlook.

Mailing Basic Data, Lab Dye Lots, Colorant Sets

Mailing Recipe Tables

Action Result

1 In the corresponding list window, 
select the objects that should be 
mailed.

2 On the „Basic data“ menu, select 
Display.

The Print Preview appears.

3 Click the e-mail button. The e-mail form appears.
The pages of the print preview are 
converted to the JPEG format and 
attached to the e-mail.

4 Fill in the form with e-mail address 
and mail text, and send the e-mail.

Action Result

1 On the context-sensitive menu of the 
recipe table, click Mail Table.

The e-mail form appears.
The recipe table is converted to the 
JPEG format and attached to the e-
mail.

2 Fill in the form with e-mail address 
and mail text, and send the e-mail.
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Specifying Print Forms Using the Pager
The pager is used to specify print forms. A set of forms is delivered by Datacolor. The 
user can modify these forms or specify new ones.

Starting the Pager

Specifying A New Print Form
Refer to Pager Window on page 7-137 for more information about the parameters.

1. On the Windows start menu or the desktop, click the Pager 
icon.
The “Pager” window appears.

Action Result

1 In the toolbar or on the “File” menu, 
select New.

The “Template Identification” dialog box 
appears.

2 Select “Application”, “Option” (object 
type), “Language”, and “Version”, 
and click OK.

An empty form appears containing all 
sections available for the selected 
option.

3 Click the section to be specified.

Inactivate an unused section:
On the Edit menu, select Hide Cur-
rent Section, or
select the requested section on the 
“Sections” menu.

Specifying a text field:
1. In the toolbar, select the text 

tool.
2. Draw and place the requested 

text field.
3. In the toolbar, select “Toggle 

Properties.”
4. Specify the text and change the 

other parameters if requested.

Specifying a database field:
1. In the toolbar, select “Toggle 

Properties.”
2. Select and place the requested 

database field. The parameters 
of the fields can be altered 
using the “Properties” box.

The check mark is removed and the 
section is not used in the current print 
form.

The “Properties” box appears.

The “Fields” list box opens displaying all 
available fields.
A text field for the description and a field 
for the data is displayed.
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4 Draw rectangles and ellipses:
1. In the toolbar, select the rectan-

gles or ellipses tool.
2. Draw and place the graph. The 

parameters of the graph can be 
altered using the “Properties” 
box.

Enter a bitmap graph:
1. In the toolbar, select the “Bit-

map” tool and click the selected 
section.

2. Search and select the graph
(supported are *.bmp, *.pcx, 
*.jpg graph), and click Open.

3. Place the graph. The parame-
ters of the graph can be altered 
using the “Properties” box.

Specifying date/time, page num-
ber or form (file) name:
1. In the toolbar, select the re-

quested tool and place the field.

Remove all field from the current 
section:
1. In the toolbar, select the 

requested tool and place the 
field.

Deleting a field:
1. Select the field and press Ctrl + 

Del.

The “Open” box appears.

5 In the toolbar or on the “File” menu, 
select Save (As).

The “Form Name” dialog box appears.

6 Specify a form name, and click OK. The new print form is created.
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Modifying A Print Form
Refer to Pager Window for more information about the parameters.

Deleting or Renaming A Print Form

Action Result

1 In the toolbar or on the “File” menu, 
select Open.

The “Template Identification” dialog box 
appears.

2 Select “Application”, “Option” (object 
type), “Language”, and “Version”, 
and click OK.

The selected form appears.

3 Alter the form as requested. Refer to 
Specifying A New Print Form on 
page 4-26.

4 In the toolbar or on the “File” menu, 
select Save, and click OK.

The print form is altered.

Action Result

1 In the toolbar or on the “File” menu, 
select Delete/Rename.

The “Form Maintenance” dialog box 
appears.

2 Select the requested form.

3 Rename: Click the form name, alter 
the name, and press ENTER.

Deleting: Select Delete, and con-
firm the deletion.

The name is altered.

The selected print form is deleted.
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Importing Print Forms

Exporting Print Forms

Action Result

1 On the “File” menu, select Import. The “Open” dialog box appears.

2 Search and select the form to be 
imported, and click Open.

The selected file is imported.

Action Result

1 On the “File” menu, select Export. The “Form Maintenance” dialog box 
appears.

2 Select the form to be exported and 
click Export.

The “Save as” dialog box appears.

3 Select the path, specify a file name, 
and click Save.

The selected form is exported.
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Customizing Graphs
The background color of all graphical displays and printouts is white, while text and 
curves are black with different line styles and the grid is activated by default.

You can have different settings for background and text color of the graphical displays 
and the printout. Modification of these settings are stored in the registry table of the 
database.

You can only modify the graphical settings in programs with graphical options such as 
the colorant set or the measurement program.

Setting Colors for Graphs

Action Result

1 On the context-sensitive menu, 
select Change Color  (for the dis-
play) or Change Printer Color  
(for color printers).

The „Choose Background Color“ dialog 
box  appears.

2 Select the background color and 
click OK .

The „Choose Text Color“ dialog box  
appears.

3 Select the text color and click OK .
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Setting Line Style and Color

Action Result

1 On the context-sensitive menu, 
select More .

The „Graphic Options“ dialog box  
appears.

2 In the „Curves“ tab , set style, 
color, and line width.

3 Click OK .
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Basics

Starting Datacolor MATCHTextile

Data Handling
Browse and Selecting
Using the object tree
All objects are displayed in a structured list on the left of the “Explorer” window.
Opening and closing structure levels:

Selection of objects:

Context-sensitive menu:
New Folder Adds a new subfolder to the selected folder. Type a meaning-

ful name.

Delete Deletes the selected folder (only if the folder is empty).

New Root Folder Adds a new root folder. Type a meaningful name.

Rename Is used to rename the selected folder.

Data Type in this Folder Opens the „Data in Folder“ dialog box used for searching 
data types and the corresponding data in the selected folder.
Refer to Data in Folder Dialog Box on page 7-13.

Find in Folder Opens the „Find <data type> in Folder“ dialog box used for 
searching data records with a determined name or part of the 
name. The <data type> of the opened list window is used.
Refer to Find in Folder Dialog Box on page 7-14.

Searching data types and the corresponding data in the selected folder
Refer to Data in Folder Dialog Box on page 7-13.

1 On the Windows start menu or the desktop, click the 
Datacolor MATCHTextile icon.
The Datacolor MATCHTextile explorer with the “Over-
view” window appears.

+ A + sign indicates that there are hidden subordinate folders and/or objects. 
Click the + sign to open the next structure level.

- Click the - sign to close all subordinate structure levels.

Action Result/Notes

1 Select the requested object folder 
using the left mouse button.

The object folder data is displayed in 
the corresponding view.
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Searching objects of a determined data type

Using the overview window
Clicking a button opens the corresponding list window. Refer to chapter Windows and 
Dialog Boxes on page 7-1, section Overview Window on page 7-2.

Using the list windows
A mouse double-click in an object opens a window, dialog box, or property sheet, that is 
used to alter or delete the corresponding object data. Refer also to General table func-
tions on page 5-7.

Action Result/Notes

1 On the context sensitive menu, 
select Find in Folder.

The „Find <data type> in Folder“ dialog 
box is displayed. The data type of the 
opened list window is selected.

2 Type the name (or a part of the 
name) of the searched data records, 
select the search restrictions, and 
click Search.

Refer to Find in Folder Dialog Box on 
page 7-14.
The corresponding data is displayed.

3 Select one or more of the items in 
the „Search Result“ box and right-
click to display, print, or to make an 
ASCII output of the data.

Note
The number of data records to be displayed is limited to 1000. A message is displayed, 
if the limit is exceeded
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Using special browse functions and the query designer
“Operations” and “Combined Processes” are windows with special browse functions:

Quick search

Example

Action Result/Notes

1 On the „Select“ menu, click Quick 
Search.

The “Quick Search” box appears. Refer 
to Quick Search Dialog Box.

2 Select the „Search Type“, check the 
“Quick Search Column(s)” and “Glo-
bal Search.”

3 Specify search criteria (* is wildcard 
for unknown leading characters and/
or for unknown characters between 
known ones), and click OK.

In the corresponding browse window, 
the objects found are displayed.
A mouse double-click in the requested 
object opens a window, dialog box, or 
property sheet, that is used to alter or 
delete the corresponding object data.

Note
You can reduce the result list using the “Search in result set” function and more specific 
search criteria.
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Default query

Custom query
For advanced “ITM Process” users only. Refer to the ITM Process documentation.

Field-specific functions

Switch between selection and input mode (1)
Click to switch between selection and input mode.

Selection mode

Input mode

The input mode is locked.

Data selection step by step (2)
The upper partial button selects the values step by step in descending order (previous), 
the lower partial button in ascending order (next).

Browse buttons (3, 4)
The upper browse button (3) opens the “Directory” dialog box used for folder selection.
The lower browse button (4) opens a list or search box to select data corresponding to 
the field.

Action Result/Notes

1 Select Default Query. In the corresponding browse window, all 
objects are displayed.
A mouse double-click in the requested 
object opens a window, dialog box, or 
property sheet, that is used to alter or 
delete the corresponding object data.

3
4

1

2
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Selection aids for fields and table column headers 
The following selection aids are implemented for input fields with a link to another object 
(drop-down combo boxes or fields with a browse button):
Typed characters are used for search criteria. In front of the field, they are displayed in 
red and into disappointed brackets. The following wildcards are available:
% (percent) Replaces an undefined number of characters. % is set per 

default at the end of the search string.
_ (underscore) Replaces any single character. 

[         ] The characters (or a range of characters) between the 
square brackets are to be included in the data found.

Examples: [or] Displays only names that contain the characters o 
or r.

[b-h] Displays only names that contain the characters of 
the range b to h.

[^        ] The characters (or a range of characters) between the 
square brackets are not to be included in the data found.

If you scroll using search criteria, only the corresponding objects are displayed.
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General table functions
Selecting columns for sorting and filtering:

Changing the order:
Click the column title of the selected column for changing the order between ascending 
and descending.
A selection filter can be defined for each column:
1 If necessary, select the column title field.
2 Type the characters to be used as selection criteria. A binocular sign is displayed 

and the data is selected according to the criteria. 

• The wildcard % can be used.

• The selection criteria can be changed as long as the column is selected.

• Use Backspace to remove the character on the left of the cursor.

• Use Shift + Backspace to remove the entire selection criteria.

Examples:

The names of the table columns can be altered using the “User’s Browser Definition” 
function of the “Tools” menu. Refer to chapter Browser Customizing on page 4-6.

Tool tips
In many places tool tips are implemented: Setting the cursor to this place, a context-
sensitive information appears (refer to figure below).

Click the column title to be selected. The column is marked with sorting 
sign and arrow.
Data is sorted using two criterias: 
1st priority has the column you have clicked in;
2nd priority always has the object name (if it is selected in „User’s Brows-
er Definition“.).
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Opening context-sensitive menus
Context-sensitive menus are available in different windows, dialog boxes, and fields 
(Refer to the corresponding descriptions.). For opening, set the mouse cursor into the 
corresponding field or table column and click the right button.

Specifying, Modifying and Deleting Objects

Specify or modify an object, you can specify new objects of another linked object type 
using the corresponding tab or selection field.
Example: In the “Quality/Style Property Sheet”, you can specify a new affinity as fol-
lows:
• Use the “Affinity” tab.
• In the “Affinity” field of the “Quality/Style” tab, use the “Input Form” function of the 

context-sensitive menu.

Opening the input form

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Action Result/Notes

1 If available, select the corresponding 
tab,
or,
right-click the selection field where 
the new object should be entered.

A context-sensitive menu appears.

2 Select Input Form. The requested tab, box, or window 
appears.
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Specifying objects

Modifying and Deleting Objects

Action Result/Notes

1 Select a folder, if necessary.

2 Switch to the input mode. The input mode icon appears.

3 Specify the new object name or 
overwrite the existing name with the 
new one. 

4 Specify the other data. Fields marked with a red * are man-

datory.
Refer to the corresponding description 
in chapter Windows and Dialog Boxes 
on page 7-1 for more information about 
the parameters.

5 Click Insert. The new object is created.

Action Result/Notes

1 Select the object data to be modified 
or deleted.

Refer to Browse and Selecting on page 
5-2.

2 Modifying: In the requested fields, 
change the object data, and click 
Save.

The input mode icon appears.
The object is altered.

3 Deleting: Click Delete and confirm 
the deletion.

The object is deleted.

Note
An object cannot be deleted, if it is linked to other objects. If the system cannot delete 
an object, all valid links are listed in the “Delete Check” info box.
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Calibration and Measurement

Calibrating Your Spectrophotometer
Your spectrophotometer must always be calibrated after switching on. It is recommend-
ed to calibrate at least every eight hours. Different types of spectrophotometers have 
different settings. This section gives a general description of the calibration.

Note
• For further details about your spectrometer refer to the manual supplied with your 

system. 
• It is not possible to re-measure color types if they are linked to other tables.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on.

Note
Leave the spectrophotometer to warm up for a few minutes. Datacolor recommends 
that for the greatest accuracy you should wait thirty minutes before calibrating.

2 If you select the Measure Directly 

button missing calibrations are 
requested automatically. 
For an intentional calibration, click 

the Measure button and in the 
opened “Measurement” dialog box, 
select the “Calibrate” tab.
After specifying the parameter val-
ues according to your spectropho-
tometer, click Calibrate.

Refer to Measurement Main Window 
on page 7-15.

3 Follow the advice on the screen.
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UV Calibration
Calibration Methods

Ganz/Griesser: This procedure uses the Ganz/Griesser calibration method. The light 
source is filtered to simulate the D65 Illuminant and the Ganz Griesser parameters are 
used to calculate the filter position. In addition, the target whiteness value is based on 
10¼ standard observer data.
CIE using D65/10: The light source is filtered to simulate the D65 illuminant. This is the 
procedure used to perform a CIE Whiteness evaluation.
ISO Brightness (C): The light source is filtered to simulate Illuminant C. This is the pro-
cedure used to perform an ISO Brightness evaluation.

Note
There are several methods that can be used to calibrate the adjustable UV filter posi-
tion. Please refer to the whiteness standard you are using to determine the method to 
be used.
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Example using the Ganz/Griesser method

The UV calibration is necessary to ensure a constant UV emission of the bulb.

Definition of the Ganz/Griesser whiteness parameters
This definition is necessary if a bulb or an other part of the optical illumination system 
has been replaced.

Note
The UV calibration is only available for instruments with the whiteness option.

Action Result/Notes

1 In the “Measurement Main Window”, 
select the UV Calibration tab.

2 Select specular Excl.

3 Set aperture LAV.

4 Click Whiteness Parameters. The „Ganz/Griesser Calibration” dialog 
box appears.
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Action Result/Notes

5 In the “Ganz/Griesser Calibration” 
dialog box, specify the “Nominal 
Whiteness”, and click Measure.

6 Repeat step 5 for all samples of your 
whiteness scale.

7 Click Calculate. The calibration results are displayed.
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“Instrument-specific Formula Parameters” dialog box:

Action Result/Notes

8 Re-calibrate until “dW/dS” is 
4000 ±10 (You must measure all 
samples again for each Re-calibra-
tion.).

The program optimizes the UV filter 
position for each re-calibration.

The value of this example is ok.

9 If the value is ok, click Accept. The “Instrument-specific Formula 
Parameters” dialog box appears.
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Checking the UV part of the bulb
The periodical check of the UV emission of the bulb is done using an „Illuminant Check-
er“ sample. The Ganz/Griesser whiteness is calculated and the UV filter is adjusted.

Action Result/Notes

1 In the “Measurement Main Window”, 
select the UV Calibration tab.

2 Select the „UV Calibration Method“.

3 Specify the whiteness of your „Illumi-
nant Checker“ sample in the “White-
ness of Test Tile” field, and click 
Auto-Calibrator.

The whiteness difference is calculated 
and the UV filter is adjusted automati-
cally (if the instrument supports it).

4 Repeat the “Auto Calibration” until 
the “Whiteness Difference“ is in the 
range of 1.5, then click Accept.
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Instrument Correlation
There is always some variation in performance between different instruments. This dif-
ference becomes a part of each color evaluation if the standard and batch measure-
ments are carried out using different instruments. While the inter-instrument agreement 
specification for Datacolor instruments is very tight when working with very small 
acceptability tolerances, small variations in instrument performance may have a signifi-
cant impact on all the color evaluations. Maestro offers the additional "correlation" fea-
ture to reduce these performance differences further.
Correlation allows you to adjust the performance of an instrument in order to match it to 
another reference or "master" instrument. This adjustment is carried out by the applica-
tion of "correlation" factors calculated using the results of the spectral test. Using the dif-
ferences between the master measurement and the current measurement, the program 
calculates a set of factors that are applied to each measurement, and which reduce the 
color difference between the two measurements. By generating correlation factors for 
every instrument used in the supply chain, the measurements made by each unit can be 
adjusted to simulate the performance of a single master unit. The result of this is that 
the Pass/Fail decisions will reflect the differences in the samples rather than in the 
instruments used to measure them. These correlation factors are generated using Mae-
stro. The instrument correlation feature is enabled through the instrument driver mod-
ule, however, which is accessible using any Datacolor program, including Maestro.
Once the correlation factors have been generated, they can be applied to raw measure-
ment data to compensate changes in instrument performance. The adjusted measure-
ment data should then closely resemble the measurement data produced by the master 
unit.
By designating a single instrument as "master", and generating correlation factors for 
every instrument used in the supply chain, you can minimize any color differences 
caused by differences in instrument performance. This allows you to share color data 
electronically, and you will have the confidence that the instruments' Pass/Fail decisions 
are accurate evaluations, regardless of the instrument(s) used for the measurement.

Configuring and Enabling the Maestro Correlation Feature

Notes
• Master Instrument: You must identify the master instrument. This is the instru-

ment used to generate the master measurements for the reference tile set. When 
you select "Install" in the Maestro correlation feature, the information about the 
reference instrument will become available here.

• If the instrument correlation is enabled, all measurement data displayed and 
stored will be adjusted data.

• Instrument correlation can be enabled/disabled using any Datacolor program. 
The "Measurement Main Window" is accessed using either an "Instrument" 
menu or an instrument icon of the Datacolor program you are running.
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Action Result/Notes

1 In the “Measurement Main Window”, 
select the General Options tab.

2 In the left box, click „Correlation“. The „Correlation setup“ box appears on 
the right.

3 Select the master instrument. All information about the master instru-
ment selected appears in the corre-
sponding fields.

4 Click the button ON to enable the 
correlation feature, resp., the button 
OFF to disable it.

When enabled, each measurement 
made will be adjusted based on the cor-
relation data in the file identified at the 
bottom of the window.

5 Click Save options to save your 
settings.
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Green Tile Test
The green tile test checks the instrument after the calibration. If the test fails the instru-
ment must be calibrated again.

Configure the green tile test

Parameters
Perform diagnostic tile ... Values: ALWAYS The test is performed after each 

calibration.
OPTIONAL The test can be skipped.
NEVER The test is not performed.

Action Result/Notes

1 In the General Options Tab of the 
„Measurement Main Window“, select 
Green Tile Test.

2 Set the parameter values, and click 
Save Options.
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Test results:

The samples are named as follows:

Green tile test (Standard): __TEST SF3008 SCI UVINC

Green tile test (Batch): __TEST SF3008 SCI UVINC 010321 11:46

The name contains the type (SF300), the serial number (8), the measurement condition 
(SCI UVINC), and (only for samples) the date and the time of the measurement.
The instrument settings and the measurement conditions are displayed in the status bar 
of the „Measurement Main Window“.

Note
• Only CMC 1:2 is used for the test.
• If the test fails, the traffic light is red. If configured, the status of the instrument is 

set to „not calibrated“.
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Measurement

Single measurement using the “Measure Directly” button

Measurement using the “Measure” button

Single measurement

Note
The program stores the type (tab) of the last measurement. The tab used for the last 
measurement appears for each new one.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on and calibrated.

Refer to Calibrating Your Spectropho-
tometer on page 5-10

2 Place the sample into the spectro-
photometer.

3 For a single measurement and if you 
do not need any parameter alter-
ations, click the Measure Directly 

button.

The measurement is executed.

4 Click Insert to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on and calibrated.

Refer to Calibrating Your Spectropho-
tometer on page 5-10.

2 Click the Measure  button, or, 
on the context-sensitive menu, 
select Measure.

The “Measure” dialog box appears. 
Refer to Measurement Main Window on 
page 7-15.

3 Select the “Single” tab for a single 
measurement.
Select the “Multiple” tab for a multi-
ple measurement.
Select the “Until Tolerance” tab for 
an until tolerance measurement.

Refer to Single measurement on page 
5-20.
Refer to Multiple measurement on page 
5-21.
Refer to Until tolerance measurement 
on page 5-22.

Action Result/Notes

4 Place the sample to the spectropho-
tometer, and click the Measure but-
ton.

The results of the measurement are dis-
played in the subordinate tabs.

5 Click Close. The “Measurement” dialog box is 
closed.

6 Click Insert to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.
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Multiple measurement

Action Result/Notes

4 Place the sample to the spectropho-
tometer, and click the Measure but-
ton. 
For each additional measurement, 
move the sample and click Measure 
again.

The results are displayed in the graph 
and in the table. Average and deviation 
are calculated continually.
Refer to Multiple Tab on page 7-16 
(Measurement Dialog Box.)

5 In the table, cancel the unusable 
measurements using the mouse.
Click Accept Now to save the mea-
surement before the specified num-
ber is done.

Average and deviation are calculated 
continually.

6 If the specified number of measure-
ments is done, the „Measure“ button 
changes to „Accept“.
Click Accept to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.

7 Click Close. The “Measurement” dialog box is 
closed.
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Until tolerance measurement

Action Result/Notes

1 In the „General Options“ tab, select 
the Until Tolerance option.

The „Until Tolerance“ data box appears.

2 Select the formula, set the tolerance 
factor, and click Save Options.

3 Select the Until Tolerance tab.
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4 Place the sample on the spectropho-
tometer, and click the Measure but-
ton. 
For each additional measurement, 
move the sample and click Measure 
again.

The results are displayed in the graph 
and in the table. Average and 
deviation are calculated continually.
Refer to Multiple Tab on page 7-16 
(Measurement Dialog Box.)

5 In the table, cancel the unusable 
measurements using the mouse.
Click Accept Now to save the mea-
surement before the specified num-
ber is done.

Average and deviation are calculated 
continually.
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Manual Input and Modification of Samples
Samples can be inserted manually, and existing samples can be modified using the 
„Sample Input“ dialog box.

Manual Input of Samples

Modification of Samples

Action Result/Notes

1 On context-sensitive menu of the 
„Sample“ list box, select Sample.

The „Sample Input“ dialog box appears. 
Refer to Sample Input Dialog Box on 
page 7-72.

2 Type the new sample name.

3 Specify the data to the „Spectral“ or 
the „Coordinates“ tab, and click 
Save.

The new sample is inserted.

Note
You can copy an existing sample using the Save As button.

Note

Datacolor MATCHTextile synchronizes color type and sample name. If you rename a 
color type, the sample name will also be modified. The same happens to the color type 
name if you change a sample name.

Action Result/Notes

1 On context-sensitive menu of the 
„Sample“ list box, select Sample.

The „Sample Input“ dialog box appears. 
Refer to Sample Input Dialog Box on 
page 7-72.

2 Search and select the sample.

3 Modify the data in the „Spectral“ or 
the „Coordinates“ tab, and click 
Save.

A warning appears.

4 Confirm the saving. The sample is overwritten with the mod-
ified data.
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Specifying Basic Data
The Basic Data application is used to manage basic data, e.g., substrates, dyestuffs, 
auxiliaries, etc. The basic data together with the colorant set definitions are prerequi-
sites for the recipe calculation. The basic data is managed using property sheets. Basic 
data include:
• Quality/Style: Data related to the substrates.
• Product: Data related to the dyestuff and auxiliary.
• Customer: Data related to the customer.
• Color Type: Measured dye sample.
• Parameters: Definition of parameters with value ranges for the dyestuff prop-

erties.

Recommended Sequence of Basic Data Input
1 Qualities/styles with the related objects. Refer to Specifying, Modifying or Delet-

ing a Quality/Style on page 5-26.
2 Products. Refer to Specifying, Modifying or Deleting a Product on page 5-34.
3 Customers. Refer to Specifying, Modifying or Deleting Customers on page 5-39.
4 Parameters. Refer to Specifying, Modifying or Deleting Parameters on page 5-

40.
5 Color Types. Refer to Specifying, Modifying or Deleting a Color Type on page 5-

43.

If these data is defined, the colorant sets can be specified. Refer to Specifying Colorant 
Sets on page 5-47.
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Specifying, Modifying or Deleting a Quality/Style

Quality/Style is a summary of all data in relation to the substrate and contains:
• Quality/style and substrate
• Affinity (quality/style subgroup)
• Fiber group
• Fiber
• Customer
• Substrate - blank dyeing
• Special composition.

Fiber Definition of all single fibers to be dyed.

Fiber group Definition of all fibers used for a quality/style. A fiber group 
can be a single fiber or a combination of different fibers, e.g., 
PES, PES/CO.

Affinity Definition of a link to a fiber group and the part of each fiber 
in %, e.g., PES = 60%, CO = 40%. Can be used for the rela-
tionship to the colorant set.

This link can be specified in the “Affinity” tab of the “Quality/Style Property” sheet, if the 
colorant set is specified. Refer to Excluding/Including Colorant Sets from/into An 
Affinity on page 5-29.

Customer A customer can be assigned to each quality/style.

Substrate - blank dyeing Reflectance measurement of the substrate and quality/style 
effect factor.

Colorant set All related colorant sets are assigned per default. The list can 
be displayed using the Search Colorant Set button. In the 
list, colorant sets can be selected and excluded using the 
Exclude button.

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Colorant set

Customer

Quality/Style

Fiber group

Affinity

Fiber Substrate - 
blank dyeing

Note
The affinity is used to group qualities/styles. Qualities/styles linked to the same affinity 
should have the same dye behavior or should be dyed with the same combined pro-
cess.
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Special composition Used for altering the parts of a composed quality.
Example: In a composition of polyester, cotton and Lycra, 
the Lycra cannot be dyed. If you do not set the Lycra part to 
0%, a recipe is also calculated for the Lycra part. 

Specifying A New Quality/Style
It is recommended to specify the objects in the following sequence:
1 Fiber
2 Fiber group
3 Affinity
4 Customer

5 Quality/style
6 Substrate - blank dyeing

Caution
When using the „Affinity SmartMatch“ matching method, it is imperative that 
only qualities with the same dye behavior are linked to an affinity. Otherwise, the 
results of matching will be unusable.

Action Result/Notes

1 Open the “Quality/Style Property” 
sheet.

Refer to Quality/Style Property Sheet 
on page 7-22 for information about the 
parameters.

2 Select the “Fiber” tab.
Open the fiber list using the browse 
button. If the list is not complete, 
specify the additional fibers in the 
“Fiber” tab.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 Specify the fiber group. Refer to Fiber Group Tab on page 7-25.
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4 Affinity: If there is more than one 
fiber in the fiber group, specify the 
parts (in%, the summary must be 
100%) of the single fibers.

5 In the “Affinity” tab, exclude colorant 
set(s), if requested. 

Refer to Excluding/Including Colorant 
Sets from/into An Affinity on page 5-29.

6 Specify the data of the “Quality/
Style” tab and click Insert.

If requested, refer to Using SmartMatch 
Points for other Qualities on page 5-31.
The quality/style is created. The Sub-
strate - Blank Dyeing and the Sub-
strate Delivery are activated.

7 If the Substrate - Blank Dyeing 
button is activated, you have not 
measured a substrate. Click Sub-
strate - Blank Dyeing to measure 
the first substrate delivery.
If you have to measure a new sub-
strate delivery, click Substrate 
Delivery.

The “Substrate Delivery Dialog” box 
appears. Refer to Substrate Delivery 
Dialog Box on page 7-27 for information 
about the parameters.
Refer to Substrate Delivery: Example 
on page 5-30 for an example.

8 Measure a sample of the delivered 
substrate.

Refer to Calibrating Your Spectropho-
tometer on page 5-10 and Measure-
ment on page 5-20.

9 Click Save. The new quality/style is created.

Note
Fields marked with a red * are mandatory.
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Excluding/Including Colorant Sets from/into An Affinity

Note
The possible links from colorant sets to affinities are not displayed immediately if you 
scroll through the list of affinities. Instead, click the Search Colorant Sets 

 button to see which links are defined or excluded (marked with 
an *).

It can take several minutes to find all colorant sets valid for an affinity, depending on the 
number of items in the database. The list of affinities and colorant sets is filtered to 
avoid the definition of incorrect links.

Action Result/Notes

1 Exclude: Select an included colo-
rant set (not marked with an *) and 
click Exclude.
Include: Select an excluded colo-
rant set (marked with an *) and click 
Include.

Note
The number of colorant sets linked to the current affinity is displayed under “Total.”
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Substrate Delivery: Example
Example for Blends PES/CO 70/30. Refer to Substrate Delivery Dialog Box for more 
information.

If you want to measure only the total substrate, it is sufficient to do it only once. No mea-
surements are needed for an individual fiber. 
If you have burned out the cotton, you can measure the polyester skeleton, pressing the 
Measure button in the fiber row “Polyester.”

In the example above, the total substrate is measured and stored with the substrate 
delivery and the polyester skeleton is stored together with the substrate delivery fiber 
“Polyester.” These substrate delivery measurements are used for recipe calculations.

Total
Substrate

Total
Substrate

PES
skeleton

Note
• If it is possible to separate all fibers, you can measure all.
• The Measure buttons become inactive if the substrate delivery is linked to a rec-

ipe.
5 - 30 Datacolor MATCHTextile Version 1.0 Datacolor



Specifying Basic Data 5 - Using Datacolor MATCHTextile
Substrate Delivery with Colorant Set Dependent Effects
Substrate deliveries can be used with colorant (dye) set dependent effects:

Using SmartMatch Points for other Qualities
• Check „Use Affinity SmartMatch“, if SmartMatch points of all the qualities linked 

with the same affinity should be used.

Action Result/Notes

1 In the „Substrate Delivery“ dialog 
box, click the Effect button.

The „Substrate Delivery Effect“ dialog 
box appears. Refer to Substrate Deliv-
ery Effect Dialog Box.

2 Select the colorant set(s) (colorant 
set) and click Insert.

The selected colorant set is added to 
the table.

3 Type the requested effect into the 
„Effect“ column.

4 Click Close. The „Substrate Delivery Effect“ dialog 
box closes.

Caution
When this method of SmartMatch matching, it is imperative that only qualities 
with the same dye behavior are linked to an affinity. Otherwise, the results of 
matching are unusable.
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Overwriting Measurements of Substrate Deliveries

Example:

Note
Overwriting a measurement of a substrate delivery is only possible if the substrate 
delivery is not linked to other data such as recipes etc. If a sample is linked to a recipe 
and the measurement is not correct, you will have to delete the recipe, correctly re-
measure the sample and calculate the recipe again.

The total substrate is correct.
The measurement for viscose 
is not correct.
1 Click the Measure button 

and 
confirm the question in the 
warning.

You can now overwrite the 
measurement of the substrate 
delivery.
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Modifying and Deleting A Quality/Style

Deletion of substrate delivery samples

Action Result/Notes

1 Open the “Quality/Style Property” 
sheet.

Refer to Quality/Style Property Sheet on 
page 7-22 for information about the 
parameters.

2 Modifying: Select the quality/style, 
alter the data, and click Save.
You can specify an additional sub-
strate using the “Substrate Delivery” 
button.
Deleting: Select the quality/style, 
click Delete, and confirm the dele-
tion.

Note
• If you delete a substrate delivery from the quality, you can also delete the reflec-

tance sample. Check the corresponding check box.
• If you delete a substrate delivery in the explorer view, the sample is not deleted.
• Remember that the substrate delivery can only be deleted if there is no link to 

other data.
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Specifying, Modifying or Deleting a Product

A Product is either a dyestuff or an auxiliary.

Dyestuff

Auxiliary

Product supplier Supplier-specific data, e.g., name, address, phone number.

* Supplier dye name Dye name of the supplier, e.g., Remazol, Terasil, etc.

Stock solution Definition of different dilutions used for optimizing the accu-
racy of manual dyestuff pipetting and to prevent that the max-
imum of the dye solution is to be exceeded.

* Dyestuff type Type of the delivered dyestuff, e.g., conc, gran., supra.

Dye class Classification of dyes according to the chemical composition 
and reaction, e.g., disperse, reactive.

* Dye description Additional description of the dye, e.g., brilliant, dark.

* Dyestuff color Color names, e.g., red, green, blue.

Formula setting Settings for recipe calculation used for production: e.g. 
default unit.

* Supplier dye name, dyestuff type, dye description, and dyestuff color can be used to 
compose the product name.

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Supplier dye name Dyestuff

Dye description

Dye class

Dyestuff type

Stock solution

Dyestuff colorProduct supplier

Auxiliary

Product supplier Stock solution Formula setting
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Specifying A New Product
It is recommended to specify the subordinate objects first.

Modifying and Deleting A Product

Note
• The stock solution defines dilutions used to optimize pipetting in the laboratory. 

Refer to Specifying A Stock Solution on page 5-36 for new stock solution tables.
• Stock solutions can be specified for dyestuffs and auxiliaries, for “exhaust” and 

“continuous” processes.
• Stock solutions are only selectable if the “Stock Solution” is checked in the 

“Options” dialog box.

Action Result/Notes

1 Open the “Product Property” sheet. Refer to Product Property Sheet on 
page 7-31 for information about the 
parameters.

2 Specify the parameters of a new 
dyestuff in the “Dyestuff” tab or the 
parameters for a new auxiliary in the 
“Auxiliary” tab. 
The other tabs are used to specify 
new subordinate objects.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 Click Insert. The new product is created.

Note
Fields marked with a red * are mandatory.

Action Result/Notes

1 Open the “Product Property” sheet. Refer to Product Property Sheet on 
page 7-31 for information about the 
parameters.

2 Modifying: Select the product, alter 
the data, and click Save.
Deleting: Select the product, click 
Delete, and confirm the deletion.
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Specifying A Stock Solution
Note
• The stock solution defines dilutions used to optimize pipetting in the laboratory.
• Stock solutions can be specified for dyestuffs and auxiliaries, for “exhaust” and 

“continuous” processes.
• Stock solutions are only selectable if the “Stock Solution” is checked in the 

“Options” dialog box.

Action Result/Notes

1 In the “Stock Solution” of the “Prod-
uct Property” sheet, specify a name 
for the new stock solution.
Refer to Stock Solution Tab on page 
7-41 for information about the 
parameters.

2 Insert the values according to your 
needs.

3 Click Insert. The new stock solution is created.

Note
Fields marked with a red * are mandatory.
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Specifying, Modifying or Deleting a Dye Process

The dye process contains dye class and process type.

Specifying A New Dye Process

Specifying dye fiber groups

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Action Result/Notes

1 Open the “Dye Process Property 
Sheet.”

Refer to Dye Process Property Sheet 
on page 7-29 for information about the 
parameters.

2 Specify name and identification of 
the new dye process.

3 Specify the parameters of the “Dye 
Process” and the “Process Factor” 
tabs.

Refer to Specifying dye fiber groups on 
page 5-37, Browse and Selecting on 
page 5-2, and Specifying, Modifying 
and Deleting Objects on page 5-8.

4 Click Insert. The dye process is created.

Action Result/Notes

1 In the table of the “Dye Process” tab 
(Dye Process Property Sheet), dou-
ble-click into an empty row.

The “Dye Fiber Group for Dye Process“ 
dialog box appears.

2 Select the fiber(s) that can be dyed 
in the same bath, and click OK.

The dialog box closes and the selected 
fiber(s) are displayed in the table row.

3 Repeat steps 1 and 2 to define addi-
tional dye fiber groups.

Refer to the note below.

Note
• Each row defines a dye fiber 

group to be dyed in the same 
bath.

• Fields marked with a red * are mandatory.
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Modifying and Deleting A Dye Process

Specifying, Modifying or Deleting a Dye Class
Specifying A New Dye Class

Modifying and Deleting A Dye Class

Action Result/Notes

1 Open the “Dye Process Property 
Sheet.”

Refer to Dye Process Property Sheet 
on page 7-29 for information about the 
parameters.

2 Modifying: Select the dye process, 
alter the data, and click Save.
Deleting: Select the dye process, 
click Delete, and confirm the dele-
tion.

Action Result/Notes

1 Open the “Dye Class” tab of the 
“Product Property Sheet.”

Refer to Dye Class Tab on page 7-36.

2 Specify name and identification of 
the new dye class.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 If necessary, specify the parameters 
in the table.

Refer to General table functions on 
page 5-7.

4 Click Insert. The dye class is created.

Note
Fields marked with a red * are mandatory.

Action Result/Notes

1 Open the “Product Property Sheet.” Refer to Dye Process Property Sheet 
on page 7-29 for information about the 
parameters.

2 Modifying: Select the dye class, 
alter the data, and click Save.
Deleting: Select the dye class, click 
Delete, and confirm the deletion.
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Specifying, Modifying or Deleting Customers
The customer data contains name, identification, tolerance details, and status.

Specifying A New Customer

Modifying and Deleting A Customer

Action Result/Notes

1 Open the “Customer Property 
Sheet.”
Refer to Customer Property Sheet 
on page 7-43 for information about 
the parameters.

2 Specify name, identification, and 
data of the new customer.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 Click Insert. The data of the new customer is creat-
ed.

4 Click the Address button. The “Address” dialog box appears 
Refer to Address Dialog Box on page 7-
44.

5 Specify the address, and click Save 
and Close.

The address is inserted and the 
“Address” dialog box closes.

Note
Fields marked with a red * are mandatory.

Action Result/Notes

1 Open the “Customer Property” 
sheet.

Refer to Customer Property Sheet on 
page 7-43 for information about the 
parameters.

2 Modifying: Select the customer, 
alter the data, and click Save.
Deleting: Select the customer, click 
Delete, and confirm the deletion.
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Specifying, Modifying or Deleting Parameters
The parameter values (e.g. “fastness”) are defined in a colorant set for each dye, and 
used to set limits for the recipe calculation.

Specifying A Parameter

Modifying and Deleting A Parameter

Action Result/Notes

1 Open the “Parameter Definition Dia-
log” box.

Refer to Parameter Definition Dialog 
Box on page 7-57 for information about 
the parameters.

2 Specify the parameter name, the 
type, and the values.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 Click Insert. The data of the new Parameter is creat-
ed.

Note

• The “Formula Setting” button is used for production. Datacolor MATCHTextile uses 
only the Calculate without Print button to exclude the parameters from printing.

• Fields marked with a red * are mandatory.

Action Result/Notes

1 Open the “Parameter Definition Dia-
log” box.

Refer to Parameter Definition Dialog 
Box on page 7-57 for information about 
the parameters.

2 Modifying: Select the parameter, 
alter the data, and click Save.
Deleting: Select the parameter, click 
Delete, and confirm the deletion.
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Parameter Examples
Parameter type “String Value”

This fastness parameter is used in the colorant set program:

Parameter type “List Box”

This fastness parameter is used in the colorant set program:
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Parameter type “Value”

This parameter is used for a rule: The batching time depends on a combined process.
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Specifying, Modifying or Deleting a Color Type
Measured color pattern. A color type is substrate-independent.
A color type is a standard and can be linked to a recipe.

Specifying A New Color Type

Modifying and Deleting A Color Type

Action Result/Notes

1 Open the “Color Type Property 
Sheet.”

Refer to Color Type Property Sheet on 
page 7-45 for information about the 
parameters.

2 Specify the name and the additional 
parameters.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

3 Measure the sample. Refer to Measurement on page 5-20.

4 If the measurement is finished, click 
Insert.

The data of the new color type is creat-
ed.

Note
Fields marked with a red * are mandatory.

Note

Datacolor MATCHTextile synchronizes color type and sample name. If you rename a 
color type the sample name is also modified. The same happens to the color type name 
if you change a sample name.

Action Result/Notes

1 Open the “Color Type Property” 
sheet.

Refer to Color Type Property Sheet on 
page 7-45 for information about the 
parameters.

2 Modifying: Select the color type, 
alter the data, and click Save.
Deleting: Select the color type, click 
Delete, and confirm the deletion.
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Specifying, Modifying or Deleting Tolerances
Specifying A New Tolerance

Action Result/Notes

1 Open the “Tolerance Block Program” 
dialog box.

Refer to Tolerance Block Program Dia-
log Box on page 7-46 for information 
about the parameters.

2 Specify the tolerance name

3 Select the requested tab and specify 
the tolerance values.
For Datacolor pass/fail formula refer 
to the following section.

Refer to Browse and Selecting on page 
5-2 and Specifying, Modifying and 
Deleting Objects on page 5-8.

4 Click Save. The new tolerance is created.
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Datacolor pass/fail formula

Action Result/Notes

1 Select the “Datacolor” tab.

2 Specify the tolerance name

3 • Click Datacolor Block Training 
for tolerance block calculation 
based on visually excepted stan-
dards and the related batches.

The “Datacolor Tolerance Block” dialog 
box appears.
Refer to CieLab Tab on page 7-47 for 
information about the parameters.

• For changing the formula, click 
Diff. Formula and select the for-
mula.

The „Select Difference Formula“ dialog 
box appears.

Select or measure the standard 
and the related batches.

In the table, the batches are listed. All 
batches with a CMC color difference <= 
1 are selected automatically.
Click the refused batches to select.

Select other colors (standards 
and batches) to specify a color-
independent tolerance block.

Select at least all colors you want to 
proof to get a useful tolerance block.

Click Apply. The „Datacolor Tolerance Block“ dialog 
box closes.

• Click Block Manual Input for a 
manual input of tolerance values.

The „Manual Input of Tolerance Values“ 
dialog box appears
Refer to Manual Input of Tolerance Val-
ues Dialog Box on page 7-56 for infor-
mation about the parameters.

Select or measure the standard 
and specify the tolerance values.

Click Apply The “Manual Input Tolerance Values” 
dialog box closes.

4 Click Save. The new tolerance is created.

Note
A Datacolor tolerance block can be modified by adding more standards and batches.
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Displaying Datacolor Tolerance Values

Modifying and Deleting Tolerance Values

Action Result/Notes

1 Select the requested “Datacolor” tol-
erance.

2 Click Tolerance Values. The “Tolerance Value Output” dialog 
box appears.
Refer to Tolerance Block Program Dia-
log Box on page 7-46.

3 Select or measure the requested 
batch.

The tolerance values are displayed.

Action Result/Notes

1 Open the “Tolerance Block Program” 
dialog box.

Refer to Tolerance Block Program Dia-
log Box on page 7-46 for information 
about the parameters.

2 Modifying: Select the tolerance, 
alter the data, and click Save.
Deleting: Select the tolerance, click 
Delete, and confirm the deletion.
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Specifying Colorant Sets

Introduction
A colorant set is a set of color information about the substrate and dyes the system 
uses to produce match and correction recipes. It contains...
• information about the overall colorant set, e.g., the substrate and process that will 

be used with the dyes;
• product information about each dye, e.g., strength, minimum and maximum con-

centrate;
• color information about each dye;

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Colorant set

Dyestuffs (product)

Affinity
Used for pre-

selection

Dye fiber group

Parameter

Dye class

Auxiliary (product)

Substrate
(quality/style)

Dye process

Connection
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Specifying A Colorant Set

Action Result/Notes

1 Open the “Colorant Set List” window.

2 On the “Colorant Set” or the context-
sensitive menu, select 
New  Textile.

The “Colorant Sets” window appears.
Refer to Colorant Set Window on page 
7-77 for information about the parame-
ters.
For the colorant set type ...
• „Textile, Alternate Substrate“ refer to 

Specifying A Colorant Set for An 
Alternate Substrate on page 5-55.

• „Textile Printing with Dyes“: In addi-
tion, an extender must be selected. 
Refer also to Completing An 
Imported Textile Printing Colorant 
Set on page 5-57.

3 Specify the name and the identifica-
tion of the new colorant set.

Refer to Browse and Selecting on page 
5-2 and Specifying objects on page 5-9.

4 A click in the „Dye Process“, „Sub-
strate Delivery“ and „Operation“ field 
opens the corresponding selection 
box.
Select Input Form on the context-
sensitive menu of the selection box 
to specify a new object.

Refer to Specifying, Modifying and 
Deleting Objects on page 5-8.

5 Click Store. The new colorant set is created.
The fiber is saved as a “Dye Fiber 
Group” in the dye process.
Continue with Specifying Colorants and 
Calibration Samples on page 5-50.

Note
If you want to store the auxiliaries used for the calibration dyeings, you can define an 
auxiliary recipe before you start to prepare dyestuffs. These auxiliaries are used for all 
dyestuffs added to the colorant set later on. If the concentration of a product depends 
on the dyestuff concentration, however, you must adjust it individually.

Refer to Auxiliary Recipes on page 5-49.
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Auxiliary Recipes
If you want to store the auxiliaries used for the calibration dyeings, you can define an 
auxiliary recipe before you start to prepare dyestuffs. These auxiliaries are used for all 
dyestuffs added to the colorant set later on. If the concentration of a product depends 
on the dyestuff concentration, however, you must adjust it individually.

Action Result/Notes

1 In the “Colorant Sets” window, click 
Auxiliary Recipe.

The „Introduce Your Complementary 
Components in Calibration Series“ dia-
log box appears.

2 Click New to select or specify a 
product.

The corresponding selection box 
appears.

3 Select the product and click OK.
To specify a new product, select 
Input Form on the context-sensitive 
menu of the selection box.

4 Select the corresponding field and 
press the space bar to specify the 
values.

The unit is set automatically if a default 
unit is specified for the selected product 
in the „Formula Setup“ dialog box.
Refer to Product Property Sheet on 
page 7-31 and Formula Setting Dialog 
Box on page 7-42

5 Click OK if finished. The auxiliaries are displayed for each 
calibration sample in the „Components 
of One Calibration Series“ dialog box. 
You can change the concentration or 
add other auxiliaries here. These modi-
fications are only valid for the selected 
calibration dyeing. Refer to Specifying 
Colorants and Calibration Samples on 
page 5-50.
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Specifying Colorants and Calibration Samples

If you open a Colorant set containing colorants not calibrated, a message box appears 
for a few seconds when you open the colorant set the next time.

Action Result/Notes

1 If the header information is filled in 
and an auxiliary recipe is defined, 
click New to add colorants to the col-
orant set. 

The „Create Calibration Series“ dialog 
box appears.
Refer to Create Calibration Series Dia-
log Box on page 7-82.

2 Select the colorant you want to cali-
brate. 
If the colorant is new, click New to 
specify a dyestuff.

Refer to Specifying A New Product on 
page 5-35.

3 Type in the concentrations of your 
calibration samples, separated by a 
blank or a comma.

The colorant name plus the concentra-
tion is used for sample name (field 
„Sample“). You can modify the sample 
name in the „Prefix“ field.

4 Click Measure to measure the cali-
bration samples.

5 If all calibration samples have been 
measured, press Accept to return to 
the „Colorant Set“ window.

The K/S values are calculated automat-
ically using the default method „Mea-
sured“.

Note
• You can select a range of colorants. Click Accept to save the colorants without 

measuring the calibration samples. The colorants are saved to the colorant set.
•  -1.0000 and a red background color in the dE field indicate that no calibration 

samples are assigned to the colorant.
• If you click one of the colorants without calibration samples, the „Create Calibra-

tion Series“ dialog box appears and you can select the calibration samples from 
the database or measure the samples.

•  If you open a colorant set containing colorants that are not calibrated, a mes-
sage box appears for a few seconds.
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Re-measure, Deleting or Move Calibration Samples
The calibration samples are listed automatically by ascending concentration.

Moving Colorants

Action Result/Notes

1 Select the calibration sample and 
open the context-sensitive menu.

2 Select the requested action. The move works like the moving of col-
orants. Refer to Moving Colorants on 
page 5-51.

Action Result/Notes

1 Select the required colorant and 
move it using the Up and Down but-
tons.

2 Repeat the actions 1 to 2 until all col-
orants are placed correctly.

3 Click OK. The new sequence of the colorants is 
saved.
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Using the Graphical Display
Click anywhere in the green fields of the Product control grid to obtain the context-sen-
sitive menu for all graphical options.

Examples
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Using two graphs
This option shows two graphs boxes with either graphical displays of two products or 
two different graph types for one product. The option toggles between one and two 
graphical displays.

Examples
The left graph always shows the curves of the currently selected colorant.
The right graph shows the curves of the previously selected colorant.

You can display two different types of curves for one colorant.

Note
The function „Use 2 graphs“ works only if a graph is being displayed, e.g., if you have 
selected the function „Show tables“, the function „Use 2 graphs“ does not work.
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Remove A Dyestuff from A Colorant Set

Note
Generally, you can only remove a colorant from a colorant set if the colorant (as a com-
ponent of this colorant set) is not linked to other data.

Action Result/Notes

1 Select the colorant and open the 
context-sensitive menu.

2 Select Delete Colorant. The program checks wether the colo-
rant is linked to other data and removes 
it from the colorant set if there are no 
links. 
If the dyestuff is linked, a dialog box 
with the names of the first 20 linked 
items appears.
Click Show All to search the entire 
database for linked data. This may take 
some time. All linked data will be listed 
when the search process is finished.
If you are sure that the colorant should 
be removed from the colorant set, click 
Delete All to delete all linked data now. 
Linked data could be: current recipes, 
matching tables, correction tables and 
SmartMatch points.
Caution:
You cannot undo this action.
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Specifying A Colorant Set for An Alternate Substrate

Note
This function can build a colorant set with information based on a few calibration dye-
ings made on the new substrate. The colorant should cover the complete spectrum in 
order to generate enough information about the colorant build-up on the new substrate.

The calculation of the „correlated“ colorant set is based on an existing colorant set and 
on the information calculated from the calibration dyeings on the new substrate.

The quality of such a colorant set depends strongly on a similar dyeing behavior of all 
colorants to the colorant used to calculate the correlation parameters.

Action Result/Notes

1 Open the “Colorant Set List” window.

2 On the “Colorant Set” or the context-
sensitive menu, select 
New  
Textile, Alternate Substrate.

The „Alternate Substrate Information“ 
dialog box appears.
Refer to Alternate Substrate Information 
Dialog Box on page 7-84.

3 Select the reference colorant set. The best colorant for calibration is auto-
matically selected.

4 Select or specify the new substrate.

5 Click Sample to measure the cali-
bration samples.

The „Create Calibration Series“ dialog 
box appears.
Refer to Create Calibration Series Dia-
log Box on page 7-82.

6 Select the calibration samples from 
the database or measure them.

7 Click Accept. The „Create Calibration Series“ dialog 
box closes. Results are displayed in the 
graph and in the table.

8 Check the results. Refer to Review of the results on page 
5-56.

9 Click Accept, if the results are OK. The new „correlated colorant set“ is cre-
ated when you accept the correlation 
data. The type of interpolation is set to 
'"Correlated“ for all colorants. The dE 
shows the red background color 
because there are no calibration sam-
ples. The colorant set is ready to be 
used for matching.
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Review of the results
Graphs:
Scattering versus concentrationScattering versus wavelength

The smaller the standard deviation of the scattering, the better the correlated data.

Table:
• The columns dE2* and dE Model2* are normally empty. They are only filled in if 

the calibration series (colorant set) of the new substrate exists for the same colo-
rants as the ones to be correlated. In this case, you will be given information 
about the quality of the correlation. Refer to Alternate Substrate Information Dia-
log Box on page 7-84.

• The dE1* is the mean CIELab color difference of the colorants in the source colo-
rant set.

• The dE2* is the mean CIELab color difference of the colorants in the colorant set 
for the alternative substrate (does not exist normally).

• The dE Model2* represents the mean CIELab color difference and standard devi-
ation for the correlated data.
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Completing An Imported Textile Printing Colorant Set
The extender used by Datamatch printing colorant sets is not transferred during data-
base conversion. These colorant sets can be completed in Datacolor MATCHTextile with 
the „colorant set“ program if the extender should be used in recipe calculation. The 
extender is a normal product with price etc. It is printed in the laboratory recipe printout 
in the matching program.

The „Industry Type“ of a printing colorant set - imported from Datamatch during 
database conversion - has the value „Textile“. You can now change the type to 
„Tex. Printing (dyestuff)“.

Do not forget to select a process; continuous processes are used for printing colo-
rant sets.

The program asks for an extender as soon as you select „Tex. Printing (dyestuff)“ 
as „Industry Type“. Select or specify one.
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The program completes all the calibration components automatically, and calculates the 
concentration of the extender. If the unit is g/kg, this is the addition to 1000:

Conc.Colorant- 1000 = Conc.Extender

Examples

1000.0001000.000

Note
You must recalculate all colorants of the colorant set. If they have all been calculated 
with the same method (measured or smoothed), you can click All.
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Comparing Colorants
This option is used to compare colorants delivered from different dyestuff manu-
facturers, or to analyze the influence of dyeing processes and auxiliaries on the build-up 
of the colorant.

Example:
The „Brilliant Blue BB“ is selected from two different colorant sets: 
The first colorant set (R48)  is dyed at 40°C and 80 g/l salt, 
the second (R45)  is dyed at 40°C and 50 g/l salt. 
As you can see in the graph, the slope of the dyeing with 50 g/l  is not as steep as that 
with 80 g/l  salt.

Action Result/Notes

1 Open the “Colorant Set List” window.

2 Open the requested colorant set and 
select the colorant.

3 On the context-sensitive menu, click 
Compare with Other Colorant.

The „Compare Colorants“ dialog box 
appears.
The selected colorant is listed in the 
box.

4 Select the colorants you would like 
to compare.

If necessary, change the colorant set.

5 Click the corresponding button to 
display the different graphs.

Refer to the example below for „K/S“.
Refer to the examples on the following 
page for „Log(KS)“ and „Strength“.
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LogK/S

Strength
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Specifying Combined Processes

Introduction
The user has to define combined processes and operations

Combined process
A combined process is used to describe the entire dyeing process either for laboratory 
or production. A treatment is generated for each calibration dye process type (,e.g., 
Exhaust, Continuous,) linked to the combined process.

Treatment
A treatment consists of one or more operations describing the dyeing process for labo-
ratory and/or production.

Operation
The operation specifies the sequence of actions to be done during the dyeing. Actions 
may be parameters (,e.g., temperature, volume,) or products (,e.g., chemicals, etc.).

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Operation

Treatment

Operation

Treatment

Colorant setCalibration dye 
processCombined process

Note
If Datacolor PROCESS is not installed, 

• only one operation is possible for each treatment.
• the operation supports XY-tables (decision tables) and fixed parameter values 

only.
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Specifying, Modifying, Deleting A Combined Process

Note
Refer to the Datacolor PROCESS documentation for more information.

Action Result/Notes

1 In the “Overview” window, click 
Combined Process.

The “Combined Process List” window 
appears.

2 On the context-sensitive or “Basic 
Data” menu of the “Combined Pro-
cess List” window, select Combined 
Process.

or
Double-click the corresponding table 
row to select a combined process for 
modifying or deletion.

The “Combined Processes” browse 
window appears. (Refer to Combined 
Processes Browse Window on page 7-
58 and Quick Search Dialog Box on 
page 7-59.) It is used to search com-
bined processes or open the “Com-
bined Process” dialog box for specifying 
a new combined process. Refer to Data 
Handling on page 5-2.

The “Combined Process” window 
appears. Refer to Combined Process 
Window on page 7-61 for information 
about the parameters.

New combined process:

3 In the “Combined Processes” 
browse box, click New for specifying 
a new combined process.
In the “Combined Process” window, 
click the + button.
In the “New Combined Process” 
selection box, select the process 
type.

The “Combined Process” dialog box 
appears. The selected data is dis-
played.

Note
• The calibration dye process(es) of the colorant set(s) set up the link(s) between 

combined process and colorant set(s).
• For a multiple fiber quality/style you must select the dye processes representing 

the colorant sets used for matching. The order of selection specifies the position 
of the color recipes in the combined process. Refer to the Example of a new 
combined process on page 5-63.

4 In the “Dye Process” selection box, 
select the dye process(es).

The treatment is generated.

5 Specify (or modify) data of the 
“Treatment”, “Recipe”, and “Prod-
ucts” tabs.

6 Click OK. The “Combined Process” dialog box is 
closed and the data is saved.
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Example of a new combined process
1 Select the type of combined process you like to specify.

2 Select the Dye Process(es). 

The dye processes are the links to the colorant sets. This combined process points to 
two dye processes (colorant sets.) It can be used for blends of polyester and cotton 
(refer to the fiber group list box.) The combined process exists of one treatment 
because both dye processes are of type “Exhaust.”
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If you specify a combined process of type “Half continuous,” two treatments are created:

Specifying, Modifying, Deleting An Operation

Note
Refer to the Datacolor PROCESS documentation for more information.

Action Result/Notes

1 In the “Overview” window, click 
Operation.

The “Operation List” window appears.

2 • Double-click the correspond-
ing table row to select an 
operation for modifying or 
deletion.

• On the context-sensitive or 
“Basic Data” menu of the 
“Operation List” window, 
select Operation.

The “Operation” window appears. Refer 
to Operation Window on page 7-67 for 
information about the parameters.

The “Operations” browse box appears. 
It is used to search operations or open 
the “Operation” dialog box for specifying 
a new operation. Refer to Data Han-
dling on page 5-2.

3 New operation:
• In the “Operations” browse 

box, click New.
• In the “Operation” dialog box, 

click the + button for specify-
ing a new operation.

The “Operation” window appears. 

4 Specify (or modify) data in the “Gen-
eral” tab.
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5 In the “Control Line” tab, specify the 
sequence of actions. Using the con-
text-sensitive menu or the insert key, 
new actions are inserted before the 
selected one. Using the “cursor 
down” key, an action is inserted at 
the end of the table.
Possible actions:
Call off: 
Specifies a group of products 
(dyestuffs and auxiliaries) that 
can be used together (weighted, 
dispensed) and defines a new 
bath (if the dye class is selected 
in the call off).
Call offs must contain the dye 
class if the liquid ratio or pickup 
is not the same for all color reci-
pes of the operation.
Dye Class: Mandatory. Dyestuff 
specification (place-marker). Opens 
a selection window for dye classes.
Product: Opens a selection window 
for products.
Parameter: Opens a selection win-
dow for parameters.
Note: Inserts a row for additional 
notes.

Notes
• In the “ID” field, other dye 

classes, products, and parame-
ters can be selected: Click the 
corresponding table cell and 
open the pull-down list.

• In the value field, click the 
browse button to specify formu-
lae.
Refer to Specifying Formulae on 
page 5-66.

6 Click OK. The “Operation” dialog box is closed 
and the data is saved.
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Specifying Formulae
Formulae are specified in the “Formula Edit” window. Refer to Formula Edit Window on 
page 7-71.

Example:

Action Result/Notes

1 Select dye class or product for the X 
axis and liquor ratio or pick up for the 
Y axis.

2 Using the cursor keys, you can add 
rows or columns. Specify the limits 
of the ranges.

3 Specify the absolute values into the 
corresponding table cells. 
If you need intermediate values, 
check the corresponding box(es).
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Recipe Calculation (Matching)

Introduction

Selection:
• Quality/style (data of the substrate)
• Combined process
• Substrate delivery (only for deliveries with data different to the blank dyeing sub-

strate)
• Dyed substrate (over-dyeing only)
• Dyestuff group with dyes pre-selected from the assigned colorant set. The dye-

stuff group is used to optimize the recipe calculation.
Selection criteria:
• Dyes from the list

• Parameter values, e.g., fastness information

• Concentration values, e.g., min., max., conc.

• Settings (parameters for calculation control)
• Standard: Color to be matched.

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Save
Print
Dispense

Affinity
Used for pre-

selection

Substrate
delivery

Dyestuff Settings

Recipe calculation

Selection:
Dyestuffs
Limits for parameters
Concentration

Recipes

Dyed
substrate

Review

Dyestuff group

Standard
(color type)

Quality/style

Multi color matching
Match in the background

Colorant set Process Operation

Treatment

Combined process
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Match: The recipes are calculated according to the selections and 
the results are displayed.

Review: The recipes can be reviewed according to the different crite-
ria (various color difference values, coordinates, price, etc.).

Further use: The recipes can be saved, printed and/or sent to a dispenser.
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Calculation of A New Recipe Series
Preliminary Work

NOte

Note
• The Save button is used to save a manually inserted recipe. Refer to Selecting 

dyestuffs for matching on page 5-71 for a re-dyeing.
• If the parameter „Fixed“ is used and the recipe is saved before the calculation, 

the dyestuff concentrations are used as default values and can be altered. A cor-
rection is possible.

• If the parameter „Fixed“ is used and the recipe is calculated without saving, the 
specified dyestuff concentrations are constant values and cannot be changed. A 
correction is restricted or impossible.

Action Result/Notes

1 Open the “Recipe List” window.

2 On the “Recipe” or the context-sen-
sitive menu, select Calculate, or 
press F5.

The “Match” dialog box appears. Refer 
to Match Dialog Box on page 7-116 for 
a parameter description.

3 Select the quality/style and the com-
bined process. 

Dye process and colorant set are dis-
played.
Refer to Specifying, Modifying or Delet-
ing a Quality/Style on page 5-26 and 
Specifying Combined Processes on 
page 5-61.

4 If necessary, select the substrate 
delivery.

You can measure a new substrate deliv-
ery using the „New“ button. Refer to 
Substrate Delivery: Example on page 5-
30.

5 Select the colorant set(s)

6 Select the “Standard” to be matched. Refer to Measurement on page 5-20.

7 If you have to re-dye, select the 
dyed substrate or re-measure it.

Refer to Measurement on page 5-20.

Note
• In the “Used Colorant Set(s)” table, you can temporarily modify the percentage, 

the process factors and/or the substrate effect factors.
• In case of a multi-fiber quality/style, you have to select the fiber parts to be 

matched. Refer to Multi color matching (for multi color qualities/styles) on page 5-
70.

• In case of re-dyeing (dyed substrate), recipes cannot be corrected. To enable 
corrections, measure the dyed substrate as substrate delivery and select it for 
the recipe calculation.

8 In the “Colorant Set” tab, select the 
dyestuffs to by used, and select or 
specify a dyestuff group.

Refer to Selecting dyestuffs for match-
ing on page 5-71.
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Multi color matching (for multi color qualities/styles)
You can assign its own standard or dyed substrate to each colorant set in the table (pro-
cess and substrate of the same row are assigned). In this way, the different recipes are 
calculated together.

Note
You can check the dyestuff selection using the „Lab Graph“ tab. Refer to Lab Graph Tab 
on page 7-119.

9 In the “Settings” tab, select the 
parameters for the matching pro-
cess.

Refer to Settings Tab on page 7-120.

10 Click Calculate to immediately start 
the recipe calculation. The recipe 
table appears.

Refer to Matching on page 5-74.

11 Select the recipes you want to dye.

12 Click Close, or Save to save the 
recipe.

Action Result/Notes

1 Check the “Multi Color Matching” 
box.

The “List of Standards” box appears.

2 In the “Standard” selection box, 
select the requested standards one 
by one, and move each to the “List 
of Standards” box using the Move 

 button.

You can remove standards from the list 
using the Remove  button.

Note
In the „Colorant Set“ tab, you can switch between the selected colorant sets. The cur-
rent colorant set name is displayed on the top of the tab.
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Rules for re-dyeing
Re-dyeing needs the following prerequisites:
• The dyed substrate must by darker than the pure substrate of the colorant set 

(Solution if lighter: Specify the dyed substrate as a delivery);
• No component of the dyed substrate must be darker than the standard (Solution: 

Bleach and measure again).

Selecting dyestuffs for matching

You can select dyestuffs ...
• by clicking on the dyestuff (multiple choices are possible).
• by inserting parameter values used for limits. Accepted operators: <, >, =, <=, >=
• If “Compulsory” is checked the dyestuff must be used in all combinations.

1 Click Accept Limits to activate the selection.

A mouse click displays one by 
one: all (A), the selected (S), or 
the not selected (N) dyestuffs.

Check „Compulsory“ and select 
the dyestuff if it must be used.

Input fields for

Used for manual input

parameter values

Note
If you have not selected any dye, all dyes of the list are selected.
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You can define the concentration ...
• by inserting fixed values (manual recipe input). The dyestuff is used with this con-

centration for all combinations.

• by setting a minimum and/or a maximum. The maximum amount displayed auto-
matically is the value specified in the colorant set program.

• by setting a fixed relation.

NOte

Note
• If the parameter „Fixed“ is used and the recipe is saved before the calculation, 

the dyestuff concentrations are used as default values and can be altered. The 
correction is possible.

• If the parameter „Fixed“ is used and the recipe is calculated and saved after cal-
culation, the specified dyestuff concentrations are constant values and cannot be 
changed. The correction is restricted or impossible.

Note
• You can check the dyestuff selection using the „Lab Graph“ tab. Refer to Check-

ing the dyestuff selection.
• In the „Group“ section, you can select, save or delete predefined dyestuff selec-

tions with all settings.
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Checking the dyestuff selection
The „Lab Graph“ tab is used to check that a recipe can be calculated with the selected 
dyestuffs.

Graph
The graph may be rotated by dragging the left mouse button, and be zoomed by draw-
ing the right mouse button.

The standard is displayed as a sphere on the top of a line. The dyestuff selection is 
OK if the standard sphere is completely inside the color space.
1 Check the possible dyestuff selections by rotating the color space. The standard 

sphere must not leave the color space at any position of the color space.

Parameters
Take all/None Using this check box, you can select or deselect all dyestuffs.

The single dyestuffs are selected or deselected with a mouse 
click.

Group Selection or definition of dyestuff groups.

Note
The graphical view cannot check the quality of a recipe.

Note
• If a selection is not OK, you can change the selection of dyestuffs.
• If a recipe is not possible, you must add dyestuffs or use (specify) another colo-

rant set.
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Settings for Recipe Match
Refer to Settings Tab on page 7-120.

Matching

Action Result/Notes

1 Click Calculate or press F5 to start 
the recipe calculation.

According to the settings in the “Set-
tings” tab, the recipes are calculated 
and the best recipes are displayed in a 
table.

2 In the table, you can change the 
order of the recipes according to dif-
ferent criteria, e.g., price, metamer-
ism.
Select one ore more recipes using 
the “Trial” function of the context-
sensitive menu.

Refer to Review (recipe table) on page 
5-76 for a description of the different 
review help functions.

3 If finished, close the recipe table. The “Recipe Database Operation” dia-
log box appears.

4 If necessary, change recipe name 
and identification(s).
Click Yes for saving the recipe.
Click „No“ for returning to the 
„Match“ dialog box for altering 
dyestuff selection and settings 
and recalculate the recipe.

The recipe is saved and the “Show full 
Recipe” dialog box appears. Refer to 
Show Full Recipe Dialog Box on page 
5-75 on the following page.

5 Edit the „Curr. Pickup (%) / Curr. 
Liquor Ratio“ value, if necessary
Click Show to displays the complete 
recipe.
Click Print to print the complete reci-
pe.
Click Dispense to send the recipe to 
a connected dispenser.
Select the recipe output(s) according 
your needs, and close the “Show 
Full Recipe” dialog box.
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Show Full Recipe Dialog Box

Trial List List of the added Trials.
Orig. ... Default values from the dye process.
Curr. ... Editable value. You can specify a current value.

Table Colorant set and recipe values.

Show Opens the print preview of the recipe.

Print Prints the recipe.

Dispense (option) Sends recipe data to a connected dispenser.

ASCII (option) Export the recipe data in the ASCII format.

Close Closes the “Show Full Recipe” dialog box.
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Review (recipe table)

Column for weighting the colorimetric values and the price

Recipe Information

Calculated Values
Colorimetric values 
and prices)

Row(s) for user-defined selection marks

Information about dyestuff
concentrations used for
the recipes

Color Display

Color Inconstancy
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The following help functions for review are implemented:
• „Table“ menu and context-sensitive menu:

• Evaluate Print / ASCII Prints colorimetric details using a predefined form.

• Theoretical reflectance
Opens the „Insert a Theoretical Sample“ dialog box 
used for saving theoretical reflectance values (E.g., for 
Datacolor Envision). Datacolor TOOLS can send this 
data to a user with a Datacolor Envision system to 
check the color, for example. Refer to Specifying The-
oretical Reflectance Values on page 5-96.

• View Configuration Opens the “View Configurations” dialog box used to 
define the display of the calculated values and the 
number of decimal places for colorimetric and concen-
tration data.

• Reset Sort Order Resets the sort order of the recipes.

• Add Trial Up to five recipes can be marked. After closing the 
table, the selected recipes are saved for further 
use.

• Remove Last Trial Removes the last trial mark.

• Hide recipes not selected
The recipe table only shows the selected recipes.

• Show all recipes Shows all recipes.

• Mail Table Opens the mail form with an attached screen shot of 
the recipe table (JPEG format).

• Modify Refer to Manual Recipe Modification (Recipe Table) on 
page 5-81.

• Round Refer to Round the Dyestuff Concentration (Recipe 
Table) on page 5-81.

• Manually Change Refer to Manual Graphical Correction on page 5-101.

• Pressing the Ctrl key and clicking in the recipe number field selects the recipes.
• Clicking in a parameter name (first column) in the table with the calculated values 

sorts the recipe table according to the values of the corresponding row.
• Alteration of weighting (only possible for metamerism): If you have altered the 

weighting, you have to close the window and match again.
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Color inconstancy

Color inconstancy is the change in color of a single sample under different light sources. 
The magnitude of color inconstancy can be defined by DE CMC (or any other color dif-
ference formula) of the sample between two light sources.
To activate the calculation of the color inconstancy, 
• calculate a recipe, 
• open the context-sensitive menu, select the function „View configuration“ and 

check the corresponding boxes (CMCxxx).

Color display for two illuminants
To activate the display of two Illuminants, 
• calculate a recipe, 
• open the context-sensitive menu, select the function „View configuration“ and 

check the box „2 illuminants banks“.
The selection becomes active after saving the recipe. If you open the recipe table again 
or match a new recipe, the colors for the first two illuminants are displayed.
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Modifying Recipes
Recipe Editor
Recipe parameters can be altered using the Recipe Editor.

Modification Rules for adding and removing dyestuffs:
The dyestuff selection of a recipe can only be altered if ...

• the recipe is approved;
• it is not in use by the laboratory and a modification may influence the laboratory 

correction.
Note
Data that can be modified is displayed with a green background.

Note
The Go (Manual Correction) button is used for a manual graphical correction. Refer to 
Manual Graphical Correction on page 5-101.
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Action Result/Notes

1 In the „Recipe List“ window, select 
the requested recipe and the menu 
function Edit.

Refer to Recipe List Window on page 7-
91.
The „Recipe Editor“ dialog box appears. 
Recipe Editor Dialog Box on page 7-
124

2 Replacing header data:
Double-click the corresponding 
green table cell.
Altering Data:
Click the green table cell, type the 
value, and confirm the data with the 
Return key.
Adding dyestuffs:
Click Add Dyestuff.
Removing Dyestuffs
Select the dyestuff and press the 
Delete key.

A selection box with the available data 
appears.

A selection box with the available dye-
stuffs appears.
The dyestuff is removed from the recipe 
without confirmation.

Note
As long as you have not saved the recipe, you can cancel the last modifications by 
clicking the Undo button.

3 If the data is altered, click Save. The altered recipe is saved.
5 - 80 Datacolor MATCHTextile Version 1.0 Datacolor



Recipe Calculation (Matching) 5 - Using Datacolor MATCHTextile
Manual Recipe Modification (Recipe Table)
The concentration calculated by Datacolor MATCHTextile may be modified in the recipe 
table.

Round the Dyestuff Concentration (Recipe Table)
Another way to modify the concentrations is the „Round“ function. You can round the 
concentrations of all recipes corresponding to the setting in the „Options“ dialog box. 
Refer to Options Dialog Box on page 7-112.

Action Result/Notes

1 In the recipe table, select the 
requested recipe.

2 In the „Table“ or the context-sensi-
tive menu, select Modify.

3 Change the concentrations of the 
dyestuffs.
It is possible to specify concen-
trations for dyestuffs that are not 
used for the recipe.

• The recipe is marked with an M 
character to indicate that the rec-
ipe has been modified.

• The values for color difference 
and metamerism are continually 
recalculated.

• The recipe price is not re-
calculated. 

Action Result/Notes

1 In the „Table“ or the context-sensi-
tive menu, select Round.

• The recipe is marked with an R 
character to indicate that the rec-
ipe has been rounded.

• The values for color difference 
and metamerism are continually 
recalculated.

• The recipe price is not re-
calculated. 
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Replace Dyestuffs in Recipes
Dyestuffs can be replaced in all recipes, recipe tables and trials, but not in SmartMatch 
populations.
Concentrations can be modified using a factor.
The dyestuffs are replaced in all recipes, but a selection is possible with filters. The fil-
ters can limit ...
• the range of recipes
• the location of the approved recipes
• the recipe type
• the color type
• the affinity
• the quality.

Action Result/Notes

1 In the „Recipe List“ window, select 
the menu function Change Dyestuff 
in Recipes.

Refer to Recipe List Window on page 7-
91.
The „Change One Product in Recipes“ 
dialog box appears.

2 Select the old and the new product. The calculated factor for concentration 
is displayed in the field „Applied Factor“.

3 If necessary, type your own factor to 
correct the strength.

The final factor (using the dyestuff 
strength and the user’s factor) is dis-
played in the field „Applied Factor“.

4 Click Filter Recipes and Continue. The „Search Recipes with Filter (using a 
filter)“ dialog box appears.
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Possible (restrictive) search conditions:
Recipe Range Select all recipes that have to be modified in the browse box.

Approved Recipe Select the requested group.

Recipe Type Select the requested type.

Color Type In the browse box, select the color type.

Affinity Select the affinity in the browse box.

Quality/Style Select the quality/style in the browse box.

Combined Process Select the combined process.

5 Select the search conditions for 
recipes that have to be modified.

Refer to „Possible (restrictive) search 
conditions“.

6 Click Continue. The dyestuff is replaced in the selected 
recipes.

Note
A log file is created with a list of all recipes where the product exchange was not 
possible. The file is located in the Datacolor MATCHTextile folder. 

The file name is „ErrorsChangeProducts.log“
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Printing Recipe Lists
A print form with the most reasonable data for recipe lists is stored in the print form data-
base.

Approving
You can approve a laboratory recipe using the Approve button in the “Correct or 
Approve your Recipe” dialog box (refer to Correct or Approve Your Recipe Dialog Box 
on page 7-95) or in the “Laboratory Correction” dialog box (refer to Laboratory Correc-
tion Dialog Box on page 7-96).

Recipes Inserted Manually by Datacolor PROCESS
Recipes created using Datacolor PROCESS can be listed, printed and corrected with 
Datacolor MATCHTextile if a colorant set has been selected in Datacolor PROCESS. 
Missing data is added automatically. 
The recipe has the status 1 (created by Datacolor PROCESS).
CMC is stored as tolerance.

Action Result/Notes

1 Select the recipes to be printed in 
the „Recipe List“ window.

2 On the context-sensitive menu, 
select Recipe List.

A print preview appears.

• If you approve a recipe, all other trials and the recipe table will be deleted. The 
recipe location is set to “Laboratory” and the recipe lock level is set to “green”: 
The recipe can be used for production.

• Recipes approved without measuring the batch are saved without SmartMatch 
information. These recipes cannot be use for recipe search.

Note
• If a colorant set is not selected in Datacolor PROCESS, an error message 

appears. The colorant set must be added in Datacolor PROCESS.
• All dyestuffs of the recipe must be calibrated in the colorant set.
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SmartMatch

Introduction
The SmartMatch facility is used to improve first-time matching and correction. Standard 
color prediction uses the Kubelka-Munk theory, which assumes that dyes behave in the 
same way when used together or stand-alone. However, this is not the case: dyes inter-
act with one another. The SmartMatch facility overcomes this problem by taking into 
account the performance of previous predictions, e.g., learning by experience.
SmartMatch stores information about the concentrations used to dye a sample and the 
results of dyeing, and uses this data to correct the first attempt made by Kubelka-Munk 
calculations in future matching. It stores information about previous predictions as 
SmartMatch points. 
Once you set your system to SmartMatch, it runs automatically. However, you can also 
examine the SmartMatch points the system is using and alter them to refine Smart-
Match performance. For example, if you suspect that one of the SmartMatch points 
being used is based on a bad dyeing, you can remove this point. This way, it is no more 
used in the calculations.
The number of similar points is reduced by grouping them. In addition to the automatic 
SmartMatch housekeeping a powerful graphical tool supports to check the SmartMatch 
population for SmartMatch points to be deleted or grouped.
All recipes calculated using the “Match” option will use SmartMatch when SmartMatch 
is turned on and if relevant populations are available. The number of SmartMatch points 
used in a recipe calculation are shown at the bottom of the dye concentration column in 
the recipe table.

Note
You can still store SmartMatch points for later use, if the SmartMatch facility is switched 
off.
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Automatic SmartMatch Maintenance
A regular housekeeping of the database is necessary to optimize the SmartMatch func-
tion. SmartMatch points with a color difference that is too large must be removed. This 
is possible using the “Automatic SmartMatch Housekeeping” function. If you want to 
remove bad SmartMatch points manually, refer to Reviewing SmartMatch Points on 
page 5-87.

Action Result/Notes

1 Select SmartMatch List on the 
“Basic Data” or the context-sensitive 
menu.

The “SmartMatch List” window appears.

2 On the „Tools“ menu, select Auto-
matic SmartMatch Housekeeping.

The tool removes all SmartMatch points 
with a an excessive color difference (> 
DE CieLAb 160) and groups similar 
SmartMatch points.
The „Automatic Housekeeping“ box 
informs you about the current statement 
of the program run.
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Reviewing SmartMatch Points
The aim of the housekeeping function is to eliminate poor points (points with a color 
difference greater than 16 DE CieLab) and to reduce the number of similar points by 
grouping them.

This is a very complicated mathematical task for the program and, generally, not all 
points can be recognized for grouping. For this reason, we still have a very powerful 
graphically supported part in the program to check the population for further points to be 
deleted or grouped. The human brain is better suited to this tasks than many program 
lines.

Action Result/Notes

1 Select SmartMatch List on the 
“Basic Data” or the context-sensi-
tive menu.

The “SmartMatch Result List” window 
appears. Refer to SmartMatch Result 
List Window on page 7-94.

2 Double-click the SmartMatch point 
to be reviewed.

The “Current Population” dialog box 
appears.
If a group is selected, a message 
appears with the group ID. You can 
open the group using the „Open Popu-
lation by SM-Id“ function and this ID.
Refer to Current Population Dialog Box 
on page 7-125.

3 Search SmartMatch points for 
another population, if necessary.

4 Click After Analyses to automatical-
ly delete bad points, and to automat-
ically merge points to be merged.
Otherwise, click Quick.

The “Population” dialog box appears.
Refer to Population Dialog Box on page 
7-127.

5 Check the values and delete Smart-
Match points, if necessary.

6 Close the “Population” dialog box. A confirmation is requested, if the 
“Delete” boxes have been checked.

Note
dE_S values should always be lower than the corresponding dE_K values. If not, the 
population contains bad points that should be deleted.
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Release SmartMatch Points from the Group
Datacolor MATCHTextile does not delete the original points if they are used to build a 
SmartMatch group point. You can release (re-establish) the original points if you select 
a group point in the explorer view. The menu function „Release points from group“ is 
only enabled if the selected point is a group point. Executing this function brings back all 
points used to build the group point and the group point is deleted.

Use the „Release Groups“ button in the „Automatic SmartMatch Housekeeping“ dialog 
box (Refer to Automatic SmartMatch Maintenance on page 5-86.) to release the Smart-
Match points of all groups.
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Saving A Batch as A Sample
A color sample can be specified using a SmartMatch point.

Action Result/Notes

1 Select SmartMatch List on the 
“Basic Data” or the context-sensi-
tive menu.

The “SmartMatch Result List” window 
appears. Refer to SmartMatch Result 
List Window on page 7-94.

2 Select the SmartMatch point to be 
saved.

3 On the „Smart“ or the context-sensi-
tive menu, select „Save Batch as 
Sample“.

The „ID’s Point for Creation of Sample“ 
dialog box appears.

4 If necessary, correct the ID, and click 
OK.

The „Shown Reflectance Will Be Stored 
as Sample“ dialog box appears.

5 Accept the default name, or, correct 
it.

6 Click Insert.
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Manual Input of SmartMatch Points
The “Fast Correction” function can be used for entering SmartMatch points.

Manual Input of SmartMatch Points together with the Recipe

Action Result/Notes

1 On the context-sensitive menu, 
select Fast Correction, or press F8.

The “Fast Correction Recipe Input” dia-
log box appears. Refer to Fast Correc-
tion Recipe Input Dialog Box on page 7-
105 for a detailed description of the 
parameters.

2 Specify any standard, the quality 
and substrate delivery.

3 Select the “Colorant Set” tab. In the “Colorant Set” tab, the fields and 
buttons used for manual input will be 
activated.

4 Specify the batch name and mea-
sure the batch that represents the 
dyeing of the SmartMatch point 
(Laboratory or Production).

5 Check the “SM Insert” box, and the 
type of “SmartMatch’s Point.”
Specify the “Machine” and the “Pick-
up/L. Ratio” for production Smart-
Match points.

6 In the dyestuff table, specify the con-
centrations and click Save.

Only the SmartMatch point will be 
inserted.

Action Result/Notes

1 to
4)

5 Do not check the “SM Insert” box.
Specify the “Machine” and the “Pick-
up/L. Ratio” for production Smart-
Match points.

6 In the dyestuff table, specify the con-
centrations and click Save.

The SmartMatch point and the recipe 
are inserted.
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Correction

Introduction
Laboratory correction Production correction

Selection of correction type:
• Laboratory The existing recipe is altered and saved again.
• Production An additional recipe is calculated that is used to change color 

of the dyed batch to the correct color.

Data input:
• Recipe to be corrected
• Batch (color of the dyed substrate to be corrected)
• Dyestuffs are pre-selected by the recipe to be corrected. Additional dyestuffs can 

be selected. Concentration and parameters can be defined.
• The acceptance limit settings can be altered.

Print Dispense

Save
Print Display

Approval for
use in production

Recipe

Dyestuff Settings

Batch

Corrected recipe

Review

Additional recipe

Recipe

Dyestuff Settings

Batch

Production
correction

Laboratory
correction

Caution!
A production correction is not saved. It must be printed before closing the “Pro-
duction Correction” dialog box. Otherwise, the recipe will be lost.
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Laboratory Correction

Action Result/Notes

1 Select the recipe to be corrected in 
the “Recipe List” window.

2 On the context-sensitive menu, 
select Pass Fail and Laboratory 
Correction, or press F6.

The “Correct or Approve Your Recipe” 
dialog box appears. Refer to Correct or 
Approve Your Recipe Dialog Box on 
page 7-95 for a detailed description of 
the parameters.

3 Click Pass Fail and Correction. The “Laboratory Correction” dialog box 
appears. Refer to Laboratory Correction 
Dialog Box on page 7-96 for a detailed 
description of the parameters

4 In the “Batch and Color Difference” 
field, measure or select the sample.

5 If necessary, alter the data in the 
dyestuffs table.

Refer to Matching on page 5-74, sec-
tion Selecting dyestuffs for matching on 
page 5-71.

6 Click Save to save a manual correc-
tion. 

The correction recipe is saved.

7 Click Laboratory. The “Recipe Correction” table appears.

8 In the “Recipe Correction” dialog 
box, you can look at the result of the 
matching. The color differences 
between “Standard” and “Batch” are 
displayed.

Refer to Laboratory Correction Table on 
page 7-98.
The „Laboratory Correction Table“ can 
be configured. Refer to View Configura-
tion Dialog Box (Laboratory Correction 
Table) on page 7-100.

9 If finished, close the recipe table. A save request appears.

10 Click Yes. The “Save Your Recipe” dialog box 
appears.

11 Select the recipe output(s) accord-
ing your needs, and/or close the 
“Show Full Recipe” dialog box.

The “Show Full Recipe” dialog box 
appears. Refer to Matching on page 5-
74, section Show Full Recipe Dialog 
Box.
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Example:

Color differences standard/batch
according to the formula used for
recipe calculation.

Evaluate displays colorimetric
data for standard and batch
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Table:

Selection of corrected recipes using 
different correction methods
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Color inconstancy

Color inconstancy is the change in color of a single sample under different light sources. 
The magnitude of color inconstancy can be defined by DE CMC (or any other color dif-
ference formula) of the sample between two light sources.
To activate the calculation of the color inconstancy, 
• open the context-sensitive menu, select the function „View configuration“ and 

check the corresponding boxes (CMCxxx).

Color display for two illuminants
To activate the display of two Illuminants, 
• open the context-sensitive menu, select the function „View configuration“ and 

check the box „2 illuminants banks“.
The selection becomes active after saving the recipe. If you open the recipe table again 
or match a new recipe, the colors for the first two illuminants are displayed.

Note
For the two illuminants, the colors can be very different.
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Specifying Theoretical Reflectance Values
You can save theoretical reflectance values of a laboratory correction or a laboratory 
recipe. Datacolor TOOLS can send this data to a user with a Datacolor Envision system 
to prove the color, for example.

Production Correction

Action Result/Notes

1 In the laboratory recipe or the cor-
rection table, select the requested 
recipe.

2 On the context-sensitive menu, 
select Theoretical Reflectance.

The „Insert a Theoretical Sample“ dia-
log box appears.
Refer to Insert A Theoretical Sample 
Dialog Box on page 7-123.

3 Click Insert. The sample name is a proposal. Alter it 
if necessary.

Action Result/Notes

1 Select the recipe to be corrected in 
the “Recipe List” window.

2 On the context-sensitive menu, 
select Pass Fail and Production 
Correction, or press F7.

The “Production Correction” dialog box 
appears. Refer to Production Correction 
Dialog Box on page 7-101 for a detailed 
description of the parameters.

3 Click Production.

4 You can optimize the result of the 
matching by adding dyestuffs and 
concentrations and by specifying tol-
erances.

Refer to Production Correction Table on 
page 7-103.

5 When finished, you can display and 
print the recipe.

6 Click Close to close the “Production 
Correction” dialog box.

Note
After closing, the production correction recipe can no longer be displayed or printed 
using Datacolor MATCHTextile.
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Production correction examples (continuous)
Result using the “Production” button:

In this example, it is recommended to use the “Match Batch” button, because the batch 
was already dark and the color difference too large. The correction tells you to dilute the 
dye batch.
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Production Correction (Access from Datacolor PROCESS)

Result if the previous adds are not taken in account:

The previous adds are taken into account with 100%

Result if the previous adds are taken in account:

Note
If the production correction is accessed from Datacolor PROCESS, the additions 
already done (using Datacolor PROCESS) can be taken into account for the batch. The 
user can define what percentage of the previous adds should be taken.
5 - 98 Datacolor MATCHTextile Version 1.0 Datacolor



Correction 5 - Using Datacolor MATCHTextile
Fast Correction

The “Fast Correction” function is used for production or laboratory corrections without 
an existing recipe. It is based on a theoretical calculated recipe of the standard or a rec-
ipe typed in manually. This task is mainly used for production correction.

Data input:
• Quality/style, combined process, colorant set, and standard.
• Batch (color of the dyed substrate to be corrected).
• Dyestuffs must be selected. Concentration and parameters can be defined.
• The acceptance limit and color difference equitation settings can be altered.
• The recipe can be entered manually or a theoretical recipe can be calculated.

Print Display

Laboratory
correction

Quality/style

Dyestuff
SettingsBatch

Review

Additional recipes

Recipe input or 
calculation

Combined process Colorant set Standard

Production
correction

Additional recipe

Print Display
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Caution!
Only fast corrections of laboratory recipes can be saved. Fast corrections of pro-
duction recipes must be printed before closing the “Production Correction” dia-
log box. Otherwise, the recipe will be lost.

Action Result/Notes

1 On the context-sensitive menu, 
select Fast Correction, or press F8.

The “Fast Correction Recipe Input” dia-
log box appears. Refer to Fast Correc-
tion Recipe Input Dialog Box on page 7-
105 for a detailed description of the 
parameters.

2 In the “Process Data for Matching” 
tab, select Quality/Style, Com-
bined Process, Colorant Set and 
Standard.

3 In the “Colorant Set” tab, select the 
dyes the recipe is dyed with.
If you know the concentrations, you 
can specify them (either concentra-
tions or absolute amounts). In case 
of amounts, you must specify the 
dye lot weight and the weight unit.

4 Measure or select the batch to be 
corrected.

5 Click Laboratory for a laboratory 
correction.
Continue with chapter Laboratory 
Correction on page 5-92.

The “Recipe Correction” tab appears.

Click Production for a production 
correction.
Continue with chapter Production 
Correction on page 5-96.

The “Production Correction” table 
appears.

Note
The “Fast Correction” function can be used for entering SmartMatch points manually. 
Refer to Manual Input of SmartMatch Points on page 5-90.
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Manual Graphical Correction
The manual graphical correction recalculates the recipe in the basis of the altered dye-
stuff concentrations.
You can start the manual graphical modification of recipes from ...
• the recipe table
• the laboratory correction table
• the production correction table
• from the „Recipe Editor“ dialog box.
The tolerance sphere, the standard and the position of the current recipe are displayed. 
To visualize the modification in the tolerance sphere, the a/b path (trajectory) of each 
dyestuff of the recipe is also drawn in the graph. 
The concentration displayed at the end of the dyestuff lines represents the position of 
the color you would get in the tolerance sphere if you took this concentration for the 
modified recipe. The third concentration is the lowest concentration that results in a 
recipe at the tolerance limit.

Position of the standard (grey).

Position of the recipe (black).

Dyestuff line:
 The length of the line shows all positions of the recipe between the concentra-

tions of 0.7616% and 0.8636%.
 The concentration 0.7808 is the minimum concentration matching the tolerance 

limit.
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Navigation in the graph

Modification
• You can change the concentration either by typing or using the buttons in the col-

umn „New Recipe“ or the column „+Amount“ to modify the recipe.
• If you click Set in the columns „Proposition“, the recipe is set to the minimum 

amount of dyestuff to match the tolerance limit.

You can see the result of the modification in the graph. The recipe moves to the 
tolerance limit when you click Set.

Action Description

Click and hold down the right mouse 
button.

Moving the mouse forward zooms in, 
moving the mouse backward zooms out.

Click and hold down the left mouse 
button.

Moving the mouse left, right, up or down 
rotates the graphic in the corresponding 
directions. 
The rotation center is the batch. 

Press F2 Switches to a two-dimensional graph (a* / 
b*). 

Press F3 Switches to a two-dimensional graph (L* / 
b*).

Press F4 Switches to a two-dimensional graph (L* / 
a*).

Double-click the graph using the right 
mouse button.

The graph view switches between parallel 
and perspective projection.
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Search and Correct An Existing Recipe for A New Standard
Existing recipes that are based on a batch have a small color difference in relation to a 
newly measured standard that has been searched and corrected.

Action Result/Notes

1 On the „Recipe“ or the context-sen-
sitive menu of the „Recipe List Win-
dow“, select Search Recipe, or 
press F9.

The “Search and Correct” dialog box 
appears. Refer to Search and Correct 
Dialog Box on page 7-109 for a detailed 
description of the parameters.

2 Select the new measured standard.

3 Select the search criteria, and click 
Search.

• If recipes are found, the “Search 
Results” dialog box appears. 
Refer to Search Results Dialog 
Box on page 7-110 for a detailed 
description of the parameters.

• Recipes found that cannot be 
used are displayed in the „Found 
Recipes without SmartMatch 
Information“ box.

4 In the “Search Results” dialog box, 
select the base recipe for the calcu-
lation.

5 • If the color difference is small 
enough, select „Save as new 
recipe“ on the context-sensi-
tive menu.

• If a new recipe is to be calcu-
lated, select „Correct and 
Save“ on the context-sensitive 
menu.

• The selected recipe is saved for 
the new standard.

• The new recipe is calculated 
based on the selected recipe and 
saved for the new standard.
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Displaying and Printing Existing Recipes

Recipe Output
New output features

Colorimetric data is printed (color difference and metamerism for standard, batch 
and standard, theoretical batch of correction).

Information if the recipe was manually modified.

Water volume to be added to get the final volume.

The last measured batch.

The modification number of the recipe (starting with No. 0 for the 1st recipe).

Action Result/Notes

1 Select the recipe in the “Recipe List” 
window.

2 On the context-sensitive menu, 
select Lab Dyelot, or, press Enter.

The “Show Full Recipe Dialog Box” dia-
log box appears. Refer to Matching, 
section Show Full Recipe Dialog Box on 
page 5-75.
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Calculation of the stock solution

Recipe History
If a Batch exists, Datacolor MATCHTextile saves all corrections and modifications of a 
recipe. Modifications done with the „Edit“ option are also saved. In addition to the reci-
pes, a dLab graph is displayed.

Displaying the history:
• Select the function History on the Recipe or the context-sensitive menu.

Printing the history:
• Select Print on the History menu.

Note
The single volumes of the stock solution are checked. If they exceed the target volume, 
another stock solution is used.

Note
The graph is not to be printed.
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Datacolor MONITOR (Option)
Datacolor MONITOR is a color quality control software product that was designed to 
easily acquire color measurement data and pass/fail decisions for production quality 
control. The program is designed to compare side-center-side for fabrics. The major 
task was to design a software module that is easy to operate. Datacolor MONITOR is an 
option for Datacolor MATCHTextile.

Specifying A Script
If you are starting the program for the 1st time, you must define a script to be able to 
measure a batch series. A script describes the measurements, the tolerances and the 
relations for the comparison.
1 On the Batch Series menu, select New Script.

2 Specify a name, a description (not mandatory), and click Next to continue.
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This dialog is very important. 
3 You have to decide ...

• wether the measurements should be compared to a reference sample;

• how many measurements should be taken in the horizontal direction (mea-
surements per line: maximum is 4), and;

• how many measurements per piece should be done in the vertical of a fabric. 

The measurements in horizontal direction are called „Tag 1", „Tag 2", „Tag 3", and 
„Tag 4". For each tag, you can give a name describing the position of the measur-
ing. This name is stored together with the spectrum and is used to identify the 
position.

If you check „Only one line“ the measurement program stops if the measurements 
defined in „Measurements per line“ are done. 

4 Select the Pass/Fail formula. 
5 Click Next to continue.

Note

• These names cannot be modified if a batch series exists using that script. Refer 
to Diagram: Measurement distribution on page 5-109.

• Up to four tags may be defined.
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6 Set the measurements you want to compare. You can set an individual tolerance 
factor for each relation.

There are three different types of relations:

• Relation with Standard (only if „Use reference“ is checked in the previous 
dialog);

• relation with previous batch (vertical);

• relation with batch on the same line (horizontal).

7 Click Finish to save the script.
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Diagram: Measurement distribution

This graph represents one piece of fabric, with three horizontal measurement positions 
(e.g. left - center - right) and three positions per piece (e.g. at the beginning, in the mid-
dle and at the end of the piece). In addition, the reference is included in the pass / fail 
task.

The circle repre-
sents a measure-
ment position.
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Specifying A Batch Series

Action Result/Notes

1 On the Batch Series menu, select 
Measure New Series.

The „Create Batch Series“ dialog box 
appears.

2 Type the name of the batch series, 
select the folder and the script.

3 If a reference is defined in the script, 
select or measure the reference 
sample.

If a reference is not defined, the section 
for the standard is disabled.

4 Click Ok to start the measurement. The measurement table and the „Mea-
sure Control“ dialog box appears.

Note
The name of the batch series is used as batch name together with an extension for the 
number of lines measured, e.g.,
M&S Lot 1173652_001
M&S Lot 1173652_002
M&S Lot 1173652_003
M&S Lot 1173652_004,

Each sample contains the spectra for the readings made at the positions left, center 
and right.
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5 Type the name or number for the 1st 
piece of fabric and click Measure to 
start the 1st measurement.

• The position you have to mea-
sure is displayed in the dialog 
box. 

• The program asks for the next 
reading as soon as the measure-
ment is done.

• If all measurements defined for a 
piece of fabric have been done, 
you can type the name of the 
next piece of fabric.

• If you forget it, the program asks 
for a new name.

• If your instrument is equipped 
with a feature button, you can 
trigger the measurement from the 
instrument.

• If the measurements of a line 
have been done, the color differ-
ences will be displayed.
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Adding A Graph Panel
You can add graph panels to the graphical display of all measurement positions and col-
or difference values.

Action Result/Notes

1 On the Batch Series menu, select 
Add Graph Panel.

Graph panels  are displayed for each 
measurement.

2 In the graph panel, click the right 
mouse button.

The „Difference Graph Settings“ dialog 
box appears. 
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3 For all graph panels, select the mea-
surement positions to be compared 
and the type of the difference value.

„iT“ is the normalized tolerance (dE/TF). 
This value is important if you work with 
different tolerance factors for the sam-
ple relations.

4 Save the screen using the Save 
Layout As function of the Batch 
Series menu.

Refer to Batch Series Window on page 
7-139 for an overview of all functions.
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Printing A Batch Series
The printout or print preview is based on print forms created with the „Print View 
Designer“. Two default forms are provided with the database „Printform.db“.
In the task „Options“ of the menu „Batch Series“, you can select wether all pass/fail 
decisions or only failed ones are to be printed.

Example of the default printouts
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Datacolor TICKET (Option)
Datacolor TICKET has been designed for customers needing software to easily specify 
production recipes and Datacolor TICKETs  to run on their production plant.
Datacolor TICKET is based on the „Entry Level Datacolor PROCESS“. The big advan-
tage of the new module is that you can generate Datacolor TICKETs without a com-
bined process.
Datacolor Ticked consists of three major tasks: dye lot, production recipe and adminis-
tration.

Datacolor TICKET - Production Recipe
The „Production Recipe“ task is used to specify production recipes from approved 
laboratory recipes.

Note
• The advantage of creating production recipes without combined process means 

that the recipe is completely unique. There is no rule for adjusting the concentra-
tions of chemicals or for adding process dependent chemicals and/or parame-
ters, even if an operation is used to set up the production recipe. The production 
recipe is a flat recipe built up from dyestuffs, chemicals, and parameters. The 
generated recipe has no link to a combined process or operation.

• Datacolor TICKET uses the combined process if it is used in Datacolor MATCH-
Textile. In this case, it is not necessary to specify the generated recipe in the „Pro-
duction Recipe“ task. The program behaves as the normal „Datacolor PROCESS 
Entry Level“.
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Action Result/Notes

1 In the „Overview“ window, click Pro-
duction Recipe.

The „Recipes“ list window appears. 
Refer to Recipe List Window on page 7-
145.

2 Select the requested recipe and 
open it.

The „Recipe“ window appears. Refer to 
Recipe Window (Datacolor PROCESS) 
on page 7-147.

3 Click Load and Modify Template to 
add chemicals.

The „Root Recipe“ dialog box appears. 
Refer to Root Recipe Dialog Box on 
page 7-149 for more information.

4 Click New Dye Lot. The „New Dye Lot“ dialog box appears. 
Continue with Datacolor TICKET - Dye 
Lot on page 5-117.

Note
The „Root Recipe“ contains all the dyeing steps with the related products and their rela-
tive amount (%, ml/l, or g/l).
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Datacolor TICKET - Dye Lot

Datacolor TICKET - Administration
In the Datacolor MATCHTextile „Overview“ window, click Administration to specify and 
maintain the other data of Datacolor PROCESS such as products, qualities, combined 
process, etc.
Refer to the Datacolor PROCESS help. Press F1.

Action Result/Notes

1 In the „Recipe Selection“ tab of the 
„New Dye Lot“ dialog box, type the 
dye lot ID, the dye lot name, and 
select the recipe.

The „Recipes“ list window appears. 
Refer to Recipe List Window on page 7-
145.

2 In the „Machine Selection“ tab, 
select the machine and type the 
absolute amounts. 
Liquor ratio or pickup are not con-
trolled by this program.

Refer to the Datacolor PROCESS help. 
Press F1.

3 Click Generate to calculate the dye 
lot.
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Datacolor SORT (Option)

Introduction
Traditional "555 shade sorting" is a system for sorting samples into a 3-dimensional 
array of blocks (centered around the standard) in order to subdivide the "acceptable" 
matches to the standard into smaller groups. Each group is described using a three digit 
code. Each digit varies from 1-9 and represents the distance to the standard for each 
color difference dimension. The center block (containing the standard) is assigned a 
sort code of "555". Each member of a group is close enough to other members of the 
same group in color to prevent any noticeable color variation between them. The "size" 
of each block is set by the user (by means of a tolerance value) to limit the amount of 
shade variation within each group. The tolerance is a set of three numerical values that 
control the dimensions of each block, typically in dL*, dC*, and dH* - although variations 
exist using dL*, da*, and db* as well as HunterLab dL, da, and db.
The selection of the tolerances by the user is critical to the performance of the system. 
Tolerances that are too large will produce shade groups with excessive shade variations 
within each group. Tolerances that are too small will result in too many subdivisions of 
the population, with many of the shade blocks containing only one or two samples.
An alternative to the "555 shade sorting" system is a dynamic sorting system that we 
will call "clustering" or "grouping". This alternative is realized in the new Datacolor 
SORT module.

Clustering
Clustering is an alternative to "555 shade sorting", whereby all the samples (rolls, piec-
es, garments, cones) are placed into groups such that all members of the group may be 
shipped or cut together. The members of the group have minimal color differences from 
the overall group average . As described below, there are usually two steps in the pro-
cess: 
1 Clustering or grouping the entire population of samples into a manageable num-

ber of distinct groups, then:
2 a sequencing or tapering process to put the members of the group in the correct 

order for shipment or cutting.

Jarvis and Aspland at Clemson first developed clustering in the early nineties. The 
Apparel Research Dept. has a fully functioning garment assembly plant, and shade 
sorting has always been one of their specialties. Simon developed the original 555 con-
cept there in 1955. Sorting by 555 has certain drawbacks:
• The fixed grid in CIELab or CIELCH results in large numbers of boxes,
• boxes with few members, and 
• the corners present problems in that samples can be very similar to a neighbor 

but are sorted into different boxes.
Clustering eliminates all of these problems by grouping them according to their proximi-
ty to each other in a logical fashion, in much the same way you would group them visu-
ally. The use of CMC-based ellipsoids for the clusters helps to insure that samples are 
placed into clusters that best correspond to visual shade grouping. The center of the 
ellipsoid is taken to be the average of the cluster. Clustering definitely produces fewer 
groups and a better color agreement within the group. 
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The only disadvantage is that clustering does not provide a color relationship to the orig-
inal standard, whereas 555 does. This is not usually a problem, because the clusters 
can be plotted in color space relative to the standard, and the samples have already 
been screened for Pass/Fail in the production QC process.
In clustering and tapering methods, there are user-defined criteria that determine the 
taper sequence(s), the number of clusters, and color differences. These are described 
in the section below. It must be remembered that there will be samples within a taper or 
clustering process that fall outside the limits established by the user. In the case of 
tapering, these samples are "outliers", and are listed as such. In clustering, there may 
be outliers that do not belong in any cluster. The object is to include all samples, but not 
to compromise the user's tolerances.
Since clustering usually precedes tapering, the cluster program must be dynamic rather 
than static. A population may be clustered and the results can be saved as a table, 
printed, etc. However, as new samples are added to the population, the entire table will 
change accordingly. If the new samples fall very close to an existing cluster, they will 
become part of that cluster, and the average of the cluster will be re-calculated. If 
enough samples fall elsewhere, but are very similar to each other, a new cluster may be 
formed and the entire population re-clustered.

Tapering
It is best to think of tapering as a sequencing method. A series of dye lots (typically rolls 
of fabric or cones of yarn) are to be shipped to a given location for cutting and assembly. 
It is important that the rolls are sent in a sequence such that there is minimal color differ-
ence from roll to roll. The rolls are usually cut as they are received. The cutter will there-
fore have a much easier job if the fabric supplier has already provided the optimum 
sequence of rolls. 
In many dyeing processes, the processes themselves will result in a tapering effect, 
especially in continuous dyeing of woven fabrics. Factors such as roller pressure and 
dye tank feeds cause variations in the run, but this variation is gradual. We would 
expect the variation to occur more often in lightness/darkness and in chroma. Differenc-
es in hue can occur, but less frequently, and are associated with the differences in dye 
substance to the fiber rather than mechanical effects.
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Start Datacolor SORT
Sorting with Datacolor SORT is performed using a sort job according to a sort script. 
Sort criteria is specified in a sort script.

Datacolor SORT can either be installed as a stand-alone application or as a module of 
Datacolor MATCHTextile.

Starting the Standalone Version

Starting from Datacolor MATCHTextile

Note
Before you can use the program to cluster and / or taper samples, you have to define 
„Sort Scripts’". A "Sort Script" contains the conditions and limitations (sort criteria) that 
are used to build clusters and tapers. 

1 On the Windows start menu or the desktop, click the 
Datacolor SORT icon.
The „SORT job“ window appears.

1 In the “Overview” window of the Datacolor MATCH-
Textile explorer, click the Datacolor SORT icon.
The „SORT job“ window appears.
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Open a SORT job

Action Result/Notes

1 Double-click the job in the „SORT 
job“ window.

The „Job load progress“ message box 
shows the progress of the loading. 

If the loading is finished, the „Job 
Result“ window appears.
Refer to Job Result Window on page 7-
154.
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Specifying a New SORT job

Action Result/Notes

1 Select either the option New Sort 
Job from the „Datacolor Sort“ menu 
or from the context-sensitive menu.

The „New Sort Job“ wizard starts. The 
sort job name may be modified and a 
description can be entered into the 
description field.
Refer also to Sort Job Maintenance 
Dialog Box on page 7-160.

Note
Depending to the settings in the „Sort Job Definition Options“, you may not see all 
pages of the wizard. Refer to SORT job Definition Options on page 5-133.

2 Click Next. The following dialog box appears.
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3 Select the Sort Script containing 
the sort conditions you need.

For more information about selecting 
data from the database, refer to Data 
Handling on page 5-2.
The sort script defines the sort opera-
tion. All parameters defined in the sort 
script are used as defaults. Depending 
on your access rights, you can modify 
these default values. Refer to Specify-
ing a New SORT job on page 5-122 and 
Modifying a Sort Script on page 5-130.

4 Select a standard from the database 
or click the Measure button. The 
„Measurement“ dialog box appears. 
Refer to Calibration and Measure-
ment on page 5-10.

If you do not select a standard, the pro-
gram calculates the average of all 
batches and uses this as the theoretical 
standard for the pass/fail decision.

5 You can set filters to reduce the 
number of batches that are dis-
played for selection. A filter might be 
a specific folder or any user defined 
field you have created either with 
Datacolor TOOLS or with Datacolor 
SORT.

Notes
• If you check „I want to use a Datacolor TOOLS Standard“ only Datacolor TOOLS 

standards are displayed to select from. The batches linked to this standard are 
listed on the next page. They are already selected if „Automatically include new 
batches“ is checked. In this case, it is not possible to remove batches from the 
list. This is only possible if „Automatically include new batches“ is not selected.

• Click the Measure button to measure more batches.
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6 The next pages of the SORT job wiz-
ard are the same as described in 
chapter „Specifying A New Sort 
Script“.
Depending on your access rights set 
in the sort job definition options. You 
can now modify all grouping and 
tapering parameters.   

Refer to Specifying A New Sort Script 
on page 5-126.

Refer to SORT job Definition Options on 
page 5-133.
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Modifying a SORT job

Action Result/Notes

1 Select either the option Maintain 
Sort Job on the „Datacolor Sort“ 
menu or on the context-sensitive 
menu.

The „Sort Job Maintenance“ dialog box 
appears.
Refer to Sort Job Maintenance Dialog 
Box on page 7-160.

2 Modify the data and click OK.

Note
The data you can change depends on your access rights and the job itself.
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Specifying A New Sort Script

Action Result/Notes

1 Select either the option New Sort 
Script on the „Datacolor Sort“ menu 
or on the context-sensitive menu.

The „New Sort Script“ wizard starts. The 
sort job name may be modified and a 
description can be entered into the 
description field.
Refer also to Sort Script Maintenance 
Dialog Box on page 7-167.

2 You can modify the name (default is 
New Script <date and time>) of the 
script and you can describe the 
script.

Refer to Script Name Tab on page 7-
167.

3 Click Next. The following dialog box appears.
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V

4 Define which sorting method, illumi-
nant, tolerance formula and toler-
ance factor you would like to use.

Refer to General Settings Tab on page 
7-168.

5 Click Next. The following dialog box appears.
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Parameters
Limit the number of batches in one group to:

You can define a minimum and a maximum number of 
batches in a group. If no maximum is given, there is no limit. 

Limit the total (XXX) in one group to
Here you can limit the group to the value of a user defined 
field, e.g., fabric length, quality level, etc. 

Limit the number of groups
This limits the number of groups to the range you type in. 

6 Select the sorting type. The grouping parameters you can 
select are dynamic and depend to the 
selected tolerance formula.

7 Click Next. The following dialog box appears.

8 Select the group limits. 

9 Click Next. The following dialog box appears.
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10 Select the tapering parameters. The parameters can be different than 
selected for clustering. In addition to the 
sort type you must select a tapering 
method.
Refer to Tapering Parameters Tab on 
page 7-163.

11 Click Next. The following dialog box appears.

12 Define what you would like to see in 
the results window.

Refer to View Options Tab on page 7-
165.

13 Click Next. The following dialog box appears.
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The last wizard page is used to set up the output and to select the coding you would like 
to use for groups (clusters) and tapers. The print output sort order is linked to individual 
print forms. One is used to print the job ordered by Group/Taper code, and the second is 
sorted identically to the order you have displayed in the output screen. You can change 
the order in the output screen by clicking in the table columns.

Modifying a Sort Script

14 Click Next to finish the wizard.

Action Result/Notes

1 Select either the option Maintain 
Sort Script on the „Datacolor Sort“ 
menu or on the context-sensitive 
menu.

The „Sort Script Maintenance“ dialog 
box appears.
Refer to Specifying A New Sort Script 
on page 5-126 and Sort Script Mainte-
nance Dialog Box on page 7-167 for 
more information about the settings.

2 Modify the data and click OK.

Note
Existing sort jobs are not modified automatically if you change the sort script. Modifica-
tions are taken into account if you recalculate the sort job.
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Maintain the Sample Property
With the „Maintain Sample Property“ function, you can add or modify a sample property 
and its value (user defined field). 
In the „Property“ tab, it is possible to specify or modify a property.
In the „Sample Property“ tab, you can set the values.
Properties and values are assigned to the batch selected in the table. The new property 
is added to the Datacolor file USER.FLD.

Action Result/Notes

1 Select the option Maintain Sample 
Property either on the „Datacolor 
Sort“ menu or on the context-sensi-
tive menu.

The „Sample Property“ dialog box 
appears.
Refer to Sample Property Dialog Box 
on page 7-169.

2 Modify the data and click OK.

Note
If you have installed Datacolor TOOLS, do not add or modify properties in Datacolor 
SORT. This may affect your Datacolor TOOLS desktop data. Properties may be used 
as input fields by screen forms in Datacolor TOOLS. Make all modification with Data-
color TOOLS Form Editor instead. 
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Pre-Selections of User Defined Fields
The „User.fld“ file may contain many fields that cannot be used by Datacolor SORT. This 
task is used to select only relevant user defined fields for Datacolor SORT.

Action Result/Notes

1 Select the fields in the „Batch Prop-
erties“ list box and click Add to 
move them into the „Pre-Selection 
Properties“ list box.

Datacolor SORT shows only the pre-
selected fields to filter the sample list 
according your field settings or to input 
the batch property field value when you 
measure new batches.
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SORT job Definition Options
This function program is used to create or modify tolerances. Refer to Specifying, Modi-
fying or Deleting Tolerances on page 5-44.

Check the input pages you want to see when a new SORT job is defined. 
The default settings for the sort job definition are:

Action Result/Notes

1 Select either the option Sort Job 
Definition Options on the „Datacol-
or Sort“ menu or on the context-sen-
sitive menu.

The „Sort Job Definition Options“ dialog 
box appears.
Refer to Sample Property Dialog Box 
on page 7-169.

2 Modify the data and click OK.

Note

If you want to be sure that a user works only with the predefined settings of the Sort 
Script, you have to limit the access rights, respectively. 

Login as User „DCI'“ and run the option „User Administration“
(Menu Tools → User Manager → User Administration). 
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Datacolor BLEND (Option)
Datacolor BLEND is a color recipe prediction software, especially designed to assist 
users in the complex process of fiber-blending.
Datacolor BLEND is a powerful tool for calculating the required amounts of pre-dyed 
fiber material to be used in the fiber-blending process, for both laboratory and produc-
tion use. Datacolor BLEND is designed with user-friendliness in mind. Each color can 
be calculated as a mixture of any fiber material, and from any shade. An important addi-
tional function is that dyeing recipes can be predicted with Datacolor MATCHTextile, in 
order to calculate the dyestuff amounts for dyeing fibers not currently in stock.
The functions for recipe creation and correction help the user to calculate blends with 
maximum efficiently, and, where required, at the lowest cost.

Datacolor BLEND is based on Datacolor MATCHTextile, the most comprehensive color 
recipe software for textile processing.
The application of fiber blending (melanges) requires different mathematics in order to 
calculate the amounts of individual colored fibers required to specify a melange fabric 
(felt, garment, etc.).
Companies that are involved in this application either use dyed fiber skeins only, and 
mix them in various percentages to obtain the desired mixture, or have their own (fiber) 
dye house for producing the "raw" material themselves, and are capable of carrying out 
supplementary dyeing if a mixture of existing colored fibers does not result in the target 
color. In addition to the demand for blending and dyeing, several fabrics are also creat-
ed by mixing different materials (CO/PES).

The Datacolor BLEND module for Datacolor MATCHTextile is able to serve all the pro-
cess demands of fiber blenders, as it offers the capability of calculating the required per-
centages of pre-colored fibers and of calculating the "supplementary dyeing".
The data set preparation for fiber blending is different from the calibration series for dye-
ing. It is necessary to have a set of black and white fiber mixtures and a 100%-repre-
sentative sample of each color. The data set preparation of Datacolor MATCHTextile has 
been modified to reflect these requirements, and, in addition, the matching and correc-
tion user interfaces have been adapted.
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Starting Datacolor BLEND
Datacolor BLEND can either be installed as a stand-alone application or as a module of 
Datacolor MATCHTextile.

Starting Datacolor BLEND

Specifying A New Fiber Set
Similar to Datacolor MATCHTextile colorant sets, you must specify fiber sets before you 
can calculate fiber recipes. The colorant set preparation program (Colibri) contains 
therefore a new option to build such fiber sets.

1 On the Windows start menu or the desktop, 
click the Datacolor MATCHTextile or the Data-
color BLEND icon.
The Datacolor MATCHTextile explorer with the 
“Overview” window appears.

2 Click the Fiber Blending icon.
The „Recipe List Window“ with the existing 
blend recipes appears.
Refer to Recipe List Window on page 7-91.

Action Result/Notes

1 Select the option General Calibra-
tion on the „File“ menu.

The „Colorant Set List“ window with the 
existing fiber sets appears.
Refer to Colorant Set List Window on 
page 7-76.

2 On the „Colorant set“ or the context-
sensitive menu, select 
New → Fiber Mixing.

The „Fiber Set“ window appears.
Refer to Blend Fiber Set Window on 
page 7-173.

3 Specify the fiber set name • The ID is built using the 24 lead-
ing characters and can be modi-
fied.

• Automatically, the „Industry Type“ 
is set to „Fiber blending“ and the 
process is created.

• The default „Calibration Method“ 
is „Rohner Function“. You can 
select „Approximation“.

4 Continue with Black and White 
Fibers on page 5-136.
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Black and White Fibers

Action Result/Notes

1 In the table column „Product“, click 
New.

The „White Fiber“ dialog box appears.

2 Specify name, product supplier, and 
actual price.

3 Click OK. The „Black Fiber“ dialog box appears.
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4 Specify name, product supplier, and 
actual price.

5 Click OK. The „Create Calibration Series“ dialog 
box appears.
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6 Fill in the concentration of the white 
fiber part.
Click then Complete mixture to. The program completes the black fiber 

concentrations.
5 - 138 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor BLEND (Option) 5 - Using Datacolor MATCHTextile
7 Select or measure the samples and 
click Accept.

The „Fiber Set“ window appears with 
the specified fibers.

8 Continue with Colored Fibers on 
page 5-140.
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Colored Fibers

Action Result/Notes

1 In the table column „Product“, click 
New.

The „Create Calibration Series“ dialog 
box appears.

2 Click New. The „Product Definition“ dialog box 
appears.

3 Specify name, product supplier, and 
actual price.

4 Click OK. The „Create Calibration Series“ dialog 
box appears.
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5 Measure the sample. Refer to Calibrating Your Spectropho-
tometer on page 5-10 and Measure-
ment on page 5-20.

6 Click Accept. The new color fiber is added to the fiber 
set.
The program goes back to the „Fiber 
Set“ window.

7 Specify the other colored fibers in 
the same way.
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Recipe Calculation

Action Result/Notes

1 On the context-sensitive menu of the 
„Recipe List“ window, click Match.

The „Match“ dialog box appears.
Refer to BLEND Match Dialog Box on 
page 7-176.

2 Select the standard.

3 Select a fiber set by double-clicking 
the name.

The fiber set appears in the list box 
„Used fiber set“. The „Part“ is set to 
100%. 
5 - 142 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor BLEND (Option) 5 - Using Datacolor MATCHTextile
4 In the „Dye Set“ tab, select the fibers 
you want to use.

Refer to Dye Set Tab on page 7-177 
and Lab Graphic Tab on page 7-178.

Note

The fiber selection is more important for this application than with Datacolor MATCHTex-

tile, because the program may calculate many recipes with a good colorimetric result, 
but the visual effect depends strongly to the fiber colors of the standard. The measure-
ment of the standard is an average of all colors used for the standard.

5 Set the parameters of the „Settings“ 
tab, if necessary.

Refer to Settings Tab on page 7-120.

6 Click Calculate. The „Recipe List“ appears.
Refer to BLEND Recipe Calculation 
Result Table on page 7-179 and Review 
(recipe table) on page 5-76.

7 Select the recipe in the table and 
save it.
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Result Table of Recipe Calculation

Recipe Calculation with several Fiber Sets
Note
If you want to calculate a recipe for several fibers, e.g., Polyester/Wool, you must 
change the „Part“ to the percentage used for fiber set 1. If the „Part“ is not equal 100%, 
the program asks for a 2nd, 3rd, ... Fiber sets as soon, as the recipe for the 1st fiber set 
is calculated.

The recipes are calculated one after the other, because the 2nd fiber recipe is influ-
enced by the first. This behavior of Datacolor BLEND is a different to Datacolor 
MATCHTextile.

8 Select the next fiber set and repeat 
the calculation procedure starting 
with instruction 3.
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Recipe Calculation with An Existing Production Lot of Used Fibers
If an existing production lot should be used as fiber for the recipe calculation, you must 
measure or select a sample of the production lot as batch. The program asks, if you like 
to specify a new fiber (based on that measurement) and gives a proposal for the maxi-
mum percentage this fiber can be used. This value is very rough information. In reality, 
you should start with smaller concentration. If no recipe can be calculated, you can 
switch back to modify the concentration again.

Example
The program asks to specify a new fiber on base of the batch measurement „Stone-
Wool“. A fiber with the name „FIB_Stone-Wool“ is created. 
These automatically created fibers cannot be used in the normal matching routine. They 
are hidden.
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The proposal (Max Of Share) for the „Batch-Fiber“ is given with 48.72%. For this exam-
ple the share is reduced to 14.00%. Some information can be get in the graph. The blue 
curve represents the batch, the green curve the standard and the red curve is the theo-
retical curve representing the part that is used (share). Very important is that the red 
curve is below the green curve of the standard.

Calculated recipes with 14% of the batch already produced.
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Calculation of the Theoretical Color Needed to Correct the Filer Lot
Instead of calculating a recipe using a part of the existing lot, it is possible to calculate 
the theoretical reflectance curve of the color that is necessary to correct the existing lot. 
The theoretical reflectance curve is used in Datacolor MATCHTextile to calculate a recipe 
for dyeing a new fiber. This new fiber is blended later with the existing lot.

Action Result/Notes

1 Click -> R% to calculate the theoreti-
cal reflectance curve.

The „Insert a theoretical sample“ dialog 
box appears.

2 Accept or modify the sample name 
and click Insert to save the sample

The sample can now be used for 
matching in Datacolor MATCHTextile.
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Recipe Correction
The Datacolor BLEND correction task does not distinguish between laboratory and pro-
duction correction. Both corrections are calculated. The new recipe is saved as soon as 
the correction is saved. In the correction printout are both, the new recipe and the addi-
tion, if a production correction is required.

Action Result/Notes

1 In the „Recipe List“ window, select 
the recipe and on the context-sensi-
tive menu select Pass Fail and Cor-
rection (or press F7).

The „Correction Dialog“ box appears.
Refer to BLEND Correction Dialog Box 
on page 7-179.

2 In the “Batch and Color Difference” 
field, measure or select the sample.

3 If necessary, alter the data in the 
dyestuffs table.

Refer to Matching on page 5-74, sec-
tion Selecting dyestuffs for matching on 
page 5-71.

4 Click Correction. The “BLEND Correction Recipe Dialog 
Box” appears.
Refer to Specifying, Modifying and 
Deleting Objects on page 5-8.
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5 In the “BLEND Correction Recipe 
Dialog Box” dialog box, you can look 
at the result of the matching. The 
color differences between “Stan-
dard” and “Batch” are displayed.
Click Show for displaying a print 
preview.
Click Print to print the recipe data.

Refer to BLEND Recipe Calculation 
Result Table on page 7-179.
The „BLEND Correction Recipe“ can be 
configured. Refer to View Configura-
tion Dialog Box (Laboratory Correction 
Table) on page 7-100.

6 Click Save. The corrected recipes (laboratory and 
production) are saved.
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BLEND Fast Correction

The “Fast Correction” function is used for corrections without an existing recipe. It is 
based on a theoretical calculated recipe of the standard or a recipe typed in manually. 
This task is mainly used for production correction.

Action Result/Notes

1 On the context-sensitive menu, 
select Fast Correction, or press F8.

The “Fast Correction Recipe Input” dia-
log box appears. Refer to BLEND Fast 
Correction Dialog Box for a detailed 
description of the parameters.

2 In the “Process Data for Fiber 
Matching” tab, select the Fiber Set, 
accept or modify the Part for the 
selected fiber set and select the 
Standard.

3 In the “Colorant Set” tab, select the 
fibers used for the recipe and specify 
the concentration.

4 Select the fibers and type the con-
centrations valid for the current 
batch.

5 Measure or select the batch to be 
corrected.

6 Click Correction.
Continue with chapter Recipe Cor-
rection on page 5-148.

The “Recipe Correction” tab appears.
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Displaying and Printing Existing BLEND Recipes

Recipe Output
New output features

Colorimetric data is printed (color difference and metamerism for standard, batch 
and standard, theoretical batch of correction).

Information if the recipe was manually modified.

The last measured batch.

Action Result/Notes

1 Select the recipe in the “Recipe List” 
window.

2 On the context-sensitive menu, 
select Lab Dyelot, or, press Enter.

The “Show Full Recipe Dialog Box” dia-
log box appears.
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Recipe History
If a Batch exists, Datacolor MATCHTextile saves all corrections and modifications of a 
recipe. Modifications done with the „Edit“ option are also saved. In addition to the reci-
pes, a dLab graph is displayed.

Displaying the history:
• Select the function History on the Recipe or the context-sensitive menu.

Printing the history:
• Select Print on the History menu.

Note
The graph is not to be printed.
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Maintenance of the Spectrophotometer
Refer to the manual of your spectrophotometer.

Maintenance of the Database

Deleting Data
You can delete data objects in the corresponding windows and boxes.

Backup
Refer to Backing Up Using Sybase Utilities on page 4-17.

Error Handling
1 Note the error message and what you were doing before the error occurred.
2 Try to execute the advice of the error message. Example below: Specify a mini-

mum of one batch before clicking Save again.

3 Log out of Datacolor MATCHTextile and restart Windows.

4 Restart Datacolor MATCHTextile.

If the error occurs again, contact your Datacolor representative for further advice.

Error Messages
If an error message appears while you are using your system, you should follow the 
advice above.

Example of an error message:

Note
The delete, move, copy and rename functions are only available to users having the 
corresponding access rights.

Note
An object cannot be deleted, if it is linked to other objects. If the system cannot delete 
an object, all valid links are listed in the “Delete Check” info box.
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Explorer

Overview Window

Title bar
The title bar contains the title of the program, the title of the current window and, if a list 
window is opened, the number of data records.

Menu bar
Refer to General Menu Functions on page 7-4 for the general functions or to the related 
window descriptions for window specific functions.

Toolbar
Refer to Toolbar Functions on page 7-7.

Status bar
Display of messages.

Menu Bar
Toolbar

Status Bar

Title bar
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Buttons in the overview window
Fiber:
Quality/Style Opens the “Quality/Style List” window. Refer to Quality/Style 

List Window on page 7-87.

Substrate Delivery Opens the “Substrate Delivery List” window. Refer to Sub-
strate Delivery List Window on page 7-87.

Affinity Opens the “Affinity List” window. Refer to Affinity List Window 
on page 7-88.

Fiber Group Opens the “Fiber Group List” window. Refer to Fiber Group 
List Window on page 7-87.

Fiber Opens the “Fiber List” window. Refer to Fiber List Window on 
page 7-86.

Process:
Combined Process Opens the “Combined Process List” window. Refer to Com-

bined Process List Window on page 7-93.

Operation Opens the “Operation List” window. Refer to Operation List 
Window on page 7-93.

Dye Process Opens the “Dye Process List” window. Refer to Dye Process 
List Window on page 7-88.

Auxiliary Opens the “Auxiliary List” window. Refer to Auxiliary List Win-
dow on page 7-89, and Specifying, Modifying or Deleting a 
Product on page 5-34.

Parameter Opens the “Parameter List” window. Refer to Parameter List 
Window on page 7-86, Parameter Definition Dialog Box on 
page 7-57, and Specifying, Modifying or Deleting a Product 
on page 5-34.

Recipe:
Color Type Opens the “Color Type List” window. Refer to Color Type List 

Window on page 7-85.

Recipe Opens the “Recipe” application (used for matching, correc-
tion and printing recipes) and displays the “Recipe List” win-
dow. Refer to Matching on page 5-74, Correction on page 5-
91, Displaying and Printing Existing Recipes on page 5-104, 
and Recipe List Window on page 7-91.

Colorant Set Opens the “Colorant Set” application (used for colorant set 
preparation) and displays the “Colorant Set List” window. 
Refer to Specifying Colorant Sets on page 5-47, and Colo-
rant Set List Window on page 7-76.

Dyestuff Opens the “Dyestuff List” window. Refer to Dyestuff List Win-
dow on page 7-89.

Sample Opens the “Sample List” window. Refer to Sample List Win-
dow on page 7-85.
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Modules: (Options)
Fiber Blending Refer to Datacolor BLEND (Option) on page 5-134.

Color Fiber Refer to Datacolor BLEND (Option) on page 5-134.

Monitoring Refer to Datacolor MONITOR (Option) on page 5-106.

Sorting Refer to Datacolor SORT (Option) on page 5-118.

Production: (Option)
Buttons used for Datacolor TICKET. Refer to Datacolor TICKET (Option) on page 5-115.
Dye Lot Opens the „Dye Lot List“ window. Refer to Datacolor TICKET 

- Dye Lot on page 5-117.

Production Recipe Opens the „Production Recipes List“ window. Refer to Data-
color TICKET - Production Recipe on page 5-115.

Administration Opens the „Datacolor PROCESS Administration“ dialog box. 
Refer to Datacolor TICKET - Administration on page 5-117.

Status bar
Display of messages.

General Menu Functions
File
Datacolor Sorting Refer to Datacolor SORT (Option) on page 5-118.

Batch Series Opens the „Batch Series List“ window. Refer to Datacolor 
MONITOR (Option) on page 5-106.

SmartMatch Opens the “SmartMatch List” window. Refer to SmartMatch 
Result List Window on page 7-94, Approving on page 5-84, 
and Manual Input of SmartMatch Points on page 5-90.

Fiber Blending Opens the „Recipe List“ window. Refer to Recipe List Win-
dow on page 7-91 and Datacolor BLEND (Option) on page 5-
134.

Basic Data Opens the list window last opened. The context-sensitive 
menu is used to open the other basic data windows. Refer to 
Specifying Basic Data on page 5-25.

General Calibration Opens the “Colorant Set” application (used for colorant set 
preparation) and displays the “Colorant Set List” window. 
Refer to Specifying Colorant Sets on page 5-47, Colorant Set 
List Window on page 7-76, and displays the basic data list of 
the last session.

Recipe Opens the “Recipe” application (used for matching, correc-
tion and printing recipes) and displays the “Recipe List” win-
dow. 
Refer to Recipe Calculation (Matching) on page 5-67, Cor-
rection on page 5-91, Displaying and Printing Existing Reci-
pes on page 5-104, and Recipe List Window on page 7-91.

Overview Opens the “Overview” window (main screen).
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Save Saves the current data.

Close Closes the currently active window. If data is altered, the pro-
gram requests the data be saved.

Close All Closes all opened windows except the “Overview” window.

Print Prints data of the currently opened “Colorant Set List” or 
“Recipe” window using the default Windows printer.

Print Setup Is used for setting up the default Windows printer.

Send Mail Is used to send e-mails. 
Refer to Sending E-mails on page 4-25.

Scan Mail Is used to receive and select e-mails.

Exit Closes the program.

Tools
Toolbar Switches the toolbar on (check mark) and off.

Status Bar Switches the status bar on (check mark) and off.

User Manager Change Password: Refer to Changing the Password on page 
4-2.
User Administration: Refer to Specifying, Modifying and 
Deleting User’s Data on page 4-2.

User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 
to Browser Customizing on page 4-6.

Define Units Opens the “Unit” dialog box. Refer to Defining Units on page 
4-11.

Automatic SmartMatch Housekeeping
Refer to Automatic SmartMatch Maintenance on page 5-86.

Options Opens the “Options” dialog box. 
Refer to Options on page 4-11.

Import Opens the “Import” dialog box for sample import. Refer to 
Import and Export on page 4-12.

Export Opens the “Export” dialog box for sample export. Refer to 
Exporting Data on page 4-12.

Import Print Form Imports print forms without using the Page View Designer. 
Refer to Importing Print Forms on page 4-29.

Export Print Form Exports print forms without using the Page View Designer. 
Refer to Exporting Print Forms on page 4-29.

ASCII forms New: Opens the „ASCII Output Definition“ dialog box.
Change: Opens the „ASCII Output Definition“ dialog box. 
Delete: Opens the „Delete ASCII Form“ dialog box. 
Refer to ASCII Output (Option) on page 4-20.

Backup Opens the “Backup” dialog box. Refer to Backing Up Using 
Sybase Utilities on page 4-17.

Calibrate Monitor Function for calibrating monitors using Datacolor SPYDER2. 
Refer to Calibrating the Monitors Using Datacolor SPYDER2 
on page 4-24.
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Instrument
Calibrate Instrument Opens the „Calibration Conditions“ dialog box. Refer to Cali-

brate Tab on page 7-18 and Calibration and Measurement on 
page 5-10.

Instrument Setup Opens the „Instrument Setup“ tab of the „Measurement Main 
Window“. Refer to Instruments Setup Tab on page 7-19 and 
Calibration and Measurement on page 5-10.

Measurement Setup Opens the „General Options“ tab of the „Measurement Main 
Window“. Refer to Instruments Setup Tab on page 7-19 and 
Calibration and Measurement on page 5-10.

Diagnostic Instrument Only if the green tile test is installed. Opens the „Prepare 
for Diagnostic“ dialog box. Refer to UV Calibration Tab on 
page 7-21 and Green Tile Test on page 5-18.

UV Calibration Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration Tab 
on page 7-21 and UV Calibration on page 5-11.

Ganz/Griesser Calibration Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration Tab 
on page 7-21 and UV Calibration on page 5-11.

Ganz/Griesser Parameters
Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration on 
page 5-11.

Window
New Window Creates a copy of the currently selected window.

Cascade Arranges the overview and the opened windows as a cas-
cade.

Tile Arranges the overview in the upper and the opened window 
in the lower part of the explorer.

Help

Help Topics Opens the Acrobat Reader with the „Datacolor MATCHTextile 
Dye Lot User’s Guide“.

About ColorLab Opens the “About ColorLab” information box with release, 
copyright and user information.

Note
Refer to the related window description for window specific menu functions.
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Toolbar Functions

General toolbar
1 Overview Opens the “Overview” window.
2 Datacolor SORT Refer to Datacolor SORT (Option) on page 5-118.
3 Datacolor MONITOR Opens the „Batch Series List“ window. Refer to Datacolor 

MONITOR (Option) on page 5-106.
4 SmartMatch Opens the “SmartMatch List” window. Refer to SmartMatch 

Result List Window on page 7-94, Approving on page 5-84, 
and Manual Input of SmartMatch Points on page 5-90.

5 Datacolor BLEND
6 Basic Data Opens the basic data application and displays the basic data 

list of the last session. Refer to Browser Customizing on 
page 4-6 and Browse and Selecting on page 5-2.

7 Calibration (colorant set)
Opens the “Colorant Set” application (used for colorant set 
preparation) and displays the “Colorant Set List” window. 
Refer to Specifying Colorant Sets on page 5-47, Colorant 
Set List Window on page 7-76

8 Recipe Opens the “Recipe” application (used for matching, correc-
tion and printing recipes) and displays the “Recipe List” win-
dow. Refer to Recipe Calculation (Matching) on page 5-67, 
Correction on page 5-91, Displaying and Printing Existing 
Recipes on page 5-104, Recipe List Window on page 7-91.

9 Instrument Calibration Opens the “Calibration Conditions” dialog box (corresponds 
to the “Calibration” tab of the “Measurement” dialog box). 
Refer to Calibrate Tab on page 7-18, and Calibration and 
Measurement on page 5-10.

10 Save Only active in recipe application. Saves recipes and labora-
tory corrections.

11 Print Prints data of the currently opened “Colorant Set List” or 
“Recipe” window using the default Windows printer.

12 Close Closes the currently displayed window and asks for saving if 
some data has been altered.

13 Help Opens the Datacolor MATCHTextile User’s Guide.

1 2 3 4 5 6 7 9 108 1211 13 14 15 16 17 18
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Recipe toolbar
14 Match Opens the “Match” dialog box.

Refer to Match Dialog Box on page 7-116.
15 Laboratory Correction Opens the “Correct or Approve Your Recipe” dialog box. 

Refer to Laboratory Correction on page 5-92.
16 Production Correction Opens the “Production Correction” dialog box. Refer to Pro-

duction Correction on page 5-96.
17 Fast Correction Opens the “Fast Correction” dialog box. Refer to Fast Cor-

rection on page 5-99.
18 Search and Correct Opens the “Search and Correct” dialog box used for search-

ing recipes. Refer to Search and Correct Dialog Box on page 
7-109.
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Folder Structure
All objects are displayed in a structured list at the 
left of the “Explorer” window.

Opening and closing structure levels
+ A + sign indicates that there are hidden subordi-

nate folders.

Click the + sign to open the next structure level.

- Click the - sign to close all subordinate structure 
levels.

Selection of object types
1. Select the requested object type using the left 

mouse button.
If “All Data” is selected, all object types can be 
displayed.

Context-sensitive menu

New Folder Adds a new subfolder to the selected folder. Type a meaning-
ful name.

Delete Deletes the selected folder (only if the folder is empty).

New Root Folder Adds a new root folder. Type a meaningful name.

Rename Is used to rename the selected folder.

Data Type in this Folder Opens the „Data in Folder“ dialog box used for searching 
data types and the corresponding data in the selected folder.
Refer to Data in Folder Dialog Box on page 7-13

Find in Folder Opens the „Find <data type> in Folder“ dialog box used for 
searching data with a determined name or part of the name. 
The <data type> of the opened list window is used.
Refer to Find in Folder Dialog Box on page 7-14
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Functions of the “Basic Data” Menu
Product Opens the “Product Property Sheet”. Refer to Product Prop-

erty Sheet on page 7-31 and Specifying, Modifying or Delet-
ing a Product on page 5-34.

Quality/Style Opens the “Quality/Style Property Sheet”. Refer to Quality/
Style Property Sheet on page 7-22 and Specifying, Modifying 
or Deleting a Quality/Style on page 5-26.

Dye Process Opens the “Dye Process Property Sheet”. Refer to Dye Pro-
cess Property Sheet on page 7-29, and Specifying, Modifying 
or Deleting a Dye Process on page 5-37.

Customer Opens the “Customer Property Sheet”. Refer to Customer 
Property Sheet on page 7-43 and Specifying, Modifying or 
Deleting Customers on page 5-39.

Color Type Opens the “Color Type Property Sheet”. Refer to Color Type 
Property Sheet on page 7-45 and Specifying, Modifying or 
Deleting a Color Type on page 5-43.

Parameter Definition Opens the “Parameter Definition” dialog box. Refer to 
Parameter Definition Dialog Box on page 7-57 and Specify-
ing, Modifying or Deleting Parameters on page 5-40.

Tolerance Opens the “Tolerance Block Program” dialog box. Refer to 
Tolerance Block Program Dialog Box on page 7-46 and 
Specifying, Modifying or Deleting Tolerances on page 5-44.

Combined Process Opens the “Combined Processes” window. Refer to Com-
bined Processes Browse Window on page 7-58 and Specify-
ing Combined Processes on page 5-61.

Operation Opens the “Operations” browse window. Refer to Operations 
Browse Window on page 7-65, and Specifying, Modifying, 
Deleting An Operation on page 5-64.

Sample Opens the “Color Sample Calculator” dialog box. Refer to 
Sample Input Dialog Box on page 7-72.

Browse Data Opens a submenu with the following functions:
Refer to Browser Customizing on page 4-6 and Browse and Selecting on page 5-2 for 
information about the use of the list windows.

Illuminant List Opens the “Illuminant List” window. Refer to Illuminant List 
Window on page 7-85.

Sample List Opens the “Sample List” window. Refer to Sample List Win-
dow on page 7-85, and Manual Input and Modification of 
Samples on page 5-24.

Color Type List Opens the “Color Type List” window. Refer to Color Type List 
Window on page 7-85, and Specifying, Modifying or Deleting 
a Color Type on page 5-43.

Tolerance List Opens the “Tolerance List” window. Refer to Tolerance List 
Window on page 7-86, and Specifying, Modifying or Deleting 
Tolerances on page 5-44.
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Parameter List Opens the “Parameter List” window. Refer to Parameter List 
Window on page 7-86, and Specifying, Modifying or Deleting 
Parameters on page 5-40.

Fiber List Opens the “Fiber List” window. Refer to Fiber List Window on 
page 7-86, and Specifying, Modifying or Deleting a Quality/
Style on page 5-26.

Fiber Group List Opens the “Fiber Group List” window. Refer to Fiber Group 
List Window on page 7-87, Fiber Group Tab on page 7-25, 
and Specifying, Modifying or Deleting a Quality/Style on page 
5-26.

Substrate Delivery List Opens the “Substrate Delivery List” window. Refer to Sub-
strate Delivery List Window on page 7-87, Substrate Delivery 
Dialog Box on page 7-27, and Specifying, Modifying or Delet-
ing a Quality/Style on page 5-26.

Quality/Style List Opens the “Quality/Style List” window. Refer to Quality/Style 
List Window on page 7-87, Quality/Style Property Sheet on 
page 7-22, and Specifying, Modifying or Deleting a Quality/
Style on page 5-26.

Affinity List Opens the “Affinity List” window. Refer to Affinity List Window 
on page 7-88, Quality/Style Property Sheet on page 7-22, 
and Specifying, Modifying or Deleting a Quality/Style on page 
5-26.

Dye Process List Opens the “Dye Process List” window. Refer to Dye Process 
List Window on page 7-88, and Specifying, Modifying or 
Deleting a Dye Process on page 5-37.

Dyestuff Class List Opens the “Dyestuff Class List” window. Refer to Dyestuff 
Class List Window on page 7-88, and Specifying, Modifying 
or Deleting a Dye Class on page 5-38.

Dyestuff List Opens the “Dyestuff List” window. Refer to Dyestuff List Win-
dow on page 7-89, and Specifying, Modifying or Deleting a 
Product on page 5-34.

Auxiliary List Opens the “Auxiliary List” window. Refer to Auxiliary List Win-
dow on page 7-89, and Specifying, Modifying or Deleting a 
Product on page 5-34.

Color Fiber List Opens the „Product List“ Window. Refer to Product List Win-
dow on page 7-90, and Specifying, Modifying or Deleting a 
Product on page 5-34.

Supplier List Opens the “Supplier List” window. Refer to Supplier List Win-
dow on page 7-90, and Specifying, Modifying or Deleting a 
Product on page 5-34.

Customer List Opens the “Customer List” window. Refer to Customer List 
Window on page 7-91, and Specifying, Modifying or Deleting 
Customers on page 5-39.

Combined Process List Opens the “Combined Process List” window. Refer to Com-
bined Process List Window on page 7-93, and Specifying 
Combined Processes on page 5-61.
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Operation List Opens the “Operation List” window. Refer to Operation List 
Window on page 7-93, and Specifying, Modifying, Deleting 
An Operation.

General functions:
Display Displays a list with the selected objects.

Print Prints list with the selected objects.

ASCII Output Creates a text file if a corresponding form exists. Refer to 
ASCII Output (Option) on page 4-20.

User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 
to Browser Customizing on page 4-6.

Rename Is used to rename the selected object.

Delete Deletes the selected object after confirmation.

Move to Moves a selected object to another folder.

Filter Refer to Browse Filters on page 4-8.

Reset Filter Resets the selected filter.

Note
The delete and rename functions are only available to users with the corresponding 
access rights.
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Data in Folder Dialog Box 7 - Windows and Dialog Boxes
Data in Folder Dialog Box
Used to search for data types and the corresponding data records stored in the folder 
selected in the folder structure.

Data type box: Shows all data types that the folder selected in the folder 
structure contains.

Data box Shows all data records of selected data type.

Context-sensitive menu of the Data box:
User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 

to Browser Customizing on page 4-6.

Rename Is used to rename the selected object.

Delete Deletes the selected object after confirmation.

Move to Moves a selected object to another folder.

Filter Refer to Browse Filters on page 4-8.

Reset Filter Resets the selected filter.

Note
The delete and rename functions are only available to users with the corresponding 
access rights.
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Find in Folder Dialog Box
Used for searching data records with a determined name or part of the name. The data 
type of the opened list window is used. Refer to Searching objects of a determined data 
type on page 5-3.

Search criteria:
You can type a complete name or a part of it. If you are typing a part it is necessary to 
check one or both of the boxes for leading or trailing text.

Additionally, you can select the time range of the last modification.
Buttons:
Search Starts the search.

Stop Stops the current search.

Clear removes all data from the input and list boxes.

Context-sensitive menu in the „Search Result“ table:
Display Displays a print preview of the selected object.

Print Prints data of the selected object.

ASCII Output Saves data of the selected object into a ASCII output.

Note
Wildcards cannot be used.
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Measurement Main Window
The “Measurement” dialog box is used for selection and setting up the instrument, cali-
bration, and measurement. Refer to Calibration and Measurement on page 5-10.

Single Tab (Example)

Refer to the manual of your spectrophotometer for instrument specific information.

„Color“ tab Shows the color of the measured sample.

„Reflectance“ tab Shows the reflectance values of the measured sample.

„Coordinates“ tab Shows the color coordinates (e.g., yxz Lab) of the measured 
sample.

„Conditions“ tab Shows the measurement conditions.
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Multiple Tab

Parameters
Used for a measurement series.

The graph and the fields show the result of the measurement. Average and deviation 
are calculated according to the selected measurements. 
In the table, the measurements can be selected or canceled using the mouse.

Measurements can also be canceled using the measurement selection and the DEL 
buttons at the top of the graph.

Accept now Selects all measurements.

Measure Executes the measurement.

Close Closes the “Measurement” dialog box and saves the cur-
rently calculated values.
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Until Tolerance Tab

Parameters
Used for multiple measurement until the color differences do no longer exceed the toler-
ance values.

The graph and the fields show the result of the measurement. Averages and deviation 
are calculated according to the selected measurements. 
Measurements can be selected or canceled in the table using the mouse.

Measurements can also be canceled using the measurement selection and the DEL 
buttons at the top of the graph.

Accept now Selects all measurements.

Measure Executes the measurement.

Close Closes the “Measurement” dialog box and saves the cur-
rently calculated values.
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Calibrate Tab
Opens the “Calibration Conditions” dialog box.

Refer to the manual of your spectrophotometer.
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Instruments Setup Tab

Parameters

Refer to the manual of your spectrophotometer.

Caution
An alteration of these parameters can interrupt the communication between the 
PC and the spectrophotometer.
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General Options Tab

Parameters
Definition of general parameters for single measurement, multiple measurement, until 
tolerance, calibration, and green tile test (Refer to Green Tile Test on page 5-18.).
Until tolerance Select the formula and specify the tolerance to be accepted.

Correlation Refer to Configuring and Enabling the Maestro Correlation 
Feature on page 5-16.
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UV Calibration Tab
Calibration Methods

Ganz/Griesser: This procedure uses the Ganz/Griesser calibration method. The light 
source is filtered to simulate the D65 Illuminant and the Ganz Griesser parameters are 
used to calculate the filter position. In addition, the target whiteness value is based on 
10% standard observer data.
CIE using D65/10: The light source is filtered to simulate the D65 illuminant. This is the 
procedure used to perform a CIE Whiteness evaluation.
ISO Brightness (C): The light source is filtered to simulate Illuminant C. This is the pro-
cedure used to perform an ISO Brightness evaluation.

Example Using the Ganz/Griesser Method

Refer to UV Calibration on page 5-11.

Note
There are several methods that can be used to calibrate the adjustable UV filter posi-
tion. Please refer to the whiteness standard you are using to determine the method to 
be used.
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Quality/Style Property Sheet
Buttons
Save Saves the displayed quality definition.

Delete Deletes the displayed quality definition after confirmation.

Clear Clears the fields of the currently displayed tab.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Quality/Style Tab

Parameters
Name Unique name of the quality/style.

ID Unique identification of the quality/style.

AuxID Additional identification of the quality/style.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Customer Name of the customer.

Affinity Name of the affinity.

Grey Quality/Style Note on the raw quality/style.

Lab. Note Additional notes for the laboratory.

Prod. Note Additional notes for production.

Type Quality/style type.

Special Comp. If checked, the composition of quality/style is modified.
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Modify (button) Opens the “Special Composition for Quality/Style” dialog box 
used for changing the fiber parts.
Example: In a composition of polyester, cotton and Lycra, 
the Lycra cannot be dyed. If you do not set the Lycra part to 
0%, a recipe is calculated for the Lycra part too. 

Substrate Delivery (button)
Opens the “Substrate Delivery Dialog” box to measure a new 
substrate delivery. Refer to Calibration and Measurement on 
page 5-10, Specifying, Modifying or Deleting a Quality/Style 
on page 5-26, and Substrate Delivery: Example on page 5-
30.

Substrate Blank Dyeing (button)
If this button is activated, you have not measured a sub-
strate. Opens the “Substrate Delivery Dialog” box to measure 
the first substrate delivery. Refer to Calibration and Measure-
ment on page 5-10, Specifying, Modifying or Deleting a Qual-
ity/Style on page 5-26, and Substrate Delivery: Example on 
page 5-30.

Process Type Check boxes: Exhaust, Continuous / Printing.

Use Affinity SmartMatch If checked, SmartMatch points of all qualities linked with the 
same affinity are used.

Characteristics (Notes) Weight: weight
Width: width
Weft: weft material
Warp: warp material.

Caution
It is indispensable when this method of SmartMatch matching that only qualities 
with the same dye behavior are linked to an affinity. Otherwise, the results of 
matching are unusable.
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Affinity Tab

Parameters of the „Affinity“ tab
Name Unique name of the affinity.

ID Unique identification of the affinity.

AuxID Additional identification of the affinity.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Fiber Group Selection of the fiber group.

Search Colorant Sets (button)
Displays in the “Colorant Set” field the selection boxes for 
colorant sets.

Fibers:

Fiber Name Name of the fiber.

Fiber Part Share of the fiber in percent. The summary of all parts 
must be 100%.

Colorant Set

Is used to set the link between colorant set and affinity.
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Fiber Group Tab

Parameters
Name Unique name of the fiber group.

ID Unique identification of the fiber group.

AuxID Additional identification of the fiber group.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Available/Selected Fibers In the “Available Fibers” list box, all available fibers are listed. 
In the “Selected Fibers” list box, the fibers are listed used for 
the current quality/style definition. 
The fibers of the two boxes can be selected and moved from 
one to the other box using the move buttons between the 
boxes (or double-click the fiber name).
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Fiber Tab

Parameters
Name Unique name of the fiber.

ID Unique identification of the fiber.

AuxID Additional identification of the fiber.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.
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Substrate Delivery Dialog Box

Substrate Delivery

Combo box Selection of existing substrate deliveries.

Table columns

Color Color display.

Fiber Name Unique name of the fiber.

Effect Opens the “Substrate Delivery Effect Dialog” box. Refer to 
Calibration and Measurement on page 5-10, Specifying, 
Modifying or Deleting a Quality/Style on page 5-26, and Sub-
strate Delivery: Example on page 5-30.

Buttons
New Click to specify a new substrate delivery.

Sample Opens a dialog box to select an existing sample.

Measure Opens the “Measure” dialog box. Refer to Calibration and 
Measurement on page 5-10.

Measure Directly Executes the measurement.

Insert Enters the currently displayed substrate delivery.

Delete Deletes the currently displayed substrate delivery.

Close Closes the “Substrate Delivery Dialog” box. If data is altered, 
the program requests the data be saved.
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Substrate Delivery Effect Dialog Box

Table columns
Fiber Name Fiber name.

Colorant Set Unique name of the colorant set (colorant set).

Effect Effect factor for the recipe calculation (little correction).

Insert a New Effect for a Colorant Set.
Selection box for the colorant set (colorant set). The browse 
button opens a browse dialog box used to search for colorant 
sets.

Buttons
Insert Adds the current colorant set to the table.

Save Saves the currently displayed effect.

Delete Deletes the currently displayed effect.

Close Closes the “Substrate Delivery Effect Dialog” box. If data is 
altered, the program requests the data be saved.

Note
It is possible to create different effects for different colorant sets. The effects must be 
defined in the “Effect Using” column. 
Refer to Substrate Delivery: Example on page 5-30.
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Dye Process Property Sheet

Dye Process Tab

Parameters
Name Unique name of the fiber.

ID Unique identification of the fiber.

AuxID Additional identification of the fiber.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Dye Class Selection box for the dye class.

Process Type Selection of process type, liquor ratio/pickup, and unit.

Table:

Shows the dye fiber group: fibers or fiber groups dyed in the same bath and using the 
same recipe. Refer to Specifying dye fiber groups on page 5-37.
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Process Factors Tab
Used to name process factors. 

Parameters
Name Unique name of the factor.

ID Unique identification of the factor.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Factor Input of a process factor.
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Product Property Sheet
Buttons
Save Saves the displayed product definition.

Delete Deletes the displayed product definition after confirmation.

Clear Clears the fields of the currently displayed tab.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Auxiliary Tab

Parameters
Name Unique name of the product.

ID Unique identification of the product.

AuxID Additional identification of the product.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of the creating or last modifying user.

Product Supplier Unique name of the product supplier.

Product Type Product type, e.g., Auxiliary (default).

Product Form Product form, e.g. liquid or solid.

Default Delivery Date of the default delivery selected from the delivery list. 
Data are imported from Datacolor Process.
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Product Strength Currently supplied concentration.

Specific Gravity Specific weight.

Lab Strength Factor Current laboratory strength factor.

Actual Price Current price (per inventory unit).

Invent. Unit Unit for the calculation of costs. This unit is defined in the 
„Unit Selection“ tab of the „Options“ dialog box together with 
a weight or volume. It is necessary because the sample 
weight and the batch volume are normally too low for the cal-
culation of the costs.

Special Stock Solution Special stock solution. If stock solution is activated in the 
options, the default stock solution is selected. If a specific 
stock solution is required for a product, you must define it in 
the “Stock Solution” tab.

Note Field for additional notes.

Formula Setting (button) Opens the “Formula Setting” dialog box for product settings 
used by the production software. Refer to Formula Setting 
Dialog Box on page 7-42.
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Product Supplier Tab

Parameters
Name Unique name of the product supplier.

ID Unique identification of the product supplier.

AuxID Additional identification of the product supplier.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Contact Person Name of the contact person.

Address Address of the product supplier.

Address 2 Additional address of the product supplier.

City Address: Name of the city.

Zip Code Zip code.

Country Name of the country.

Phone Number Phone number of the product supplier.

Fax Number Fax number of the product supplier.

E-Mail E-mail address of the product supplier.
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Dyestuff Tab

Parameters
Name Unique name of the dyestuff.

ID Unique identification of the dyestuff.

AuxID Additional identification of the dyestuff.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Supplier Dye Name Dye name of the supplier.

Dye Description Description, e.g., Brilliant.

Dyestuff Color Name of the color.

Dyestuff Type (Form) Dyestuff type, e.g., Light.

Dye Name Ext. Dyestuff name extension.

Dyestuff Strength Currently supplied strength.

Dye Class Dye class, e.g., Disperse.

Compose Name (button) If activated a dyestuff name is composed using “Supplier Dye 
Name,” “Dye Description”, “Dyestuff Color, and “Dyestuff 
Type.”

Product Supplier Unique name of the product supplier.

Product Type Product type, e.g., Dyestuff (default).

Default Delivery Date of the default delivery selected from the delivery list. 
Data are imported from Datacolor Process.
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Product Form Product form, e.g. liquid or solid.

Lab Strength Factor Current laboratory strength (differences to the default deliv-
ery).

Actual Price Current price (per inventory unit).

Invent. Unit Inventory unit.

Specific Gravity Specific gravity.

Color Index Refer to Color index on page 8-2.

Note Field for additional notes.

Special Stock Solution Special stock solution.

Note
The Lab Strength Factor is a divisor.
Example:
Original: 100%. New delivery: 97%. Lab Strength Factor: 0.97

The original quantity is divided into 0.97.

Exception: If the recipe is sent to a laboratory dispenser the concentration is corrected.
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Dye Class Tab

Parameters
Name Unique name of the dye class.

ID Unique identification of the dye class.

AuxID Additional identification of the dye class.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Note Field for additional notes.

Technical Data:

Table with the parameter sequence assigned to all dyestuffs of a colorant set with this 
dye class. The values are to be assigned to the colorant set program. 
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Supplier Dye Name Tab

Parameters
Name Unique supplier dye name, e.g., Terasil, Remazol.

ID Unique identification of the supplier dye name.

AuxID Additional identification of the supplier dye name.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Supplier Unique name of the supplier.

Dye Class Dye class, e.g., Disperse.
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Dyestuff Color Tab

Parameters
Name Unique name of the dyestuff color.

ID Unique identification of the dyestuff color.

AuxID Additional identification of the dyestuff color.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.
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Dyestuff Type (Form) Tab

Parameters
Name Unique name of the dyestuff type, e.g. gran., conc., supra.

ID Unique identification of the dyestuff type.

AuxID Additional identification of the dyestuff type.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.
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Dye Description Tab

Parameters
Name Unique name of the dye description, e.g., Brillant, Dark.

ID Unique identification of the dye description.

AuxID Additional identification of the dye description.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.
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Stock Solution Tab

Parameters
Name Unique name of the stock solution.

ID Unique identification of the stock solution.

AuxID Additional identification of the stock solution.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Description Field for an additional description.

Exhaust/Continuous Input fields for the stock solutions in relation to the amount in 
g. Refer to Specifying A Stock Solution on page 5-36.
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Formula Setting Dialog Box

Parameters
Default Unit Unit for the formula.

Save (button) Saves the current settings.

Close (button) Closes the window. If data is altered, the program requests 
the data be saved.

All other parameters are only used for production.
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Customer Property Sheet
Buttons
Save Saves the displayed customer definition.

Delete Deletes the displayed customer definition after confirmation.

Clear Clears the fields of the currently displayed tab.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Customer Tab

Parameters
Name Unique name of the customer.

ID Unique identification of the customer.

AuxID Additional identification of the customer.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Tolerance Name Unique name of the tolerance definition. Using the context-
sensitive menu, you can open the “Option” input form to 
specify tolerances.

Tolerance Factor Tolerance factor.

Address (button) Opens the “Address” dialog box.
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Address Dialog Box

Parameters
Name Unique name of the customer.

ID Unique identification of the customer.

AuxID Additional identification of the customer.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Address Address of the product supplier.

Address 2 Additional address of the product supplier

City Address: Name of the city.

Zip Code Zip code.

Country Name of the country.

Contact Person Name of the contact person.

Phone Number Phone number of the product supplier.

Fax Number Fax number of the product supplier.

E-Mail E-mail address of the product supplier.

Buttons
Save Saves the displayed address.

Close Closes the window. If data is altered, the program requests 
the data be saved.
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Color Type Property Sheet

Buttons
Save Saves the displayed color type definition.

Delete Deletes the displayed color type definition after confirmation.

Clear Clears the fields of the currently displayed tab.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Parameters of the “Color Type” tab
Name Unique name of the color type.

ID Unique identification of the color type.

AuxID Additional identification of the color type.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Lab Note Additional Notes for the laboratory.

Prod. Note Additional Notes for the production.

Tolerance Name Unique name of the tolerance.

Tolerance Factor Tolerance factor.

White Check it, if the sample is a measurement of a blank substrate 
or an optical brightened sample.
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Tolerance Block Program Dialog Box

General parameters
Name Unique name of the tolerance.

Modification Date of last tolerance.

User ID Identification of creating or modifying user.

Description Text field.

Buttons
Delete Deletes the selected tolerance.

Default Sets the default values in the selected tab.

Save Saves the current tolerance.

Close Closes the dialog box.

Refer the following pages for information about the tabs.
7 - 46 Datacolor MATCHTextile Version 1.0 Datacolor



Tolerance Block Program Dialog Box 7 - Windows and Dialog Boxes
CieLab Tab

Parameters
Table Input values for minimum and maximum tolerances.

Symmetric Tolerances Minimum and maximum values are symmetric.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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CMC Tab

Parameters
Table Input values for minimum and maximum tolerances.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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Datacolor Tab

Parameters
Datacolor Block Training Opens the “Datacolor Tolerance Block” dialog box.

Block Manual Input Opens the “Manual Input of Tolerance Values” dialog box.

Tolerance Values Opens the “Tolerance Values Output” dialog box used for 
information about tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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FMC2 Tab

Parameters
Table Input for tolerance value.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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JPC79 Tab

Parameters
Table Input for tolerance value.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
Datacolor February 2005 7 - 51



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
MS89 Tab

Parameters
Table Input of dE values. The other tolerance values are calculated.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.

Note
The user can only modify the dE values. DH, DC and DL are calculated automatically. 
These values are displayed after saving the tolerance, and closing and opening the dia-
log box.
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Cie 94 Tab

Parameters
Table Input for tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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DIN99 Tab

Parameters
Table Input for tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 5-44.
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Datacolor Tolerance Block Dialog Box

Standard Selection or measurement of the standard.

Batch Selection or measurement of the batch.

Diff. Formula (button) Opens the „Select Difference Formula“ dialog box for the 
selection of the formula.
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Manual Input of Tolerance Values Dialog Box
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Parameter Definition Dialog Box
The parameter values are defined in a colorant set for each dye, and are used to set 
limits for the recipe calculation. Examples: Fastness parameter, operation parameter, 
etc.

Buttons
Formula Setting Opens the “Formula Setting” dialog box for product settings 

used by the production software. Refer to Formula Setting 
Dialog Box on page 7-42.

Save Saves the displayed parameter definition.

Delete Deletes the displayed parameter definition after confirmation.

Clear Clears the fields of the currently displayed tab.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Parameters
Name Unique name of the parameter.

ID Unique identification of the parameter.

AuxID Additional identification of the parameter.

Creation Date Date of creation.

Modification Date of last modification.

User ID Identification of creating or modifying user.

Parameter Type Parameter type:
Value for numeric values
String for a string value
List box for a list box.

Unit Unit. Only used for “Parameter Type Value.”

Text List Text input for a list box.

Note Field for additional notes.
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Combined Processes Browse Window

Browse window for combined processes. Refer to Specifying Combined Processes on 
page 5-61.

Functions of the “Select” menu
Quick Search Opens a dialog box used to search combined processes. 

Refer to Quick Search Dialog Box on page 7-59.

Default Query Selects all combined processes.

User Query Only for advanced database users. Opens the “Query 
Designer.” Refer to the Datacolor Process documentation.

Functions of the “View” menu
Find in ... Value Switches the search bar on and off.

Reset Resets the search bar.

Record Count Displays the number of records in the title bar.

Buttons
New Opens the “Combined Process” window for specifying a new 

combined process. Refer to Specifying, Modifying, Deleting A 
Combined Process on page 5-62.

Open Opens the “Combined Process” window with the selected 
combined process. Refer to Specifying, Modifying, Deleting A 
Combined Process on page 5-62.

Delete Deletes the currently selected combined process after confir-
mation.

Quick Search Opens a dialog box used to search combined processes. 
Refer to Quick Search Dialog Box on page 7-59.

Duplicate Duplicates the currently selected combined process.

Close Closes the window. If data is altered, the program requests 
the data be saved.

Note
Refer to the Datacolor Process documentation for more information.
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Quick Search Dialog Box

Search Type Values: Exact match, Start with, Ends with, Contains, Use 
Wildcards.

Enter your search values
The values can be removed using the button on the left.

Quick Search Column Check to activate table columns for searching.

Note
Refer to the Datacolor Process documentation for more information.
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Table columns
CombProcess_ID Unique identification of the combined process.

CombProcess_AuxID Additional identification of the combined process.

CombProcess_Name Unique name of the combined process.

Context-sensitive menu
Refresh Grid Refreshes the grid.

Select All Selects all displayed combined processes.

Unselect All Deselect all combined processes.

Locate Opens the “Locate” dialog box. Refer to Specifying Com-
bined Processes on page 5-61.

Filter Opens the “Filter” dialog box. Refer to Specifying Combined 
Processes on page 5-61 and to the Datacolor Process docu-
mentation.

Show/Hide Columns Opens the “Selected Fields” dialog box. Using the move 
buttons, you can move the field columns to be displayed to 
the “Selected Fields” and remove the field columns that are 
not to be displayed.

Set Font Opens the “Font” dialog box used to define the font for the 
table.
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Combined Process Window

Only available for users with full access.

Functions of the “Edit” menu
New Prepares the window for specifying a new combined process.

Delete Deletes the currently displayed combined process.

Duplicate Duplicates the currently displayed combined process.

Note
Refer to the Datacolor Process documentation for more information.
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Buttons

Parameters of the “General” tab
ID Unique identification of the combined process.

CombProcess_AuxID Additional identification of the combined process.

CombProcess_Name Unique name of the combined process.

Process Type Displays the process type the combined process is used for.

Dye Process:

Type Type of the dye process.

DyeProcess_ID Unique identification of the dye process.

Dyeprocess_Name Unique name of the dye process.

Fiber Group List of the fiber groups.

Lab Note Additional Notes for the laboratory.

Production Note Additional Notes for the production.

First Jumps to the first combined process of 
the list.

Previous Jumps to the previous combined process.

Next Jumps to the next combined process.

Last Jumps to the last combined process of the 
list.

New Prepares the window for specifying a new 
combined process.

Delete Deletes the currently displayed combined 
process.

Apply Saves the currently displayed data. The 
window is not closed.

OK Saves the currently displayed data and 
the window closes.

Cancel Closes the window without saving.

Note
In the “Lab Note” and “Production Note” fields, a context-sensitive menu is used for 
changing data. The Cut, Copy and Paste functions are used to copy notes from a com-
bined process to others.
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Parameters of the “Treatments” tab

Process Type Process type.

Name Unique process name.

Visible Operations:

Regular The normal operation list is displayed.

Additions The operation list for an addition process is displayed.

Operations:

# Ordinal number.

Name Description of the operation. Default: No operation name.

LabOperation_ID Unique identification of the operation used in the laboratory.

ProdOperation_ID Unique identification of the operation used for production.

If the calculator is highlighted, the operation is based on a 
formula. A double-click on the calculator opens the “Formula 
Edit” window. Refer to Specifying Formulae on page 5-66.

Valid machine group for the treatment:

MachineGroupID Unique identification of the machine group.

MachineGroupName Name of the machine group.
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Context-sensitive menu of the “Operations” table
Open Operation Opens the “Treatment Operation” dialog box. Refer to Speci-

fying, Modifying, Deleting A Combined Process, and Specify-
ing, Modifying, Deleting An Operation on page 5-64.

Edit Operation Count Opens the “Formula Edit” window. Refer to Specifying For-
mulae on page 5-66.

Clear Operation Count Refer to Specifying, Modifying, Deleting An Operation on 
page 5-64.

Context-sensitive menu of the “Machine Group” table
Edit Criteria Opens the “Formula Edit” window. Refer to Specifying For-

mulae on page 5-66.

Delete Criteria Deletes the selected criteria after confirmation.

Parameters of the “Product/Parameters” tab
Product table:

Product_ID Unique identification of the product.

Product_Name Unique name of the product.

Value Numeric value.

Unit_ID Unit.

Parameter table:

Parameter_ID Unique identification of the parameter.

Parameter_Name Unique name of the parameter.

String Value String value.

Value Numeric value.

Parameters of the “References/Settings” tab
Default Prod. Form Data/Default Lab. Form Data

Display of the corresponding data.

Table: Name of the linked form and number of records.

Open (button) Opens the selected form.
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Operations Browse Window

Browse window for operations. Refer to, Browse and Selecting on page 5-2 and Speci-
fying, Modifying, Deleting An Operation on page 5-64.

Functions of the “Select” menu
Quick Search Opens the “Quick Search” dialog box used to search opera-

tions. Quick Search Dialog Box on page 7-59.

Default Query Selects all operations.

Custom Query Only for advanced database users. Opens the “Query 
Designer.” Refer to the Datacolor Process documentation.

Operations used by a given comb. process
Opens the “ITM” dialog box that is used for specifying a 
CombProcess_ID. After clicking OK, the operations found 
are listed.

Operations used by a given Dye lot
Opens the “ITM” dialog box that is used for specifying a Dye 
Lot_ID. After clicking OK, the operations found are listed.

Functions of the “View” menu
Find in ... Value Opens a search bar in the window footer. Click a table col-

umn, specify a search value and hit the tabulator key.

Reset Resets the search bar in the window footer.

Record Count Displays the number of records found.

Buttons
New Opens the “Operation” window used to specify a new opera-

tion. Refer to Specifying, Modifying, Deleting An Operation 
on page 5-64.

Open Opens the “Operation” window with the data of the selected 
operation.

Note
Refer to the Datacolor Process documentation for more information.
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Delete Deletes the selected operation after confirmation.

Quick Search Opens the “Quick Search” dialog box used to search opera-
tions. Quick Search Dialog Box on page 7-59.

Duplicate Duplicates the currently selected operation. Refer to Specify-
ing, Modifying, Deleting An Operation on page 5-64.

Close Closes the “Operation” window.

Table columns
Operation_ID Unique identification of the operation.

Operation_AuxID Additional identification of the operation.

Operation_Name Unique name of the operation.

Lab If checked, the operation is used in the laboratory.

Prod. If checked, the operation is used in production.

Context-sensitive menu
Refresh Grid Refreshes the grid.

Select All Selects all operations of the list.

Unselect All Removes the selections.

Locate Opens the “Locate” dialog box. It is used to search data 
records containing the entered string in the “Field Value” 
field.

Filter Opens the “Filter” dialog box used for defining search filters. 
Refer to Browse and Selecting on page 5-2.

Show/Hide Columns Opens the “Selected Fields” dialog box. Using the move but-
tons, you can move the field columns to be displayed to the 
“Selected Fields” and remove the field columns that are not 
to be displayed.

Set Font Opens the “Font” dialog box used to define the font for the 
table.
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Operation Window

General Parameters
Functions of the “Edit” menu
New Prepares the window for specifying a new operation.

Delete Deletes the currently displayed operation.

Duplicate Duplicates the current operation. This function can be used 
for specifying a new operation with only small differences to 
the current operation.

Buttons

Note
Refer to the Datacolor Process documentation for more information.

First Jumps to the first operation of the list.

Previous Jumps to the previous operation.

Next Jumps to the next operation.

Last Jumps to the last operation of the list.

New Prepares the window for specifying a 
new operation.

Delete Deletes the currently displayed opera-
tion.

Apply Saves the currently displayed data. The 
window is not closed.

OK Saves the currently displayed data and 
the window closes.

Cancel Closes the window without saving after 
confirmation.
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Parameters of the General Tab

ID Unique identification of the operation.

AuxID Additional identification of the operation.

Name Unique name of the operation.

Lab operation If the box is checked the operation is used in the laboratory.

Prod. Operation If the box is checked the operation is used for production.

Note Field for additional notes.

Note
A context-sensitive menu for each input field is used for changing data.
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Table Columns of the “Control Line” Tab

ID Identification of the object.

Name Name of the object.

Value Numeric value. The button opens the “Formula Edit” window. 
Refer to Specifying Formulae on page 5-66.

Unit Unit belonging to the numeric value.

Note
A context-sensitive menu is used for specifying new control lines. Refer to Specifying, 
Modifying, Deleting An Operation on page 5-64.
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Parameters of the References Tab

References Referenced objects.

References count Number of objects.

Open Opens the corresponding Datacolor Process window with the 
referenced objects.
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Formula Edit Window
Refer to Specifying Formulae on page 5-66.

Parameters
Combobox Selection of dye class or product (X axis).

Interpolate on X/Y If checked, the linear interpolation of intermediate values is 
switched on.

Liquor Ratio/Pick Up Selection for the Y axis.

Decision Table: Set the range limits in the X and Y axis. 
Set the absolute values in the corresponding table cells.

Round to Rounds to the entered number of units. 
Example
“Round to” value is 5, unit is kg: The result is calculated in 
steps of 5 kg.

Raise error if result < minimum
If checked and the result is lower than the minimum value, an 
error message appears and the matching is stopped. 
If not checked, the minimum value is set.

Raise error if result > maximum
If checked and the result is higher than the maximum value, 
an error message appears and the matching is stopped.
If not checked, the maximum value is set.
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Context-sensitive menu
Add Row/Column Adds a row/column after the selected one.

Delete Row/Column Deletes the selected row/column.

Build Formula Opens the “Expression Wizard” dialog box used for creating 
formulae.

Sample Input Dialog Box
The “Sample Input” dialog box is used for the manual input of samples based on reflec-
tance values or color coordinates.

General parameters
Name Unique name of the color sample.

Description Additional description of the color sample.

Date Date of the input.

Buttons
Insert/Save Used to insert a new or save an existing sample.

Clear Clears the input fields.

Save As Used to save a modification.

Close Closes the “Color Sample Calculator.” If data is altered, the 
program requests the data be saved.

Data Information Input Specular

Reflectance Manual Included

Transmission Instrumental Excluded
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Spectral Tab

Parameters
Data Input
First Wavelength Starting wavelength for data input.

Last Wavelength Ending wavelength for data input.

Wavelength Interval Wavelength steps for data input.

Spectral Data Length Number of values.

Graph
Graphical view of the result.

Context-sensitive Menu

Reset Resets the last manual data entry.

Change Color Opens the “Color” window twice to define the colors of the 
graph. The first definition is for the background, the second 
for the lines.

With Origin If checked, the current graph is displayed with the coordinate 
zero point.

Grid If checked, a grid is displayed.

Fonts Opens the “Font” dialog box used to define the font for the 
graph.

Points If checked, the interval points are displayed.

Log View Logarithmic view.
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More Opens the “Options” dialog box that allows changes to the 
graph display.

Visible Curves - Manual Data Entry
If checked, it is possible to alter the values in the table or the 
points of the curve manually. If finished, click “Calculate” to 
recalculate the curve.

Table
The results of the calculation are displayed.

Checksum Summary of all values.

+ Delta R Clicking the + button adds positive or negative values to the 
fields.
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Coordinates Tab

Parameters
Used for specifying recipes manually:

Type XYZ: 
xyZ 
CIE Lab
CIE LCH

Coordinates Coordinate values. The result depends on type selection.

Illuminant Name of the illuminant.

Color Color display.
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Colorant Set List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools“ menu. Refer to 
Browse and Selecting on page 5-2.

ColorantSet_Name Unique colorant set name. 

SUBSTRATEDELIVERY_NAME
Unique substrate delivery name.

CREATIONDATE Date of creation.

A mouse double-click opens the “Colorant Set” tab of the “Colorant Set” window (Refer 
to Specifying Colorant Sets on page 5-47).

Functions of the “Colorant Set” and the context-sensitive menu
New Opens the Colorant Set” window to specify a new colorant 

set of the selected type (submenu): Textile / Textile, alter-
nate substrate / Textile Printing with Dyes (Refer to Speci-
fying Colorant Sets on page 5-47.) /
Fiber Mixing. (If option „Datacolor BLEND“ is installed. Refer 
to Datacolor BLEND (Option) on page 5-134.

Copy Opens the Colorant Set” window with a copy of the selected 
colorant set.

Edit Opens the Colorant Set” window with the selected colorant 
set.

Show Displays a print preview of the header or the complete colo-
rant set (submenu).

Rename Used to rename the currently selected colorant set.

Delete Used to delete the currently selected colorant set.

Filter Refer to Browse Filters on page 4-8.

Reset Filter Refer to Browse Filters on page 4-8.

Users Browser Definition Refer to Browser Customizing on page 4-6.
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Colorant Set Window

Color codes of the fields
Green Values that can be modified.

Select the field and press the space bar.
Blue Values calculated while opening the window.

Pale yellow Values that cannot be modified.

Red * Mandatory fields.

Buttons
Show and Print Prints the complete set of data. The print-out is based on a 

print form.

Auxiliary Recipe Saves the current list of auxiliaries. If an auxiliary recipe 
exists, the auxiliaries are added to each new colorant. The 
concentrations may be edited individually.

Calculate

Single The selected colorant is recalculated.

All All colorants of the colorant set are recalculated.

Store Saves the colorant set.

End Closes the window. If data has been changed, a dialog box 
with a save request appears.
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Header Information
Name Unique name of the colorant set.

ID Unique identification of the colorant set.

AuxID Additional identification of the colorant set.

Type Dye process type “Continuous” or “Exhaust“.

Dye Class Dye class, e.g., Disperse.

dE (Sigma) Delta E: color difference (sample - theory) and standard 
deviation dependent to the calibration method.

Unit Unit used for the concentration.

Dye Process Name of the dye process.

Creation Date Date of creation.

Modification Date Date of last modification.

Industry Type Type of the dyeing process.

Substrate Delivery Name of the currently used substrate.

Liq. Ratio or Pickup Liquor ratio or pickup value.

Operation Name of the operation.

Graphical Display
Graphical view of the calibration results: Values and units of the axis are displayed 
according to the selected analysis.

Context-sensitive menus
Reset Resets the “Zoom” and “With Origin” settings.

Change Color Refer to Customizing Graphs on page 4-30.

Change Printer Color Refer to Customizing Graphs on page 4-30.

With Origin If checked, the current graph is displayed with the coordinate 
zero point.

Grid If checked, a grid is displayed.

Fonts Opens the “Font” dialog box used to define the font for the 
graph. Useful for “R% and K/S vs. Wavelength” graph.

Points If checked, the measurement points are displayed.

Log View The graph is based on logarithmic values.

More Refer to Customizing Graphs on page 4-30.

Visible Curves List of all curves. The curves may be selected or the 
selection can be canceled using a mouse click.
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Clicking on a curve:
Select Selects a curve. The measurement points are displayed with 

a greater diameter.

Hide Hides the selected curve.

Do not use this point/Use this point (not used for colorant set program)
The selected point is either used or not used for calibration. 
The point is displayed in a red color if it is not used.

Restore all points Resets all points. Only used for “Reflectance of Calibration 
Samples” and “Absorptions of Calibration Samples“ graphs.

Colorant Table
Product Unique name of the product. The header contains the 

number of listed products.

Created Date and time of creation.

Modified Date and time of the last modification.

dE Delta E: color difference between current samples and the 
theoretical values. 
A red background indicates that there are no selected or 
measured calibration samples.

Min. Conc. Specification of the minimum concentration.

Max Conc. Specification of the maximum concentration.

Interpol. Calibration method: Measured, Smoothed, Automatic.

Monotony Check to set the „monotony“ interpolation.

No_samples_Subs. Number of calibration samples plus substrate.

Strength Product strength in percents.

New (button) Click to add a new product.

Functions of the context-sensitive menu:
R. vs Wavelength Displays the reflectance in relation to the wavelength.

K. vs Wavelength Displays the absorption (K/S) in relation to the wavelength.

K vs Concentration at Maximum Value
Displays the absorption (K/S) in relation to the concentration.

K vs Concentration at Maximum Value
Logarithmically displays the absorption in relation to the dye-
stuff concentration (K/S versus concentration.)

Fix your Wavelength Opens a dialog box used to select the wavelength for the 
following absorptions curves.

Show Tables Displays the numeric tables (K table and S table if the two 
constant method is used.).

Show/Edit Parameters Displays the parameter values.
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KS: Relative Strength Displays the strength in relation to the dye concentration for 
selected dyes (in the “Colorant Set” tab).
= (strength at first calibration sample) * 100 / (strength at cal-
ibration sample)

KS: Absolute Strength Displays (in the “Colorant Set” tab) the absolute strength for 
selected dyes.
Strength is the summary of norm absorptions of the sample.

Add Colorant Opens the „Create Calibration Series“ dialog box. Refer to 
Specifying Colorant Sets on page 5-47.

Move Colorant Refer to Moving Colorants on page 5-51.

Delete Colorant Removes the selected colorant from the colorant set after 
confirmation. Refer to Remove A Dyestuff from A Colorant 
Set on page 5-54.

Compare with another Colorant
Opens the „Compare Colorants“ dialog box. Refer to Com-
paring Colorants on page 5-59.

Use two Graphs Splits and resets the graphical display.

Calibration Series Table
Results of the calibration series. The first column displays the color of each sample.

Sample Unique name of the sample. The header contains the num-
ber of listed samples.

dE Delta E: color difference dependent to the calibration method.

Strength Relative strength in percents.

Do not use If checked, the sample is not used for the calculation.

Context-sensitive menu
Re-measure Calibration Sample

Refer to Calibration and Measurement on page 5-10.

New Calibration Sample Refer to Specifying Colorants and Calibration Samples on 
page 5-50.

Move Calibration Sample Refer to Moving Colorants on page 5-51.

Delete Calibration Sample
Removes a calibration sample from the colorant set.

New (button) Click to add a new calibration sample.
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Components in One Calibration Series (Table)
Product Unique name of the product. The header contains the num-

ber of listed products.

Type Product type.

Concentration Numeric value of the concentration.

Unit Unit used for the concentration.

New (button) Click to add a new product.

Context-sensitive menu
New Calibration Component

Is used to add a product.

Move Calibration Component
Is used to change the order of the products.

Delete Calibration Component
Removes the selected product from the colorant set.
Datacolor February 2005 7 - 81



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
Create Calibration Series Dialog Box
Dialog box for specifying new calibration samples:
Refer to Specifying Colorants and Calibration Samples on page 5-50.

Parameters
Product Selection of the product.

New (button) Opens the „Product“ property box to insert a new product. 
Refer to Specifying A New Product on page 5-35.

Modify (button) Opens the „Product Edition“ dialog box used to modify the 
selected product.
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Fields with a green background can be edited.

Type of Sample Input Selects the source of the samples.

Measure with Input of Concentration Values (Measurements)
Table with the samples to be measured. Concentrations must 
be entered (or corrected) before the measurements. Prefix 
and sample name can be edited.

Used Stored Samples (From database) Selection of samples.

New Calibration’s Series Table with the measured or selected sample(s).

Reset (button) Removes all samples from the „New Calibration’s Series“ 
table.

Accept (button) Accepts all samples from the „New Calibration’s Series“ 
table.
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Alternate Substrate Information Dialog Box

Reference Colorant Set Selection of the existing colorant set used for base of calcula-
tion.

Accept (button) Click Accept if the result is OK. 

Substrate Selection of the new substrate.

Single Input (button Used to select or specify a quality.

Best Product ... Selection of the dyestuff. The best dyestuff is selected auto-
matically.

Sample (button) Used to measure or select the calibration samples. Refer to 
Specifying Colorants and Calibration Samples on page 5-50.

Plots on Graph of the results.

Table Results of the calculation.
7 - 84 Datacolor MATCHTextile Version 1.0 Datacolor



Illuminant List Window 7 - Windows and Dialog Boxes
Illuminant List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Illuminant Name Unique name of the Illuminant.

Observer Name Degree observer. Values: 10 or 2.

Creation Date Date of creation.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Sample List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Name Unique name of the sample.

RGB Color Display of the color.

Sample Id. Unique identification of the sample.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Color Type List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Color Type Name Unique name of the color type.

RGB Color Display of the color.

Color Type Id. Unique identification of the sample.

Name Name of the color Type.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Tolerance List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Name Unique name of the tolerance definition.

Tolerance Id. Unique identification of the tolerance definition.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Parameter List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Parameter Name Unique name of the parameter.

Parameter Id. Unique identification of the parameter.

Param. Unit Related Unit.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Fiber List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Fiber Name Unique name of the fiber.

Fiber Id. Unique identification of the fiber.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Fiber Group List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Fiber Group Name Unique name of the fiber group.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Substrate Delivery List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Substrate Delivery Name Unique name of the delivered substrate.

Substrate Delivery Id Unique Identification of the delivered substrate.

Quality Name Unique name of the quality/style.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Quality/Style List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Quality Name Unique name of the quality/style.

Quality Id. Unique identification of the quality/style.

Affinity Name Unique name of the affinity.

Affinity Id. Unique identification of the affinity.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Affinity List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Affinity Name Unique name of the affinity.

Affinity Id. Unique identification of the affinity.

Fiber Group Name Unique name of the fiber group.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Dye Process List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Dye Process Name Unique name of the dye process.

Dye Process Id. Unique identification of the dye process.

Dye Class Name Unique name of the dye class.

Dye Class Id. Unique identification of the dye class.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Dyestuff Class List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Dyestuff Class Name Unique identification of the dye class.

Dyestuff Class Id. Unique name of the dye class.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Dyestuff List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Product Name Unique name of the product.

Product Id. Unique identification of the product.

Product Supplier Name Unique name of the product supplier.

ACTUAL_PRICE Current price.

ACTUAL_CONC Currently supplied concentration.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Auxiliary List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Product Name Unique name of the product.

Product Id. Unique identification of the product.

Product Supplier Name Unique identification of the product supplier.

ACTUAL_PRICE Current price.

ACTUAL_CONC Currently supplied concentration.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Product List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu.

Product Name Name of the product.

Product ID Unique identification of the product.

Product Supplier Name Name of the product supplier.

ACTUEL_PRICE Actual price of the product.

ACTUAL_CONC Current concentration of the product.

Modification Date Country of the contact person.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Supplier List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu.

Product Supplier Unique name of the product supplier.

Contact Person Name of the contact person.

Phone Number Phone Number of the contact person.

Fax Number Fax Number of the contact person.

Address Address of the contact person.

City City of the contact person.

Country Country of the contact person.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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Customer List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Specifying, Modifying or Deleting Customers on page 5-39.

Customer Name Unique name of the customer.

Contact Person Name of the contact person.

Phone Number Phone Number of the contact person.

Fax Number Fax Number of the contact person.

Address Address of the contact person.

City City of the contact person.

Country Country of the contact person.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.

Recipe List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Recipe Name Recipe name.

Recipe Id. Unique identification of the recipe.

Batch Id. Unique identification of the batch.

Status Recipe status. Values:
-1 Recipe Manual Input in Datacolor Pro-
cess
1 Ready for calculation
2 No solution
4 Calculated
5 Manually modified or inserted
6 Modified by dyestuff exchange

Modification Date Date of last modification.

Quality Name Quality/style name.

Combined Process Name Unique identification of the combined process.

Functions of the “Recipe” and the context-sensitive menu
History Displays the history of recipe generation and corrections.

Match Opens the “Match” dialog box.
Refer to Match Dialog Box on page 7-116.

Match in Background Used if several standards are defined for calculation. (Is only 
enabled if there are recipes of status 2.)

ReMatch Re-calculation of a recipe.
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Pass Fail and Laboratory Correction
Opens the “Correct or Approve Your Recipe” dialog box. 
Refer to Laboratory Correction on page 5-92.

Pass Fail and Production Correction
Opens the “Production Correction” dialog box. Refer to Pro-
duction Correction on page 5-96.

Fast Correction Opens the “Fast Correction” dialog box. Refer to Fast Correc-
tion on page 5-99.

Search Recipes Opens the “Search and Correct” dialog box used for search-
ing recipes. Refer to Search and Correct An Existing Recipe 
for A New Standard on page 5-103.

Search Results Lists the current result list.

Lab Table Display Displays the matching results of the selected recipe.

Lab Dye Lot Opens the “Show Full Recipe” dialog box used for displaying, 
printing, and dispensing recipe data.

Edit Opens the “Edit Recipe” dialog box for altering color type and 
combined process of a recipe. Refer to Modifying Recipes on 
page 5-79.

Recipe List Prints the recipe list of all selected recipes.

Change Dyestuff in Recipes
Opens the “Change one Product in Recipe” dialog box used 
for changing the product. Refer to Replace Dyestuffs in Reci-
pes on page 5-82.

User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 
to Browser Customizing on page 4-6.

Rename Used to rename a selected recipe.

Delete Deletes the selected recipe after confirmation.

Filter Refer to Browse Filters on page 4-8.

Reset Filter Resets the selected filter.
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Combined Process List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the menu “Tools.” Refer to 
Browser Customizing on page 4-6.

Combined Process Name Unique name of the combined process.

Combined Process Id. Unique identification of the combined process.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to “Functions of the “Basic Data” Menu on page 7-10“.

Operation List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the menu “Tools.” Refer to 
Browser Customizing on page 4-6.

Operation Name Operation name. A mouse double-click opens the “Opera-
tion” window. Refer to Specifying Combined Processes on 
page 5-61.

Operation Id. Unique identification of the operation.

Modification Date Date of last modification.

Functions of the “Basic Data” and the context-sensitive menu
Refer to Functions of the “Basic Data” Menu on page 7-10.
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SmartMatch Result List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

SM Result AK Identification of the SmartMatch point.

DE__KS Color difference dependent to the calibration method.

DE_SM Color difference of the recalculated SmartMatch point.

Modification Date Date of last modification.

Quality Name Unique name of the quality/style.

List Products Name List of dyestuffs used for the SmartMatch point.

Colorant Set Name Unique name of the colorant set.

Functions of the “Smart” and the context-sensitive menu
Open Population by SM ID

Opens the „Open population for given ID“ dialog box. Type 
the ID and click OK to open the „Current Population“ dialog 
box. Refer to Current Population Dialog Box on page 7-125.

Show Population of Marked SmartMatch Point
Opens the „Current Population“ dialog box. Refer to Current 
Population Dialog Box on page 7-125. If a group is selected, 
a message appears with the group ID. You can open the 
group using the „Open Population by SM-Id“ function and this 
ID.

Release Points from Group
The group of SmartMatch points is removed and the single 
points are saved. Refer to Release SmartMatch Points from 
the Group on page 5-88.

Automatic SmartMatch Housekeeping
Refer to Automatic SmartMatch Maintenance on page 5-86.

Save Batch as Sample Opens a dialog box to save a sample using a SmartMatch 
point or group. Refer to Saving A Batch as A Sample on page 
5-89.

User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 
to Browser Customizing on page 4-6.

Rename Used to rename a selected recipe.

Delete Deletes the selected recipe after confirmation.

Filter Refer to Browse Filters on page 4-8.

Reset Filter Resets the selected filter.
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Correct or Approve Your Recipe Dialog Box

Parameters
Name Name of the selected recipe.

Trial Selection of the trial to be corrected or approved.

Table: List of products and concentrations used for the recipe.

Information table: Color differences of the batches.

Buttons
Pass Fail and Correction Opens the “Laboratory Correction” dialog box used for labo-

ratory corrections.

Approve Approves the selected recipe.
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Laboratory Correction Dialog Box

Parameters
General parameters
Trial Number Trial number of the selected recipe.

Standard Measured color to be dyed (target color).

Buttons
Approve Approves the selected recipe (trial).

Save Saves manually entered modifications. 

Laboratory Opens the “Recipe Correction” dialog box.

Reset Batch Resets the batch data.

Datacolor Tools Opens the “Datacolor Tools” application for color quality con-
trol. Standard and batch are transferred automatically from 
the Datacolor MATCHTextile database to the Datacolor Tools 
database.

Evaluate Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.
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Parameters of the „Colorant Set“ tab
Colorant set Protected. A „Colorant set“ tab is displayed for each colorant 

set. The colorant set name and the part of the corresponding 
fibre (in %) are displayed on the top.

Batch and ... Selection of the measured sample dyed according to the rec-
ipe to be corrected.

Information line: Differences (dE and dL) between standard, batch, and “Dif. 
Formula”.
On the left, a graphical view of the differences is displayed.
If the differences are out of tolerance, the message „Batch 
refused“ appears and the traffic light is red.

SM Analysis SmartMatch analysis (graphical display and SmartMatch 
result table). Color differences (standard/batch) according to 
the formula used for recipe calculation.

Total batch Check the box if the batch is measured with all fibres.

Table: Selection of dyes. Refer to Preliminary Work on page 5-69, 
section Selecting dyestuffs for matching on page 5-71.

Settings tab
The settings cannot be modified.

Note
Minimum and maximum concentrations can be changed for the correction. This can 
result in better corrections if more then 4 or 5 colorants are used by the recipe.
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Laboratory Correction Table

Table columns
Dyestuff Used dyestuffs.

SmartMatch Recipe corrected using the SmartMatch algorithm.

Additive Recipe corrected using the additive algorithm:
standard conc. + original conc. - batch conc.

Multiply Recipe corrected using the multiplicative algorithm:
standard conc. * performance factor

Performance Relation between batch and original data.

Batch Data of the measured sample dyed according to the recipe to 
be corrected. (Recalculated batch recipe)

Standard Data of the measured sample (color type) to be dyed (target 
color). (Recalculated recipe for the standard)

Original Pass Fail: Differences to the original recipe (from the data-
base).

Refer to Matching on page 5-74, section Review (recipe table) on page 5-76 for more 
information about the parameters.

Note
The re-calculation of the recipe for the standard is always done without SmartMatch. If 
the original recipe has been calculated using SmartMatch, it is different to the standard 
recipe.
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Functions of the „Correct“ and the context-sensitive menu
Evaluate Print Displays the colorimetric data in a print preview.

Evaluate ASCII Creates a text file using a specified form. Refer to ASCII Out-
put (Option) on page 4-20.

Theoretical reflectance Opens the „Insert a Theoretical Sample“ dialog box.

Refer to Insert A Theoretical Sample Dialog Box on page 7-
123.

View configuration Opens the „View Configuration“ dialog box. Refer to View 
Configuration Dialog Box (Laboratory Correction Table) on 
page 7-100.

Modify Used for changing recipe manually.

Round Rounds the results according to the specification in the 
„View“ tab of the „options“ dialog box.

Modify Graphical Opens the „Manual Lab Correction“ dialog box. Refer to Man-
ual Graphical Correction on page 5-101.
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View Configuration Dialog Box (Laboratory Correction Table)
Used to configure the laboratory correction table.
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Production Correction Dialog Box

General parameters
Standard Measured color to be dyed (target color).

Buttons
Production Used for calculating the recipe to correct the dyed 

production. Opens the “Production Correction” dialog box.

Reset Batch Resets the batch data to original data if modified manually.

Match Batch The application assumes that exactly the calculated recipe 
has been used to dye the batch. A correction therefore only 
makes sense if the color difference is not too large (dE ≤ 5.).
If the color difference is larger, something has gone wrong 
during dyeing. In this case, the “Match Batch” calculates a 
new recipe using the dyestuffs of the original recipe. The new 
recipe becomes the base for correction and no SmartMatch 
point is saved.

Match Standard Calculates a new recipe for the standard.

Datacolor Tools Opens the “Datacolor Tools” application for color quality con-
trol. Standard and batch are transferred automatically from 
the Datacolor MATCHTextile database to the Datacolor Tools 
desktop.

Evaluate Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.
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Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.

Parameters of the „Colorant Set“ tab
Colorant Set Protected. A „Colorant Set“ tab is displayed for each colo-

rant set. The colorant set name and the part of the corre-
sponding fibre (in %) are displayed on the top.

Batch and ... Selection of the measured sample dyed according to the rec-
ipe to be corrected.

Information line: Differences (dE and dL) between standard, batch, and “Dif. 
Formula”.
On the left, a graphical view of the differences is displayed.
If the differences are out of tolerance, the message „Batch 
refused“ appears and the traffic light is red.

First Correction Check the box if it is the first correction of the recipe and a 
SmartMatch point should be saved.

Total Batch Check the box if the batch is measured with all fibres.

Table: Selection of dyes. Refer to Preliminary Work on page 5-69, 
section Selecting dyestuffs for matching on page 5-71.

Lab Graph tab
Refer to Lab Graph Tab on page 7-119.

Settings tab
Refer to Match Dialog Box on page 7-116, section Parameters on page 7-120.
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Production Correction Table

Standard Measured color to be dyed (target color).

Batch Measured sample dyed according to the recipe to be 
corrected.

SmartMatch in Production:

Used to save a production SmartMatch point.

Total Batch Check the box if the batch is measured with all fibres.

First Dyeing Check the box if it is the first correction of the recipe and a 
SmartMatch point should be saved. This function is only 
enabled if checked.

Fibre tab
Add New Dyestuff(s)

User selected Selection of unused dyestuffs (of the same colorant set) to be 
added.

Best Add Evaluates and adds the best dyestuff according to the 
colorimetric results.

Best Positive Add Evaluates and adds the best dyestuff to correct negative 
amounts. This function is only available if the recipe is 
calculated with additional illuminants and the initial result has 
negative add amounts.

Reset Removes the added dyestuffs.

Recipe table:

1st column Color display.
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Dyestuff Names of the dyestuffs.

Recipe Values of the original recipe. (Absolute amount of dye lot)

+ Amount Values of the correction.

Effect Effect factor for the recipe calculation (performance between 
original and batch recipe).

Rel. % Relative correction for the single dyestuff (Addition in %).

New Recipe Values of the new, corrected recipe (without additions). A 
print out is not possible.

Batch Size, Bath, Liquor Ration
If you have altered a value, press the Tab key to 
recalculate the correction.

Use Pickup For continuous dyeing. If it is checked, the entered pickup 
value is taken into account. “Amount” and “+ Amount” are 
adjusted.

The table and the graph show the colorimetric data.

Evaluate (buttons) Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

User Add (scale back by) Used to reduce the “+ Amount” by value in %.

Computer Add: Used for absolute tolerance specification.

Optimal dE Optimizes dE only with positive adds. Removes all negative 
adds.

Min. Add. / dE (button) Recalculates the correction using the dE limit given in the 
“Compute To Limit” field. dE must be higher than the dE limit.

Min. Add. / dH (button) Recalculates the correction using the dH limit given in the 
“Compute To Limit” field.

Buttons
Cancel Closes the dialog box without saving. Data that not has 

been saved will lost.
Show Opens a print preview.

Print Prints the correction data.

ASCII Export Saves the correction data to a file in the ASCII format. Refer 
to ASCII Output (Option) on page 4-20.

Close Closes the “Production Correction” dialog box.
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Fast Correction Recipe Input Dialog Box
General parameters
Standard Selected color to be dyed (target color).

Buttons
Save Saves the correction data.

Laboratory Used for recalculating the recipe. Opens the “Recipe 
Correction” dialog box.

Production Used for calculating the recipe to correct the dyed 
production. Opens the “Production Correction” dialog box.

Match Batch The application assumes that exactly the calculated recipe 
has been used to dye the batch. A correction therefore only 
makes sense if the color difference is not too large (dE ≤ 5).
If the color difference is larger, something has gone wrong 
during dyeing. In this case, the “Match Batch” calculates a 
new recipe using the dyestuffs of the original recipe. The new 
recipe becomes the base for correction and a SmartMatch 
point is not saved.

Match Standard Calculates a new recipe for the standard.

Datacolor Tools Opens the “Datacolor Tools” application for color quality con-
trol. Standard and batch are transferred automatically from 
the Datacolor MATCHTextile database to the Datacolor Tools 
database.

Evaluate Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.
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Process Data for Matching tab

Parameters
Quality/Style Field for quality/style specification.

Combined Process Field for combined process specification.

Affinity Protected. Display of the affinity.

Substrate Delivery Selection of a specific substrate delivery.
New button: Used to measure a new substrate delivery.

Possible Colorant Set(s) Selection table with the assigned colorant sets.
Select a colorant set using a double-click on the name cell.

Used Colorant Set(s) Table with the selected colorant sets.
Remove a colorant set using a double-click on the name cell.

Standard Selection of color to be dyed (target color).
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Colorant Set tab

Colorant Set Protected. A „Colorant Set“ tab is displayed for each colo-
rant set. The colorant set name and the part of the corre-
sponding fibre (in %) are displayed on the top.

Part Buttons: Selection of the colorant set to be displayed (only used with 
multiple qualities).

Batch Size: If “Amount Input” is checked, the absolute amount of concen-
tration is entered.

Batch and ... Selection of the measured sample dyed according to the 
recipe to be corrected.

Information line: Differences (dE and dL) between standard, batch, and “Dif. 
Formula”.
On the left, a graphical view of the differences is displayed.
If the differences are out of tolerance, the message „Batch 
refused“ is displayed and the traffic light is red.

SM Analysis SmartMatch analysis (graphical display and SmartMatch 
result table). Color differences (standard/batch) according to 
the formula used for recipe calculation.

Total batch Check the box if the batch is measured with all fibres.

SM Insert If checked, the fast correction is used to enter SmartMatch 
points manually. Only the SmartMatch point is saved 
using the Save button.

Note
If you only save SmartMatch points, it is not necessary to select the standard. Smart-
Match points are independent to the standard. They depend to the quality, the substrate 
delivery and the colorant set.
Datacolor February 2005 7 - 107



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
SmartMatch Point Selection of laboratory or production for the SmartMatch 
point insertion.

Table: Dyestuffs selection and concentration input.

Lab Graph tab
Refer to Lab Graph Tab on page 7-119.

Settings tab
Refer to Match Dialog Box on page 7-116, section Parameters on page 7-120.

Note
If you do not check „SM insert“ the recipe and the SmartMatch point can be saved using 
the Save button. The recipe can be used for the „Recipe Search and Correct“ function 
then.
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Search and Correct Dialog Box
Used for searching for existing recipes that are based on a batch that has a small color 
difference to a newly measured standard.

Standard Select the new standard.

Affinity, Quality/Style, Customer, Tolerance
Selection criteria.

dE to Search Upper limit for dE.

Search (button) Searches for recipes. If recipes are found, they are listed in 
the „Search Results“ dialog box. Refer to Search Results 
Dialog Box on page 7-110.
Recipes without SmartMatch information appear in the 
corresponding box. They cannot be used to calculate a new 
recipe.
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Search Results Dialog Box
List of recipes that can be used for the new calculation.

Select the basic recipe and in the context-sensitive menu ...
• Correct and Save Calculates a new recipe based on the selected recipe 

and saves it for the new standard.
or
• Save as new recipe Saves the selected recipe for the new standard.
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Unit Dialog Box

Parameters
Check boxes: Defines use and placement of the unit.

Price Factor Factor for price adjustment to the price of the default unit.
Default units: m, kg, l

MetricSysCnvFactor Factor for conversion to the metric system.

Printed Decimals Only used by Datacolor Process production software. Num-
ber of decimal digits to be printed.

Decimal Precision Only used by Datacolor Process production software. Num-
ber of decimal digits used for calculations.

Base Unit Type Relative, Weight, Length, Volume, Other, Time.

Result Unit Absolute unit ID for relative units.

Factor Unit Nominator unit for composed units (g/l).

Denominator Unit Denominator unit for composed units (g/l).

Buttons
Save Saves the currently displayed unit.

Delete Deletes the currently displayed unit after confirmation.

Clear Clears the fields of the dialog box.

Close Closes the “Unit” dialog box. If data is altered, the program 
requests the data be saved.

Note
Result Unit, Factor Unit and Denominator Unit can only be selected for the Base Unit 
Type „Relative“,
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Options Dialog Box
The “Options” dialog box is used for defining views, connecting dispensers, enabling 
the use of stock solutions, defining laboratory units and printing definitions for the recipe 
tables.

General button
Close Closes the “Options” dialog box. If data is altered, the 

program requests the data be saved.

View Tab

Parameters
Check boxes If checked the related data will be displayed.

Rounding precision (significant digits)
The rounding function of recipe and the laboratory correction 
tables rounds to the number of the significant digits.

Small color background in spectral graphic
The color spectrum is displayed to the bottom of the graph 
box.

Small color background in spectral graphic
The color spectrum is displayed as background of the graph 
box.

Buttons
Save Saves the current selection.

Default: “ID” „Aux ID, “Combined Process”, and „Grid Column Titles in Bold“ are 
checked.

Note
„Grid Column Titles in Bold“ must be checked for the Chinese and Japanese versions of 
Datacolor MATCHTextile.
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Dispenser Tab

Parameters
Name Dispenser name.

Type Dispenser type:
„Autolab“ creates an ASCII output file.
„DS-5“ creates an ASCII output file (DS5 format).
„AutoLab Database“ writes recipe data for AutoLab dispenser 
systems to the DCI_ALHB.DB Sybase database.

File Path to the dispenser folder and input of a file name.

Disp. Water If checked, the dispenser dispenses water.

Chemicals If checked, the dispenser dispenses chemicals.

Used Here if checked, the corresponding dispenser obtains the data of 
the recipes to be dispensed from the workstation.

Buttons
Add Adds a new dispenser.

Remove Removes the selected dispenser from the table.

Save Saves the current settings.
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Stock Solution Tab

Use Stock Solution here If checked, the selected stock solutions are used for this 
workstation. It is possible to specify different stock 
solutions for each workstation.

Check Volume If checked, the program checks that the final volume is not 
exceeded by the volumes of the components.

Default Stock Solutions for Dyestuffs
Selection of stock solution for dyestuffs.

Default Stock Solutions for Auxiliaries
Selection of stock solution for auxiliaries.
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Unit Selection Tab

Selection of weight and volume unit for laboratory data.

Laboratory Price Calculation
Weight and bath volume for cost calculation of a laboratory 
dye lot.

Print Tab

Selection of portrait or landscape format for the recipe table printouts. 

Save The current selection is saved for further use. Otherwise, the 
selection will only be valid for the current session.
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Match Dialog Box
General parameters
Standard Color to be matched. A standard can be selected or 

re-measured.

General buttons and fields

Process Data for Matching Tab

Parameters
Quality/Style Field for quality/style specification.

Combined Process Field for combined process specification.

Affinity Protected. Display of the assigned affinity.

Substrate delivery Selection of a specific substrate delivery. The latest substrate 
delivery is selected per default.
New Button: Opens the „Substrate Delivery Dialog“ box for 

NOte

Note
• If the „Fixed“ parameter is used, and the recipe is saved before the calculation, 

the dyestuff concentrations will be used as default values and can be altered. 
A correction is possible.

• If the „Fixed“ parameter is used and the recipe is calculated without saving, the 
specified dyestuff concentrations are constant values and cannot be changed. 
A correction is restricted or impossible.
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measuring a new substrate delivery. Refer to Substrate Deliv-
ery Dialog Box on page 7-27, Substrate Delivery: Example 
on page 5-30 and Overwriting Measurements of Substrate 
Deliveries on page 5-32.

Possible/Used Colorant (Dye) Set
In the „Possible Colorant Set(s)“ table, the selection of possi-
ble colorant sets is displayed. A mouse double-click moves it 
to the „Used Colorant Set“ table. You can modify the percent-
age of the fibers, the process factor and the substrate effect.

Tolerance If a tolerance formula is used, it is displayed above the Stan-
dard selection (only if a tolerance is assigned to the color 
type).

Dyed Substrate Used to calculate a re-dye. A dye substrate can be selected 
or re-measured.

Multi Color Matching If checked, different recipes using different dye processes 
are calculated simultaneously. Used to calculate recipes with 
different standards for each fiber of a blended quality/style.
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Colorant Set Tab

Parameters
Colorant Set Protected. Currently selected colorant set.

Part Used for multiple color matching. The buttons are used to 
switch between the colorant sets.

Group Selection or definition of dyestuff groups (or fiber product 
groups for Datacolor BLEND). The Save button saves the 
group with all settings of the „Selection“ table. The Delete 
button deletes a group with all settings.
Refer to Calculation of A New Recipe Series on page 5-69.

Table for dye selection. Refer to Selecting dyestuffs for matching on page 5-71.
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Lab Graph Tab
The „Lab Graph“ tab is used to check that a recipe can be calculated with the selected 
dyestuffs.

Graph
The graph may be rotated by pressing down the left mouse button and can be zoomed 
using the right mouse button.

The standard is displayed as a sphere on the top of a line. The dyestuff selection is 
OK if the standard sphere is completely inside the color space.
1 Check the possible dyestuff selections by rotating the color space. The standard 

sphere must not leave the color space at any position of the color space.

Parameters
Take all/None Using this check box, you can select or deselect all dyestuffs.

The single dyestuffs are selected or deselected with a mouse 
click.

Group Selection or definition of dyestuff groups.

Note
The graphical view cannot check the quality of a recipe.

Note
• If a selection is not OK, you can change the selection of dyestuffs.
• If a recipe is not possible, you must add dyestuffs or use (specify) another colo-

rant set.
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Settings Tab

Parameters
The parameter selection is altered according to “Optimize using.” 

User’s Settings Selection or definition of the settings. Individual settings may 
be saved for each user. The Save button saves all settings. 
The Delete button deletes the settings.

Predefined Settings A mouse click on the corresponding button sets the pre-
defined values.

Additional Illuminants Number of additional illuminants to be used for recipe calcu-
lation multiple illuminant match. Maximum value is 3. 

Calculate All Combinations ...
Range of dyestuffs that can be used for a single recipe.

No. off Solutions ... Maximum of solutions to be displayed with the defined maxi-
mum of dE. Up to this number, the recipes are displayed after 
calculation.

Accept ... Recipes are accepted if dE and dM are better than the speci-
fied values.

Stop ... If a recipe has values better than defined, the calculation is 
stopped and the results are displayed.

Selection Precision Most precise calculation.
Turbo Recommended for big colorant sets. Other

pre-selection is used.
Both methods calculate recipes with the same precision. 
With „Turbo“ you may not get all possible combinations.
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Tolerance Formula The tolerance formula is selected automatically.

Illuminants Using these buttons illuminants, may be selected or dese-
lected.

Matching Technology Selection of “Normal Match” (no SmartMatch), “Lab Smart-
Match” (SmartMatch points of location laboratory are used), 
and “Prod. SmartMatch” (SmartMatch points of location 
production are used).

Weight dH Weighting of hue. You can change the weight of dH. 
Value range is 0.2 to 5.
5 = highest weight of dH
0.2 = lowest weight of dH
The use of this parameter only make sense if additional 
illuminants are selected.

SmartMatch Factor in % Value: 100 %. New method for matching with one Smart-
Match point. The value is set automatically. 
Value: 0 %. The additive correction is used.

Recipe Calculation Result Table

Column for weighting the colorimetric values and the price

Recipe Information

Calculated Values
Colorimetric values 
and prices)

Row(s) for user-defined selection marks

Information about dyestuff
concentrations used for
the recipes

Color Display

Color Inconstancy
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The following help functions for review are implemented:
• „Table“ menu and context-sensitive menu:

• Evaluate Print / ASCII Prints colorimetric details using a predefined form.

• Theoretical reflectance
Opens the „Insert a Theoretical Sample“ dialog box 
used for saving theoretical reflectance values (E.g., for 
Datacolor Envision). Datacolor Tools can send this 
data to a user with a Datacolor Envision system to 
check the color, for example. Refer to Specifying The-
oretical Reflectance Values on page 5-96.

• View Configuration Opens the “View Configurations” dialog box used to 
define the display of the calculated values and the 
number of decimal places for colorimetric and concen-
tration data.

• Reset Sort Order Resets the sort order of the recipes.

• Add Trial Up to five recipes can be marked. After closing the 
table, the selected recipes are saved for further 
use.

• Remove Last Trial Removes the last trial mark.

• Hide recipes not selected
The recipe table only shows the selected recipes.

• Show all recipes Shows all recipes.

• Mail Table Opens the mail form with an attached screen shot of 
the recipe table (JPEG format).

• Modify Refer to Manual Recipe Modification (Recipe Table) on 
page 5-81.

• Round Refer to Round the Dyestuff Concentration (Recipe 
Table) on page 5-81.

• Manually Change Refer to Manual Graphical Correction on page 5-101.

• Pressing the Ctrl key and clicking in the recipe number field selects the recipes.
• Clicking in a parameter name (first column) in the table with the calculated values 

sorts the recipe table according to the values of the corresponding row.
• Alteration of weighting (only possible for metamerism): If you have altered the 

weighting, you have to close the window and match again.
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Insert A Theoretical Sample Dialog Box

Parameters
Name Selection of the sample. The name of the currently selected 

sample is used as default.

Insert (button) Inserts the theoretical reflectance value into the recipe table.

Graph
Refer to Spectral Tab on page 7-73.
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Recipe Editor Dialog Box
The „Recipe Editor“ dialog box is used to alter recipe parameters. Refer to Modifying 
Recipes on page 5-79.

The recipe is displayed in a tree structure. Data that can be modified is displayed with a 
green background.

Buttons
Expand Expands the tree structure.

Collaps Closes the tree structure.

Undo Cancels the last modifications as long as you have not saved 
the recipe.

Go (manual correction) Refer to Manual Graphical Correction on page 5-101.

Modification Rules for adding and removing dyestuffs:
The dyestuff selection of a recipe can only be altered if ...

• the recipe is approved;
• it is not in use by the laboratory and a modification could influence the laboratory 

correction.
Note
Data that can be modified is displayed with a green background.
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Current Population Dialog Box

Affinity/Quality/Style/Substrate/Process/Machine/(Colorant Set)
These specifications are used to select all SmartMatch points 
of the same dyestuff combination.
You can search for other SmartMatch points by altering the 
values and clicking Evaluate.

Colorimetric Colorimetric values of the selected SmartMatch point (batch).
“Size dE” represents the space used for SmartMatch points 
to be evaluated.

Evaluate Evaluates SmartMatch points for a selected set combination.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.

Location Selection of the type of the SmartMatch point.

Products List of used dyestuffs.
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Operation on Population The program checks the SmartMatch points and indicates 
how many points will be forced to be deleted or merged 
because they are similar to each other.
Grouped: Number of points grouped automatically by the 
program.
Points with Comments: Number of points with comments to 
the detail screen.

Quick Opens the list of SmartMatch points and the graphical 
display.

After Analyses Opens the list of SmartMatch points and the graphical 
display. Points outside the tolerances are deleted and points 
to be merged are automatically merged.

3D in Conc. 3D graph in concentration space. If not checked, the graph 
are in Laboratory space.

Max. Points Displayed Specifies the maximum points to be displayed.

Caution
Points with comments should be checked.
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Population Dialog Box
List and graph of the SmartMatch points used for the housekeeping. Refer to Reviewing 
SmartMatch Points on page 5-87.

Parameters of the SmartMatch points or groups
All columns in the upper table can be ordered by simply clicking the column header.

Mean Values Displays the mean values of dE_K and dE_S.

dE_K CMC 2:1 color differences between the batch and the 
theoretical curve using the Kubelka-Munk theory.

dE_S CMC 2:1 color differences between the batch and the 
theoretical curve using SmartMatch.

L*, a*, b* Coordinates of the batch representing the SmartMatch point.

dL*, da*, db* CIELab color differences of theory (K/S) and batch.

Dyestuff names Concentrations of the SmartMatch point dyes.

Note
dE_S values should always be lower than the corresponding dE_K values. Otherwise, 
the population contains bad points that should be deleted.
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Buttons

Graph
The SmartMatch points are displayed in the graph with different colors: 

• The spike has the color of the batch.
• A gray shaft represents a normal point.
• A blue shaft indicates a grouped point and all points belonging to a group.
• The point you have selected in the upper table is displayed with a yellow shaft.
• A red shaft is displayed if a point is suspect.
The length of the shaft is proportional to the dLab* vector representing the lab distance 
between the theoretical reflectance and the reflectance of the measured batch.

For better identification, all points are numbered, e.g.:

20 Index No. of the SmartMatch point.

[17,4] The 1st number is index no. of the SM point, 
the 2nd number is the number of the group the point belongs 
to.

[-54,1] = A negative index identifies a new group point (not existing in 
the database); it is built when population is opened. It is 
saved after confirmation during closing the SM population 
screen.

With these buttons you can change the radius of the color space 
(color difference CIELab) used to show the SmartMatch points. 
Default value is 32. Selectable are 1, 2, 4, 16, 32 and 250.

This button toggles between DEL, to delete, and INS, to insert, 
the SmartMatch point.
The points are definitively deleted if you close the population.

This button toggles between Lab* and C%.
Lab* = Lab color space and C% = concentration space.

The OK button is used to mark the SmartMatch point if it is 
checked. This SM point is hidden in the SM table but is still dis-
played in the graph. The spike becomes a sphere. The next point 
in the list will be selected for checking.

The All button displays all the points again.
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Table columns on the left of the dialog box
The columns „ind/dE“ and „dE*“ contain the index number and the dE for the CIELab 
space.

The column „ind/CC“ and „dCC“ show the SmartMatch index and the difference in 
concentration space.

All SmartMatch points within the color difference selected for the radius (displayed in 
the dialog title) are colored with different gray shades. Points with the same shade in 
both columns belong together. This shows clearly how much the color difference 
depends to the space you are using to evaluate the points.

Navigation in the graph
• The selected point in the SmartMatch table (click the color patch) is displayed in 

the center of the graph.
• Press down the left mouse button and move the mouse to rotate the graphic. The 

selected SM point (SmartMatch point with the yellow shaft) is the crucial point.
• Press down the right mouse button and move the mouse to zoom in or out.

Note
It is necessary to look at the color differences of both spaces to assess the quality of a 
SmartMatch point.
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Example of A SmartMatch Group Point
The picture shows SmartMatch points that are used to build a group point.

-57,1 Group point built by the program. The negative index 
indicates a new group, the 1 is the number of the group. 

23,1 / 24,1 / 25,1 Points used to build the group.
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Example of Lab and C% Graphical View
The following pictures show the influence of the space (Lab* or concentration). You see 
the same points in both. Only in the concentration space can you see the large differ-
ence between the points 17,4 and -57,1.
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Example of Manually Checked SmartMatch Points
The SmartMatch points 12, 11 and 16 (with a sphere on top) have already been 
checked manually.
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Comments Used for SmartMatch Points

Note
Points with a comment should be checked.

Comments Explanation

Automatic Points with this comment are grouped automatically. The number of 
the group is written to the „Grp“ column (in the example, it is Group 
1). Points are grouped to reduce the number of similar points. Too 
many points may have a negative influence to the matching quality. 
Many statistical calculations are necessary to find the SmartMatch 
points that build a group. The aim is to find „clouds“ of points with 
similar behavior. It is an iterative process, which calculates the aver-
age distance between all points and the smallest distance between 
two points, which are not equal.

The graph shows how the pro-
gram is looking for points, 
which can be used for 
grouping.

The group point is calculated using the information of the points that 
are building the group. A theoretical recipe and reflectance values 
are stored for this new point. Points used for grouping are not 
deleted from the database. If you select the group point, you can 
restore the points used to build the group point.

C[x] All points with „C“ and the same number have similar or equal con-
centrations, but the reflectance values of the batches are different.

Batch[x] All points with „Batch“ and the same number have similar or equal 
reflectance values, but the concentrations are different.

dBat[x] All points with „dBat“ and the same number have similar or equal 
color difference values, but the concentrations are different.
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Example of SmartMatch Points to Be Deleted

The two points 205 and 192 have both the same or similar batch and the same or simi-
lar difference values. You can delete one point, because it makes no sense to have two 
points with almost the same information. You should also delete points with the same 
concentrations C(x) comment.

Import Dialog Box

Parameters
Import File Name Path and name of the file to be imported. Use the „Browse“ 

button for searching and selecting.

Browse (button) Displays the Windows standard „Open“ dialog box.
7 - 134 Datacolor MATCHTextile Version 1.0 Datacolor



Export Dialog Box 7 - Windows and Dialog Boxes
Export Dialog Box

Parameters
Radio buttons Selection of the sample format.

Selected Samples Selection of the color samples to be exported.

File Name Path and name of the export file.

Browse (button) Displays the Windows standard „Save as“ dialog box.
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Form Maintenance Dialog Box

Parameters
Form name Name of the print form.

Application Application.

Section Sub-program.

English Language of the print form.

Version Version of the print form.

Buttons
Export Exports the print form file to the selected location.
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Pager Window

Page View Designer specific Menu Functions
„File“ menu
Import Opens the “Open” dialog box used to import an exported 

print form.

Export Opens the “Form Maintenance” dialog box used to select and 
export print forms.

Delete/Rename Opens the “Form Maintenance” dialog box used for renaming 
and deleting print forms.

Page Setup Opens the “Page Setup” dialog box used for specifying the 
left and the right margin.

„Edit“ menu
Remove all fields from current section

Removes the fields from the selected section.

Hide current section Hides the selected section.

„Sections“ menu
List of the sections that are available for the current print form. Checked sections are 
currently used for the form.

„View“ menu
Toolbar Switches the toolbar on (check mark) and off.

Status Bar Switches the status bar on (check mark) and off.
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Fields Opens the “Fields” information box with the database fields 
used for the selected section.

Properties Opens the “Properties” of the selected field.

Look Opens the “Look” dialog box used for window settings.

„Layout“ menu
Help functions for a correct alignments of fields.

Page View Designer specific Toolbar Functions

1 About Page View Designer version info.
2 Grid, Zoom, Ruler Opens the “Look” dialog box used for window settings.
3 Toggle Fields Opens the “Fields” information box with the database fields 

used for the selected section.
4 Toggle Properties Opens the “Properties” of the selected field.
5 Left Alignment Active if more than one field is selected.
6 Top Alignment Active if more than one field is selected.
7 Right Alignment Active if more than one field is selected.
8 Same Horizontal Size

Active if more than one field is selected.
9 Same Vertical Size Active if more than one field is selected.
10 Text Used to specify a text field.
11 Rectangle Used to draw rectangles.
12 Ellipse Used to draw ellipses.
13 Bitmap Used to enter a picture, e.g., a logo. Supported formats: 

*.bmp, *.pcx, *.jpg.
14 Date/Time Used to enter a field with date and time.
15 Page Number Used to enter a page count field.
16 Form Name Used to enter a field for the form name.
17 Login User Used to insert the Name of the logged in user.
18 Zoom Selection of predefined zoom values.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1817
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Datacolor MONITOR

Batch Series Window
Refer to:
• Adding A Graph Panel on page 5-112
• Printing A Batch Series on page 5-114

Navigation
Left and right cursor keys Navigates from one measurement line (orange vertical solid 

line) to the next or previous. Corresponding to their position, 
the numeric values are displayed with yellow background 
color in the table above. The pieces of fabric are separated in 
the graph panel by a dotted black vertical line. 

Results shown in the table
• One section with the average of all color differences, indicated by µ.

• One section with the standard deviation of all color difference, indicated by σ.
• The next section contains the result for all measurement on one line. This section 

is separated by the name of the piece of fabric.

Symbols describing the relation of the sample pairs used for color difference calculation:
Indicates color difference to a previous measurement, e.g., left to left, center to 
center or right to right.
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Indicates color differences to a neighbor sample, e.g., left to center, center to 
right and right to left.
Indicates color differences to the reference, e.g., left to reference, center to 
reference or right to reference.

You will have nine color difference decisions if you have checked all possible relations.

Create Batch Series Dialog Box
Refer to Printing A Batch Series on page 5-114.

Name Name of the batch series.

Folder Selection of the folder.

Script Selection of the script.

Standard Selection of the Standard.

Batch Name Name of the Batch.

Batches Selection of the batches.

Description Field for a description of the batch series.
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Batch Series Script Name Dialog Box
Refer to Specifying A Script on page 5-106.
Datacolor February 2005 7 - 141



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
Batch Series Type Dialog Box
Refer to Specifying A Script on page 5-106.
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Batch Series Relation Dialog Box
Refer to Specifying A Script on page 5-106.
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Select Current Illuminants Dialog Box
Refer to UV Calibration on page 5-11.
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Datacolor TICKET

Recipe List Window

Functions of the “Select” Menu
Quick Search Opens a dialog box used to specify a search criteria for the 

recipes.

Default Query Selects all recipes.

Recipes with Quality List Adds a column with the query list.

Recipes with a Product in a Given Conc. Range
Opens a dialog box for setting a concentration range for 
searching.

Functions of the “View” Menu
Find in ... Value Switches the search bar on and off.

Reset View Resets the search bar.

Record Count Displays the number of records in the title bar.

Buttons
New Opens the “New Recipe” dialog box for specifying a new 

recipe. Refer to Datacolor TICKET - Production Recipe on 
page 5-115.

Open Opens the “New Recipe” dialog box with the selected recipe. 
Refer to Datacolor TICKET - Production Recipe on page 5-
115.

Delete Deletes the currently selected recipe after confirmation.

Quick Search Opens the dialog box „Quick Search“ dialog box.

Close Closes the window. If data is altered, the program requests 
the data be saved.
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Table columns
RGB Color Display of the color.

Recipe_ID Unique identification of the recipe.

Recipe_Name Name of the recipe.

Recipe_AuxID Additional identification of the recipe.

Recipe Location Recipe type.

Locked Level Red: The recipe must not be used for dye lot generation.

Quality_ID Unique identification of the quality.

CombProcess_ID Unique identification of the combined process.

Affinity_ID Unique identification of the affinity.

Context-sensitive menu
Refresh Grid Refreshes the grid.

Select All Selects all displayed combined processes.

Unselect All Deselect all combined processes.

Locate Opens the “Locate” dialog box.

Filter Opens the “Filter” dialog box.

Show/Hide Columns Opens the “Selected Fields” dialog box. Using the „move“ 
buttons, you can move the field columns to be displayed to 
the “Selected Fields” and remove the field columns that are 
not to be displayed.

Set Font Opens the “Font” dialog box used to define the font for the 
table text.

Find in Select the requested table column and type the search crite-
ria. The pointer jumps to the first line with the corresponding 
data.
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Recipe Window (Datacolor PROCESS)

Functions of the „Recipe“ menu
Correct Is used to modify a recipe and keep a copy of the original rec-

ipe. Refer to Production Correction on page 5-96.

Clear Template All loaded recipe components (using the „Load and Modify 
Template“ button) are to be removed.

Go to Dye Lot Opens the „Dye Lot List“ window with the existing dye lot of 
the selected recipe. Refer to Datacolor TICKET - Dye Lot on 
page 5-117.

New Dye Lot Opens the „New Dye Lot“ dialog box. Refer to Datacolor 
TICKET - Dye Lot on page 5-117.
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Buttons on the top

Parameters
ID Unique identification of the recipe.

AuxID Additional identification of the recipe.

Name Unique name of the recipe.

Color Type Display of the color type.

Quality Selection of the quality.

Affinity Display of the affinity.

CombProcess Selection of the combined process.

Location Selection of the recipe type.

Traffic Light The „traffic light“ may be set to red if the recipe must not be 
used for dye lot generation.

Pass Fail (button) The color difference between the color type and the last 
batch is calculated and displayed.

Dye process table
Displays data of the dye process(es).

Colorant table
Displays data of the colorants used for the recipe. It is possible to modify the recipe.

First Jumps to the first recipe of the list.

Previous Jumps to the recipe process.

Next Jumps to the next recipe.

Last Jumps to the last recipe of the list.

New Prepares the window for specifying a 
new recipe.

Delete Deletes the currently displayed recipe.

Apply Saves the currently displayed data. 
The window is not closed.

OK Saves the currently displayed data 
and the window closes.

Cancel Closes the window without saving.
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Buttons on the footer
Load and Modify Template (or Modify Template)

Opens the „Root Recipe“ dialog box with the list of all 
products with there relative amounts. Refer to Root Recipe 
Dialog Box on page 7-149.

New Dye Lot Opens the „New Dye Lot“ dialog box. Refer to Datacolor 
TICKET - Dye Lot on page 5-117.

Root Recipe Dialog Box

Table columns
Sequence of the use

Product ID

Product name

Relative amount

Unit

Remarks
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Buttons
Append Opens the „Insert“ dialog box, used to insert call offs, dye-

stuffs, products, parameters and notes.

Delete Removes the currently selected table line(s).

OK Saves the currently displayed data, and the dialog box 
closes.

Cancel Closes the dialog box without saving.

Note

• Do not use operate with the dyestuff class as dyestuff placeholder. The color rec-
ipe will thereby be duplicated. When you insert an operation, all items are 
grabbed from the operation and saved in the generated recipe. Recipes are not 
adjusted, if you change the operation. Production recipes created with the Data-
color TICKET are stored with a flat structure. All recipes must be adjusted manu-
ally.

• All items are added to the end of the list. Do not forget to move the products to 
the correct position in the recipe. Use the „Drag and Drop“ method to move items 
to a different position.
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Dye Lots List Window

Menu functions
Refer to the Datacolor Process help (Press F1).

Buttons
New Opens the “New Dye Lot” dialog box for specifying a new dye 

lot. Refer to Datacolor TICKET - Dye Lot on page 5-117.

Modify Opens the „New Dye Lot“ dialog box. Refer to Datacolor 
TICKET - Dye Lot on page 5-117.

Open Opens the “New Recipe” dialog box with the selected recipe. 
Refer to Datacolor TICKET - Dye Lot on page 5-117.

Delete Deletes the currently selected recipe after confirmation.

Quick Search Opens the „Quick Search“ dialog box.

Generate Generates the selected dye lots (only if not generated).

Close Closes the window. If data is altered, the program requests 
the data be saved.

Table columns
Refer to the Datacolor Process help (Press F1).

Find in Select the requested table column and type the search crite-
ria. The pointer jumps to the first line with the corresponding 
data.
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New Dye Lot Dialog Box
Recipe Selection Tab

Refer to the Datacolor Process help (Press F1).
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Machine Selection Tab

Refer to the Datacolor Process help (Press F1).
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Datacolor SORT (Option)

Datacolor SORT List Window
Table columns
The data (table columns) to be displayed and the names of the table columns can be 
altered using the “User’s Browser Definition” function of the “Tools” menu. Refer to 
Browser Customizing on page 4-6.

Sort Job Name Unique name of the sort job.

Sort Script Name Unique name of the sort related script.

Name Name of the standard.

Modification Date Date of last modification.

Description Description of the standard.

Functions of the “Datacolor Sort” and the context-sensitive menu
Refer to Menu Functions of the Sort Job Menu on page 7-155 and for general functions 
of the context-sensitive menu Functions of the “Basic Data” Menu on page 7-10.

Job Result Window
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Menu Functions of the Sort Job Menu
Maintain Sample Property

Refer to Maintain the Sample Property on page 5-131.

Recalculate If you open an existing sort job, the program recalculates the 
job with the settings and batches saved in the job. 

Executing the option „Recalculate“ - the program reads the 
Sort Script again and re-builds the job with all modified set-
tings. If „I want to use a Datacolor Tools Standard“ was acti-
vated in the job, all new batches are added automatically. 
This task is very important, if you build the groups and tapers 
on the basis of fabric length. For example, if some of the fab-
ric rolls have been delivered and the remaining length has 
changed, the job must be recalculated, so that the new 
length is taken into account when new clusters and tapers 
are built.

Options You can select other data to be displayed in the „Job Result“ 
window:

Batch removed You can remove batches from a job, e.g., if the sample (fabric 
roll) is delivered. The sample is grayed out but it is not 
deleted from the job. To re-activate the sample, remove the 
check from the option.

Modify Job Refer to Modifying a SORT job on page 5-125.

Save Job Saves the job.

Save Job As You can specify a copy of an existing job using the function. 
The copy of the job can be used to cluster and taper with new 
conditions without loosing the original data.

Copy This task copies the entire table to the Windows clipboard. 
E.g., this is a simple way to transfer the data to Excel.
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Print Preview Shows the print out in the Job Result table. Refer to Exam-
ples of Printouts on page 7-158.

Print Prints the result without displaying on screen. Refer to Exam-
ples of Printouts on page 7-158.

ASCII Output (optional) Writes the job result to an ASCII file (An ASCII form must 
exist). Refer to ASCII Output (Option) on page 4-20.

Close Sort Job Closes the sort job.
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Details to the Job Result Table

Symbol for cluster

Symbol for taper

Symbol for taper sequence

Symbol for compatible cluster

Symbol for Cluster A, Cluster B etc.

Batch 200205-E3940101-001 is compatible to Cluster F and I
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Examples of Printouts
Use the menu function Sort Job, Print Preview, or Print to show or print the sort result.

Example 1: 
Printout sorted by group and/or taper code
7 - 158 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor SORT (Option) 7 - Windows and Dialog Boxes
Example 2: 
Printout sorted by name (sort order depends on order on result screen)
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Sort Job Maintenance Dialog Box
New Sort Job Wizard Tab

Parameters
Select an existing sort job Selection box with the name of the sort job.

Description Text box for an additional description of the sort job.
7 - 160 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor SORT (Option) 7 - Windows and Dialog Boxes
Script and Filter Tab

Parameters
Sort Script Selection box with the currently used sort job.

Check boxes If you check „I want to use a Datacolor Tools Standard“ only 
Datacolor Tools standards are displayed to select from. The 
batches linked to this standard are listed in the set of 
Batches“ tab. They are already selected if „Automatically 
include new batches“ is checked as well. In this case, it is not 
possible to remove batches from the list. This is only possible 
if „Automatically include new batches“ is not selected.

Standard Selection box with the selected standard.
If you do not select a standard, the program calculates the 
average of all batches and uses this as the theoretical stan-
dard for the pass/fail decision.

Measure Start button for the measurement. Refer to Measurement on 
page 5-20.

Table:
You can set filters to reduce the number of batches that are displayed for selection. A fil-
ter might be a specific folder or any user defined field you have created either with Data-
color Tools or with Datacolor SORT.
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Set of Batches Tab

Selection table for the batches to be used.
7 - 162 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor SORT (Option) 7 - Windows and Dialog Boxes
Tapering Parameters Tab

Parameters
Sort by
Color Samples are sorted by color. All three dimensions are used 

(dL, dC and dH).

dL(xxx) Samples are sorted by dL only.
(xxx) = placeholder for selected Pass/Fail formula 
(1 dimensional).

dC(xxx) Samples are sorted by dC only.
(xxx) = placeholder for selected Pass/Fail formula 
(1 dimensional).

dH(xxx) Samples are sorted by dH only.
(xxx) = placeholder for selected Pass/Fail formula 
(1 dimensional).
Datacolor February 2005 7 - 163



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
dL(xxx) plus dC(xxx) or dH(xxx)
Samples are sorted by dL plus dC or dH.
(xxx) = placeholder for selected Pass/Fail formula 
(2 dimensional).

Start a new taper if distance (xxx) is greater
This tolerance defines the distance between the batches. If 
the distance is above the limit, a new taper starts. If "Color" is 
selected as the sort type, the limit corresponds to a color dif-
ference dE(xxx).
We call the limit a distance because it is not a real color dif-
ference if you select a 2-dimensional sort, e.g. dL plus dC. 
The distance represents in this case:

(xxx) = placeholder for selected Pass/Fail formula

Tapering Method

Next neighbor The program searches for the closest next batch. 

Linear path The program calculates a regression line and tapers the 
batches along this line. 

Minimum path The program calculates the total distance of all batches of a 
taper path using "next neighbor" and "linear path" methods. 
The method with the lower total distance is selected as the 
"Minimum Path". 

Note
The program starts tapering with a batch that has a connection to a compatible cluster. 
This allows a taper to be built across the cluster borders
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View Options Tab

In the „View Options“ tab, you can define what you would like to see in the results win-
dow.
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Output Options Tab

The last wizard page is used to set up the output and to select the coding you would like 
to use for groups (clusters) and tapers. The print output sort order is linked to individual 
print forms. One is used to print the job ordered by Group/Taper code, and the second is 
sorted identically to the order you have displayed in the output screen. You can change 
the order in the output screen by clicking in the table columns.
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Sort Script Maintenance Dialog Box
Script Name Tab

Parameters
Select an existing script Selection box with the name of the sort script.

Description Text box for an additional description of the sort script.
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General Settings Tab

Parameters
Group only The program builds subsets of samples (clusters, groups) 

that pass the pass/fail decision based on the selected for-
mula and tolerance factor.

Taper only The program searches for the best sequence of samples that 
pass the pass/fail decision based on the selected formula 
and tolerance factor.

Group and Taper In the 1st step the program builds subsets of samples (clus-
ters, groups) and in the 2nd step it tapers the samples in 
each cluster.

Tolerance All tolerance formulas can be selected.

Maximum distance[xxx] Batch to Standard
Tolerance factor (scaling factor) used for Pass/Fail. (XXX) is 
a placeholder for the selected formula.

Tapering Parameters Tab
Refer to Tapering Parameters Tab on page 7-163.

Note
M&S89 is optional. If M&S 89 is used you must select one of the M&S illuminants 
(msTL84-10, msD65-10, msA-10). 
No results are displayed if other than ms-illuminants are selected.

Note
This scaling factor modifies the tolerance value set in the tolerance block.
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View Options Tab
Refer to View Options Tab on page 7-165.

Output Options Tab
Refer to Output Options Tab on page 7-166.

Sample Property Dialog Box
Sample Property Tab

Parameters
Standard Standard, the sample is related to.

Batch Batch, the sample is related to.

Property Properties specified for the sample.

Value Value of the selected property.
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Property Tab

Parameters
Property type Selection of the property type.

Name Selection (or input) of the name.

Data type Selection of the data type.

Store to database If checked, the property is stored in the database.

Required If checked, the value must be filled in (mandatory field). 

Database Tools input field If checked, the field is defined as input field in Datacolor 
TOOLS.

Length Length of a field of type „String“.

Precision Defines the number of decimals.

Default Field for setting a default value.

Description Description of the property.
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Sort Job Definition Options Dialog Box
In the sort job definition options dialog box can be specified, which dialog boxes of the 
„Sort Job“ wizard and tabs of the „Sort Job Maintenance“ dialog box are displayed for 
specifying and modifying sort jobs. The invisible tabs are filled with the corresponding 
data of assigned sort script.

Note
If you want to be sure that a user works only with the predefined settings of the sort 
script, you have to limit the access rights, respectively. 

Login as User „DCI’“ and run the option „User Administration“ 
(Menu Tools → User Manager → User Administration). 
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User Field Pre-selection Dialog Box
The „User.fld“ file may contain many fields that cannot be used by Datacolor SORT. This 
task is used to select only relevant user defined fields for Datacolor SORT.

Refer to Pre-Selections of User Defined Fields on page 5-132.
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Datacolor BLEND (Option)

Blend Fiber Set Window

Color codes of the fields
Green Values that can be modified.

Select the field and press the space bar.
Blue Values calculated while opening the window.

Pale yellow Values that cannot be modified.

Red * Mandatory fields.

Buttons
Show and Print Prints the complete set of data. The print-out is based on a 

print form.

Calculate

Single The selected colorant is recalculated.

All All colorants of the colorant set are recalculated.

Store Saves the colorant set.

End Closes the window. If data has been changed, a dialog box 
with a save request appears.
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Header Information
Name Unique name of the fiber set.

ID Unique identification of the fiber set.

Industrie Type Type of the dyeing process. Value: „Fiber Blending“.

Type Process Dye process name.

Method Calibration „Rohner Function“ or „Approximation“.

Param 1 Parameter 1

Param 2 Parameter 2

Creation Date Date of creation.

Modification Date Date of last modification.

dE (Sigma) Delta E: color difference (sample - theory) and standard 
deviation dependent to the calibration method.

Unit Unit used for the concentration.

Graphical Display
Graphical view of the calibration results: Values and units of the axis are displayed 
according to the selected analysis.

Context-sensitive menus
Reset Resets the “Zoom” and “With Origin” settings.

Change Color Refer to Customizing Graphs on page 4-30.

Change Printer Color Refer to Customizing Graphs on page 4-30.

With Origin If checked, the current graph is displayed with the coordinate 
zero point.

Grid If checked, a grid is displayed.

Fonts Opens the “Font” dialog box used to define the font for the 
graph. Useful for “R% and K/S vs. Wavelength” graph.

Points If checked, the measurement points are displayed.

Log View The graph is based on logarithmic values.

More Refer to Customizing Graphs on page 4-30.

Visible Curves List of all curves. The curves may be selected or the 
selection can be canceled using a mouse click.

Clicking on a curve:
Select Selects a curve. The measurement points are displayed with 

a greater diameter.

Hide Hides the selected curve.

Do not use this point/Use this point (not used for colorant set program)
The selected point is either used or not used for calibration. 
The point is displayed in a red color if it is not used.

Restore all points Resets all points. Only used for “Reflectance of Calibration 
Samples” and “Absorptions of Calibration Samples“ graphs.
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Fiber Table
RGB Color display.

Product Unique name of the product. The header contains the 
number of listed products.

Created Date and time of creation.

Modified Date and time of the last modification.

dE Delta E: color difference between current samples and the 
theoretical values. 
A red background indicates that there are no selected or 
measured calibration samples.

Product Type White, Black or Colored.

Min. Conc. Specification of the minimum concentration.

Max Conc. Specification of the maximum concentration.

Strength Product strength in percents.

New (button) Click to add a new fiber.

Calibration Series Table
Results of the calibration series. The first column displays the color of each sample.

RGB Color display.

Sample Unique name of the sample. The header contains the num-
ber of listed samples.

dE Delta E: color difference dependent to the calibration method.

Strength Relative strength in percents.

Do not use If checked, the sample is not used for the calculation.

CNew (button) Click to add a new calibration sample.

Components in One Calibration Series (Table)
Product Unique name of the product. The header contains the num-

ber of listed products.

Type Product type.

Concentration Numeric value of the concentration.

Unit Unit used for the concentration.

New (button) Click to add a new product.
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BLEND Match Dialog Box
General Parameters
Standard Protected. Display of the selected standard.

General Buttons
Save Saves a manually created recipe. Refer to “Fixed” parameter 

in Colorant Set Tab on page 7-118.

Calculate Starts the recipe calculation. Refer to Calculation of A New 
Recipe Series on page 5-69.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.

Process Data for Fiber Matching Tab

Parameters
Available Fiber sets Table with the specified fiber sets.

Used Dye Set Selected fiber set.

Part Part of the selected fiber set. Refer to Recipe Calculation 
with several Fiber Sets on page 5-144.

Current Total [%] Display of the currently used part.

Standard Section of the Standard to be used.
7 - 176 Datacolor MATCHTextile Version 1.0 Datacolor



Datacolor BLEND (Option) 7 - Windows and Dialog Boxes
Dye Set Tab

Parameters
Fiber Set Protected. Selected fiber set.

Batch and Color Difference
Selection of the Batch.

Share / Max. of Share Shows the part (in %) of the current fiber set and the current 
summary (in %) of all selected fiber sets.

Group Selection or definition of dyestuff groups. The Save button 
saves the group with all settings of the „Selection“ table. The 
Delete button deletes a group with all settings.
Refer to Calculation of A New Recipe Series on page 5-69.

Table for fiber selection. Refer to Recipe Calculation with several Fiber Sets on page 
5-144.
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Lab Graphic Tab

Graph
XY-Graph for the standard and all selected fibers. A recipe can be calculated, if the 
standard is inside of all possible triangles that can be drawn between each combination 
of three fibers.

Parameters
FIber Set Protected. Selected Fiber Set.

Take all Check the box if all fibers are to be used.

Group Selection or definition of dyestuff groups. The Save button 
saves the group with all settings of the „Selection“ table. The 
Delete button deletes a group with all settings.
Refer to Calculation of A New Recipe Series on page 5-69.

Box for fiber selection Refer to Recipe Calculation with several Fiber Sets on page 
5-144.

Settings Tab
Refer to Settings Tab on page 7-120.
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BLEND Recipe Calculation Result Table

Refer to Recipe Calculation on page 5-142 and Recipe Correction on page 5-148.

BLEND Correction Dialog Box
General parameters
Standard Protected. Measured fiber blending.

Buttons
Correction Opens the “BLEND Correction Recipe Correction” dialog 

box.

Datacolor Tools Opens the “Datacolor Tools” application for color quality con-
trol. Standard and batch are transferred automatically from 
the Datacolor MATCHTextile database to the Datacolor Tools 
database.

Evaluate Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.
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Dye Set Tab

Parameters
Fiber set Protected. The fiber set name and the part of the corre-

sponding fibre set (in %) are displayed on the top.

Batch and Color Difference
Selection of the measured sample produced according to the 
recipe to be corrected.

Information line: Differences (dE and dL) between standard, batch, and “Dif. 
Formula”.
On the left, a graphical view of the differences is displayed.
If the differences are out of tolerance, the message „Batch 
refused“ appears and the traffic light is red.

Table: Selection of dyes. Refer to Preliminary Work on page 5-69, 
section Selecting dyestuffs for matching on page 5-71.

Lab Graphic Tab
Refer to Lab Graphic Tab on page 7-178.

Settings Tab
Refer to Settings Tab on page 7-120.
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BLEND Correction Recipe Dialog Box
G

Standard Measured fiber blending.

Batch Measured sample produced according to the recipe to be 
corrected.

SmartMatch in Production:

Used to save a production SmartMatch point.

Total Batch Check the box if the batch is measured with all fibres.

First Dyeing Check the box if it is the first correction of the recipe and a 
SmartMatch point should be saved. This function is only 
enabled if checked.

Fibre tab
Recipe table:

1st column Color display.

Dyestuff Names of the fibers.

Recipe Values of the original recipe. (Absolute amount of dye lot)

+ Amount Values of the correction.

Effect Effect factor for the recipe calculation (performance between 
original and batch recipe).

Rel. % Relative correction for the single dyestuff (Addition in %).

Total Batch Size Batch size for the calculated correction.
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New Batch Size Fibers have to be added to correct the color. The batch size 
becomes bigger than the total batch size.
About 50 kg must be added in the example to correct the 
color.

The table and the graph show the colorimetric data.

Evaluate (buttons) Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

User Add (scale back by) Used to reduce the “+ Amount” by value in %.

Computer Add: Used for absolute tolerance specification.

Optimal dE Optimizes dE only with positive adds. Removes all negative 
adds.

Min. Add. / dE (button) Recalculates the correction using the dE limit given in the 
“Compute To Limit” field. dE must be higher than the dE limit.

Min. Add. / dH (button) Recalculates the correction using the dH limit given in the 
“Compute To Limit” field.

Buttons
Cancel Closes the dialog box without saving. Data that not has 

been saved will lost.
Show Opens a print preview.

Print Prints the correction data.

ASCII Export Saves the correction data to a file in the ASCII format. Refer 
to ASCII Output (Option) on page 4-20.

Save Saves the fiber blend recipes.

BLEND Fast Correction Dialog Box
General parameters
Standard Selected color to be dyed (target color).

Buttons
Save Saves the correction data.

Correction Used for recalculating the recipe. Opens the “BLEND Correc-
tion Recipe Dialog Box” dialog box.

Datacolor Tools Opens the “Datacolor Tools” application for color quality con-
trol. Standard and batch are transferred automatically from 
the Datacolor MATCHTextile database to the Datacolor 
TOOLS database.

Evaluate Print: Displays the colorimetric data in a print preview.
ASCII: Creates a text file using a specified form. Refer to 
ASCII Output (Option) on page 4-20.

Cancel Closes the dialog box without saving. Data that not has 
been saved will be lost.
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Process Data for Fiber Matching tab

Parameters
Available Colorant Set Selection table with the assigned fiber sets.

Select fiber sets by checking the box.

Used Fiber Set(s) Table with the selected fiber set.
Remove a fiber set using a double-click on the name cell.

Part Part of the selected fiber set. Refer to Recipe Calculation 
with several Fiber Sets on page 5-144.

Current Total [%] Display of the currently used part.

Standard Section of the Standard to be used.
Datacolor February 2005 7 - 183



Datacolor MATCHTextile User’s Guide 7 - Windows and Dialog Boxes
Colorant Set tab

Fiber Set Protected. A „Fiber Set“ tab is displayed for each colorant 
set. The colorant set name and the part of the corresponding 
fibre (in %) are displayed on the top.

Batch Size: If “Amount Input” is checked, the absolute amount of concen-
tration is entered.

Batch and ... Selection of the measured fiber set sample according to the 
recipe to be corrected.

Information line: Differences (dE and dL) between standard, batch, and “Dif. 
Formula”.
On the left, a graphical view of the differences is displayed.
If the differences are out of tolerance, the message „Batch 
refused“ is displayed and the traffic light is red.

SM Analysis SmartMatch analysis (graphical display and SmartMatch 
result table). Color differences (standard/batch) according to 
the formula used for recipe calculation.

Total batch Check the box if the batch is measured with all fibres.

SmartMatch Point Selection of laboratory or production for the SmartMatch 
point insertion.

Table: Dyestuffs selection and concentration input.

Lab Graph tab
Refer to Lab Graphic Tab on page 7-178.

Settings tab
Refer to Settings Tab on page 7-120.
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Absorption The conversion of light or other electromagnetic radiation into heat energy. This light 
energy cannot be reflected back to an observer. The selective absorption of light is 
responsible for our perception of color.

Affinity The affinity group is an optional field that is used to group qualities with the same dyeing 
properties.

Auxiliary Chemicals to used for dyeing, finishing, etc.

Calibration data Concentrations of dyestuffs and blank dyed Substrate which (when measured with the 
spectrophotometer) become part of the match prediction database in the form of colo-
rant sets.

Calibration
sample

Measured sample dyed with defined concentration and dye strength. The data of cali-
bration samples are used for recipe calculation and correction. Calibration samples are 
used to calculate the calibration data (K/S) for each dyestuff used for recipe calculation 
and correction.

Color
inconstancy

Color inconstancy is the color difference if a single sample is illuminated with different 
light sources. The magnitude of color inconstancy can be defined by DE CMC (or any 
other color difference formula) of the sample between two light sources.

Colorant set A colorant set is a set of color information about the Substrates and dyes the system 
uses to produce match and correction recipes. It contains...

• information about the overall colorant set, e.g., the substrate(s) and process(es) 
that will be used with the dyes;

• product information about each dye, e.g., price and specific gravity (density);
• color information about each dye;
information about the qualities used with the colorant set.

Color index The color index is produced jointly by SDC (Society of Dyers and Colourists) in the UK, 
and the AATCC (American Association of Textile Chemists and Colorists) in the USA. 
The index is split into two parts: one part gives the commercial names for the individual 
dyes; the other part of the index gives the color index number, and lists the commercial 
names for the dyes using that number. Refer to Color index number.

Color index
number

Every dye is given a color index number based on its chemical type. The same number 
is given to the dyes with the same chemical structure. For example, Resolin Red FB 
and Dispersol Red B2B, both have the color index number “CI Disperse Red 60."

The index number is divided into four sections:

• CI stand for color index and is displayed in every color index number
• The next section is the dye type, e.g., Disperse, Acid, etc.
• The third section is the color, according to a defined list off color names, e.g., Red 

Yellow, Orange
• The last number is increased every time a new dye is added to the index; in the 

example above, “CI Disperse Red 60" is the 60th red disperse dye to be added to 
the index. Refer to Color index.

Colorant A coloring matter; a dye, a pigment or an ink.

Color type Measured color of a sample. The color type is the target color to be dyed.

Note
References to other glossary entries are written in italics.
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Combined
process

A combined process is used to describe the entire dyeing process either for laboratory 
or production. A treatment is generated for each calibration dye process type (e.g., 
Exhaust, Continuous,) linked to the combined process.

Correction Datacolor MATCHTextile supports three types of correction:

• Laboratory correction: The existing recipe is altered and saved again. Every 
additional laboratory correction reduces the differences 
to the color sample.

• Production correction: An additional recipe is calculated that is used to change 
the color of the dyed batch to the correct color.

• Fast correction: Used for a production correction without an existing rec-
ipe. It is based on a theoretical calculated recipe of the 
standard.

Dye class Classification of dyes according to the chemical composition and reaction, e.g., dis-
perse, reactive.

Dye fiber group Group of fibers dyed in the same bath with the same dyestuffs, e.g. Cotton/Viscose.

Dye process The dye process contains Dye class, Process type and Process factor. The dye process 
is associated with combined process and colorant set.

Dye strength The attribute of color which increases the concentration of the Colorant, all other condi-
tions remaining the same.

Dyestuff type Description of the dyestuff, e.g. gran., conc., supra. The dyestuff type is used to specify 
the dyestuff name.

 Fast correction Refer to Correction.

Fiber Single fiber to be dyed.

Fiber group All fibers used for a Quality / Style. A fiber group can be a single fiber or a combination 
of different fibers, e.g., PES, PES/CO.

K Kubelka Munk coefficient of Absorption. The optical property that describes the absorp-
tion of light by a colorant or mixture of colorants.

K/S A ratio of the Kubelka Munk constants, K (coefficient of Absorption), and S (coefficient 
of Scattering).

Kubelka Munk
theory

A theory that describes the optical behavior of materials which scatter and absorb radi-
ant energy.

Laboratory
correction

Refer to Correction.

Metameric
match

Two samples which match under one set of conditions but no longer match on changing 
one or more of the conditions.

Metamerism A pair of colors that match under one or more sets of conditions but differ markedly in 
color if you change one or more of the conditions. A metameric pair of samples have the 
same tristimulus values for a specific set of viewing conditions but have different reflec-
tance curves.

Monotone data Reflectance data of a dyestuff is manipulated for a non-linear build-up of K/S. It is used 
when an error in making a sample or contamination causes the build-up curve to dip 
and divert in the opposite direction to the general trend. Monotone means keeping the 
same slope as the general trend.

Off shade Descriptive of a match that is commercially unacceptable.
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Quality / Style The quality is used to define the type of fabric you are going to dye. lt contains a refer-
ence to the composition and describes whether the fabric is used for exhaust or contin-
uous dyeing or both.

Operation The operation specifies the sequence of action to be done during the dyeing. Actions 
may be parameters (e.g., temperature, volume,) or products (e.g., chemicals, etc.).

Parameter The parameter values (e.g. “fastness”) are defined in a colorant set for each dye, and 
used to set limits for the recipe calculation.

Process Refer to Dye process and Combined process.

Process factor In match prediction, used to take in account differences in dyestuff build up. The dye-
stuff concentrations are multiplied with the process factor.

Process type Values: Exhaust, Continuous, Cold Pad Batch.

Product A Product is either a dyestuff or an auxiliary.

Production
correction

Refer to Correction.

Recipe
calculation

A process which identifies and calculates the amounts of each coloring matter in a 
material so that the final color looks like (i.e. matches) the given sample in a specified 
light source and price. It is possible to get several combinations which match the sam-
ple so the process can give the most cost effective one.

S Kubelka Munk coefficient of Scattering. The optical property that describes the scatter-
ing of light by a Colorant or mixture of colorants.

Sample Measured color stored with its spectral values.

Scattering The diffusion or redirection of radiant energy encountering particles of a different refrac-
tive index.

Security key Used by the software to decide which sections of the software are available on the com-
puter, or workstation, it is attached to.

Settings Parameters used for recipe calculation. Refer to Settings Tab on page 7-120.

SmartMatch
point

Information about a specific laboratory or production dyeing stored in the database. This 
information is used to improve first-time matching and correction.

SmartMatch
population

A group of SmartMatch points which were all dyed on the same substrate using the 
same dyes.

Smoothed data The reflectance data is manipulated in such a way that minor variations in the build-up 
of a dyestuff are eliminated by a least mean squared fit.

Specular
reflectance

Light striking a surface and being reflected, or turned back, at an angle equal to the 
angle of incidence. The reflected light is specular reflectance.

Specular
reflectance
coefficient

A numerical term used to describe the value for the Specular reflectance when used in 
the Sauderson correction.

Standard Measured color to be matched (target color). In Datacolor MATCHTextile, a standard 
becomes a color type.

Stock solution Definition of different dilutions used for optimizing the accuracy of manual dyestuff 
pipetting and to prevent that the maximum of the dye solution is to be exceeded.

Substrate The materials onto which Colorant is applied to obtain the desired shade.

Substrate blank
dyeing

Dyeing without dyestuff but with all auxiliaries.
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Substrate
delivery

Specific substrate delivery. Small differences between different substrate deliveries may 
force corrections of the recipe.

Tolerance value A numerical value used to determine the acceptability of a sample.

Treatment A treatment consists of one or more operations describing the dyeing process for labo-
ratory and/or production.
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A
Absorption

explanation 8-2
Access rights

specification 4-3
Address

dialog box 7-44
Administration

Datacolor TICKET 5-117
Affinity

exclude colorant sets 5-29
explanation 8-2
include colorant sets 5-29

Affinity list
window 7-88

Alternate Substrate Information
dialog box 7-84

Approve
approving a recipe for production. 5-84

ASCII
output 4-20
output of basic data 4-23
output of recipes 4-23
specifying forms 4-20

Auxiliary
explanation 8-2
overview 2-3

Auxiliary list
window 7-89

B
Backup

database using Datacolor Match Textile 4-16
database using Sybase utilities 4-17

Basic data
ASCII output 4-23
color type 5-43
customers 5-39
dye class 5-38
dye process 5-37
menu functions 7-10
overview 2-2, 5-25
parameters 5-40
product 5-34
quality/style 5-26
recommended input sequence 5-25
tolerance 5-44

Basics
browse and select 5-2
custom query 5-5
data handling 5-2
default query 5-5
field-specific selection aids 5-6
quick search 5-4
selection using the list windows 5-3, 5-4

selection using the object tree 5-2
selection using the overview window 5-3
specify, modify, delete objects 5-8
using special browse functions and the query

designer 5-4
Batch series

window (Datacolor MONITOR) 7-139
Batch series script name

dialog box (Datacolor MONITOR) 7-141
Batch series type

dialog box (Datacolor MONITOR) 7-142, 7-143
BLEND

correction dialog box 7-179
correction recipe dialog box 7-181
fast correction 5-150
fast correction dialog box 7-182
fiber set window 7-173, 7-176
option 5-134
recipe calculation 5-142
recipe correction 5-148
recipe table 7-179
specify a new fiber set 5-135
start 5-135

Browse
basics 5-2

Browser
alter position of table column titles 4-7
alter table column titles 4-7
customizing 4-6
display table columns 4-6
filters 4-8

Button
browse 5-5
overview window 7-3

C
Calculation

recipe (Datacolor BLEND) 5-142
Calibrate

green tile test 5-18
instrument correlation 5-16
monitor 4-24
spectrophotometer 5-10
UV calibration 5-11

Calibration data
explanation 8-2

Calibration methods
colorant set overview 2-5

Calibration sample
explanation 8-2

Change
position of table column titles 4-7
table column titles 4-7

Check
dyestuff selection for a recipe 5-73
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Color index
explanation 8-2

Color index number
explanation 8-2

Color type
data handling 5-43
deletion 5-43
explanation 8-2
overview 2-3
specify newly 5-43
updating 5-43

Color type list
window 7-85

Color type property sheet
dialog box 7-45

Colorant
explanation 8-2

Colorant set
calibration methods 2-5
comparing colorants 5-59
complete imported textile printing colorant sets

5-57
explanation 8-2
import 4-14
introduction 5-47
move colorants 5-51
overview 2-4
re-measure, delete or move calibration sample

5-51
remove dyestuff 5-54
specify auxiliary recipe 5-49
specify colorant and calibration sample 5-50
specify for an alternate substrate 5-55
specify newly 5-48
using the graphical display 5-52
window 7-77

Colorant set list
window 7-76

Combined process
explanation 8-3
introduction 5-61
overview 2-6
specify, modify, delete 5-62
window 7-61

Combined process list
window 7-93

Combined processes
window 7-58

Compare
colorants (colorant set) 5-59

Complete
imported textile printing colorant set 5-57

Configure
instrument correlation 5-16

Context-sensitive menu
opening 5-8

Correct or approve your recipe
dialog box 7-95

Correction
BLEND fast correction 5-150
dialog box (Datacolor BLEND) 7-179
existing recipe for a new standard 5-103
explanation 8-3, 8-4
fast correction 5-99
introduction 5-91
laboratory correction 5-92
laboratory correction dialog box 7-96
laboratory correction table 7-98
manual graphical correction 5-101
overview 2-9
production correction 5-96
production correction dialog box 7-101
production correction from Datacolor Process 5-

98
production correction table 7-103
recipe (Datacolor BLEND) 5-148
specify theoretical reflectance values 5-96

Correction recipe
dialog box (Datacolor BLEND) 7-181

Create batch series
dialog box (Datacolor MONITOR) 7-140

Create calibration series
dialog box 7-82

Current population
dialog box 7-125

Custom query
basics 5-5

Customer
data handling 5-39
deletion 5-39
overview 2-3
specify newly 5-39
updating 5-39

Customer list
window 7-91

Customer property sheet
dialog box 7-43

Customize
browser 4-6
graphs 4-30

D
Data

export 4-12
import 4-13

Data handling
basics 5-2

Data in Folder
dialog box 7-13
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Database
backup using Datacolor Match Textile 4-16
backup using Sybase utilities 4-17
maintenance 6-2

Datacolor Match Textile
removing 3-6
security system 3-4
setting up 3-2
starting 5-2
system requirements 3-2
updating 3-3

Datacolor Process
access to production correction 5-98

Datacolor tolerance block
dialog box 7-55

Default query
basics 5-5

Delete
calibration sample 5-51
color type 5-43
combined process 5-62
customer 5-39
Dye class 5-38
Dye process 5-38
object 5-9
objects 5-8
operation 5-64
parameter 5-40
print forms 4-28
product 5-35
quality/Style 5-33
tolerance value 5-46
user’s data 4-2

Dispenser
connecting 4-11

Display
existing BLEND recipes 5-151
existing recipes 5-104

Dye class
data handling 5-38
deletion 5-38
explanation 8-3
specify newly 5-38
updating 5-38

Dye fiber group
explanation 8-3
specify into a dye process 5-37

Dye lot
Datacolor TICKET 5-117

Dye lots list
window (Datacolor TICKET) 7-151

Dye process
data handling 5-37
deletion 5-38
explanation 8-3
specify dye fiber groups 5-37

specify newly 5-37, 5-48
updating 5-38

Dye process list
window 7-88

Dye process property sheet
dialog box 7-29

Dye strength
explanation 8-3

Dyestuff
check selection for a recipe 5-73
overview 2-3
round concentrations 5-81
selection for a recipe 5-71
settings for a recipe 5-74

Dyestuff class list
window 7-88

Dyestuff list
window 7-89

Dyestuff type
explanation 8-3

E
E-mail

sending printfiles 4-25
Enable

instrument correlation 5-16
Enter

SmartMatch point manually 2-10
SmartMatch points manually 5-90
SmartMatch with recipes points manually 5-90

Error
handling 6-2
messages 6-2

Explorer
folder structure 7-9
toolbar 7-7
window 7-2

Explorer window
menu functions 7-4

Export
data 4-12
dialog box 7-135
print forms 4-19, 4-29
samples (QTX format) 4-16

F
Fast correction

dialog box (Datacolor BLEND) 7-182
overview 2-10

Fast correction recipe input
dialog box 7-105

Fiber
explanation 8-3

Fiber group
explanation 8-3
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Fiber group list
window 7-87

Fiber set
specify 5-135
window (Datacolor BLEND) 7-173, 7-176

Fibre list
window 7-86

Field
selection and input mode 5-5
specific functions 5-5

Filter
browser 4-8
disabling browse filters 4-9
export browse filters 4-9
import browse filters 4-10
import browse filters from e-mails 4-10
using browse filters 4-8

Folder
structure (explorer) 7-9

Form
delete print forms 4-28
export print forms 4-29
import print forms 4-29
modify print forms 4-28
rename print forms 4-28
specify print forms 4-26

Form maintenance
dialog box 7-136

Formula
specify, modify 5-66

Formula edit
window 7-71

Formula setting
dialog box 7-42

Function
field-specific 5-5

Functions
tables 5-7

G
Graphical display

using (colorant set) 5-52
Graphs

customizing 4-30
Green tile test 5-18

H
Handle

errors 6-2

I
Illuminant list

window 7-85
Import

colorant sets 4-14

data 4-13
dialog box 7-134
print forms 4-19, 4-29
samples (QTX format) 4-16

Input
sequence recommended for basic data 5-25

Input form
selection of context-sensitive menu 5-8

Insert a theoretical sample
dialog box 7-123

Instrument correlation 5-16
configure and enable 5-16

Introduction
colorant set 5-47
combined process 5-61
correction 5-91
Datacolor SORT 5-118
recipe calculation (matching) 5-67
SmartMatch 5-85

J
Job result

window (Datacolor SORT) 7-154

K
K

explanation 8-3
K/S

explanation 8-3
Kubelka Munk theory

explanation 8-3

L
Laboratory correction

specify 5-92
List window

basics 5-3, 5-4

M
Maintenance

database 6-2
spectrophotometer 6-2

Manual
type styles and symbols 1-3

Manual input tolerance values
dialog box 7-56

Match
dialog box 7-116
introduction 5-67
multi color matching 5-70
recipe 5-74

Matching
overview 2-7
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Measure
multiple measurement 5-21
samples 5-20
until tolerance measurement 5-22

Measurement main window
dialog box 7-15

Menu functions
basic data 7-10
explorer 7-4
Page View Designer 7-137

Messages
error messages 6-2

Metameric match
explanation 8-3

Metamerism
explanation 8-3

Modify
combined process 5-62
Datacolor SORT job 5-125
Datacolor SORT script 5-130
formula 5-66
maintain sample property (Datacolor SORT) 5-

131
manual modification of recipes 5-81
modification of recipes using the editor 5-79
objects 5-8
operation 5-64
print forms 4-28
recipes 5-79
replace dyestuffs in recipes 5-82
user’s data 4-2

MONITOR
adding a graph panel 5-112
batch series relation dialog box 7-143
batch series script name dialog box 7-141
batch series type dialog box

Window
batch series type dialog box (Data-

color MONITOR) 7-142
batch series window 7-139
create batch series dialog box 7-140
option 5-106
printing a batch series 5-114
select current illuminations dialog box 7-144
specify a batch series 5-110
specify a script 5-106

Monitor
calibrate with Spyder2 4-24

Monotone data
explanation 8-3

Move
calibration sample 5-51
colorants 5-51

N
New dye lot

dialog box (Datacolor TICKET) 7-152

O
Object

specify newly 5-9
update and delete 5-9

Object tree
basics 5-2

Off shade
explanation 8-3

Open
context-sensitive menus 5-8
sort job 5-121

Operation
explanation 8-4
formulae 5-66
specify, modify, delete 5-64
window 7-67

Operation list
window 7-93

Operations browse
window 7-65

Option
connecting dispensers 4-11
Datacolor BLEND 5-134
Datacolor MONITOR 5-106
Datacolor SORT 5-118
Datacolor TICKET 5-115

Options
dialog box 7-112
sort job definition options 5-133

Output
ASCII 4-20
ASCII files of basic data 4-23
ASCII files of recipes 4-23
specifying ASCII forms 4-20

Overview
auxiliary 2-3
basic data 2-2, 5-25
calibration methods (colorant set) 2-5
color type 2-3
colorant set 2-4
combined process 2-6
correction 2-9
customer 2-3
dyestuff 2-3
fast correction 2-10
matching 2-7
product 2-3
quality 2-2
recipe calculation 2-7
SmartMatch 2-8
style 2-2
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window 7-2
Overview window

buttons 7-3
selection 5-3

P
Page View Designer

delete print forms 4-28
export print forms 4-29
import print forms 4-29
modify print forms 4-28
rename print forms 4-28
specify print forms 4-26
starting 4-26

Page View Designer window
menu functions 7-137
toolbar functions 7-138

Pager
window 7-137

Parameter
data handling 5-40
deletion 5-40
explanation 8-4
specify newly 5-40
updating 5-40

Parameter definition
dialog box 7-57

Parameter list
window 7-86

Password
changing 4-2

Population
dialog box 7-127

Preliminary work
recipe 5-69

Print
delete print forms 4-28
existing BLEND recipes 5-151
existing recipes 5-104
export print forms 4-29
import print forms 4-29
modify print forms 4-28
recipe lists 5-84
rename print forms 4-28
specify print forms 4-26

Print form
delete print forms 4-28
export 4-19, 4-29
import 4-19, 4-29
modify print forms 4-28
rename print forms 4-28
specify print forms 4-26

Process factor
explanation 8-4

Process type
explanation 8-4

Product
data handling 5-34
deletion 5-35
explanation 8-4
overview 2-3
specify newly 5-35
updating 5-35

Product list
window 7-90

Product property sheet
dialog box 7-31

Production correction
access from Datacolor Process 5-98
specify 5-96

Production recipe
Datacolor TICKET 5-115

Q
Quality

data handling 5-26
explanation 8-4
overview 2-2
quality/style property sheet 7-22
specify newly 5-27
update and delete 5-33
using SmartMatch points of other qualities 5-31

Quality list
window 7-87

Quick search
basics 5-4
dialog box 7-59

R
Recipe

approving for production 5-84
ASCII output 4-23
calculation (Datacolor BLEND) 5-142
check dyestuff selection 5-73
correction (Datacolor BLEND) 5-148
display and print 5-104
manual modification 5-81
matching 5-74
modification 5-79
modification using the editor 5-79
multi color matching 5-70
preliminary work 5-69
print lists 5-84
replace dyestuffs 5-82
review 5-76
round dyestuff concentrations 5-81
rules for re-dyeing 5-71
selecting dyestuffs 5-71
settings 5-74
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specify a new series 5-69
specify theoretical reflectance values 5-96
window (Datacolor TICKET 7-147

Recipe (BLEND)
display and print 5-151

Recipe calculation
explanation 8-4
introduction 5-67
overview 2-7

Recipe editor
dialog box 7-124

Recipe list
window 7-91
window (Datacolor TICKET) 7-145

Recipe Table
window (Datacolor BLEND) 7-179

Recipe table
window 7-121

Re-dye
rules 5-71

Release
group(s) of SmartMatch points 5-88

Re-measure
calibration sample 5-51

Remove
bad SmartMatch points automatically 5-86
bad SmartMatch points manually 5-87
Datacolor Match Textile 3-6
dyestuff from a colorant set 5-54

Rename
print forms 4-28

Requirements
system requirements for Datacolor Match Tex-

tile 3-2
Review

recipe 5-76
Root recipe

dialog box (Datacolor TICKET) 7-149
Round

dyestuff concentrations of recipes 5-81
Rules

re-dying 5-71

S
S

explanation 8-4
Sample

explanation 8-4
import/export (QTX format) 4-16
measure 5-20
multiple measurement 5-21
until tolerance measurement 5-22

Sample input
dialog box 7-72

Sample list
window 7-85

Sample property
dialog box (Datacolor SORT) 7-169

Scattering
explanation 8-4

Search and correct
dialog box 7-109

Search results
dialog box 7-110

Security key
explanation 8-4

Security system
Datacolor Match Textile 3-4

Select current illuminants
dialog box (Datacolor MONITOR) 7-144

Selection
basics 5-2
dyestuffs for a recipe 5-71
field-specific aids 5-6
step by step 5-5

Set
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